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In this section:

Typographical Conventions

[T o | o= T3 QTP 8

Typographical Conventions

The following kinds of formatting in the text identify special information.

Formatting convention Type of Information Example

Special Bold Items you must select, such as | Go to the QoStab.
menu options, command
buttons, or items in a list.

Titles of chapters, sections, Read the Basic Administration
and subsections. chapter.

Italics Used to emphasize the The system supports the so
importance of a point, to called wildcard character
introduce a term or to search.
designate a command line
placeholder, which is to be
replaced with a real name or
value.

Monospace The names of style sheet The license file is called
selectors, files and directories, |license.key
and CSS fragments.




8 Preface

Preformatted Bold What you type, contrasted with | nix/Linux:

on-screen computer output.
# cd /root/rpms/php

Windows:
>cd % myfolder%

Preformatted On-screen computer output in - | Unix/Linux:

your command-line sessions; o
source code in XML, C++, or |#1Is Tal/files
other programming languages. |total 14470

Windows:

>ping localhost
Reply from 127.0.0.1:
bytes=32 time<lms
TTL=128

Feaedback

If you have found a mistake in this guide, or if you have suggestions or ideas on how to
improve this guide, please send your feedback using the online form at
http://www.parallels.com/en/support/usersdoc/. Please include in your report the guide's title,
chapter and section titles, and the fragment of text in which you have found an error.



http://www.parallels.com/en/support/usersdoc/

CHAPTER 1

Getting Started

Parallels Plesk Panel is the program that you use for hosting and managing your Web
sites.

You can manage the hosted domain hames and Web sites on your own, or delegate
permissions to manage individual domains to other users. Upon delegation, a separate
Domain Administrator's control panel environment is automatically created, providing
the users with site and e-mail management capabilities in accordance with the
permissions you define.

Using the Domain Administrator's control panel, a site owner can:

A Change passwords for access to control panel and Web space through FTP,

A Publish and preview a Web site,

A Install, manage and remove databases and Web applications,

A Order and install SSL certificates to secure online transactions (this is possible for
Web sites hosted on a dedicated IP address, which is not shared among other Web
sites),

A Set up, manage and remove subdomains,

A Host personal Web pages for other users,

A Password protect areas of a Web site,

A Customize Web server error messages,

A Backup and restore a Web site with its databases and applications,

A Schedule automatic backups,

A Create, edit, remove mailboxes, and protect them against spam and viruses,

A Allow access to individual E-mail administration panel to mailbox owners (this is

convenient when running mail hosting business or creating mailboxes for other
users),

A Create, edit, remove mail forwarders and automatic replies,
A Create, manage, remove mailing lists, subscribe and unsubscribe users.
You have access to all these features from your own control panel, therefore, you will

not need to use neither the Domain Administrator's nor E-mail Administrator's control
panels.

To learn more about using Domain Administrator's control panel, please refer to the
Domain Administrator Guide.

In this chapter:

Logging In to Parallels Plesk Panel ...............uooiiiiiiiiiieiice e, 10
Becoming Familiar with Parallels Plesk Panel ............ccccoooeiiiiiiiiii s 11
Changing Your Contact Information and Password ..............ccoovveeeiiiiiniieeneeeenns 15
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Logging In to Paralleidesk Panel

To log in to your Parallels Plesk Panel:

Open your Web browser, and in the address bar type the URL where
your Parallels Plesk Panel is located.

For example, https://your-domain.com:8443, where your-domain.com is the domain
name of your Web host.

2 Press ENTER. Parallels Plesk Panel login screen will open.

3 Type the login name and password your provider gave you into the
Loginand Passwordooxes, respectively.

4 If you log in for the first time, select the language for your control
panel from the Interface languag#grop-down box. If you had previously
specified the interface language and saved it in your interface
preferences, leave the User defaulvalue selected.

5 Click Login
In this section:

IT YOU FOrgot YOUr PASSWOIT .......ccooiiieieeeeeeeeeeeee e 10

If You Forgot Your Password

U To restore your forgotten password:

I n your web browserdés address bar, type
Plesk Panel is located (for example, https://your-domain.com:8443)

2 Press ENTER.
Parallels Plesk Panel login screen will open.
3 Click the Forgot your passwordink.

4 Type your login name into the Loginbox, and type your e-mail address
registered in the system into the E-mailbox.

5 Click OK
Your password will be sent to your e-mail address.
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Becoming Familiar with Parallels Plesk
Panel

When you log in to Parallels Plesk Panel, it shows your Home page with shortcuts to
the operations you frequently perform.

Parallels aed eiicl & M nt Log out
Plesk Panel agged in 2 res1d1 v 3ccou og ou
i o ) e -
Welcome, Client's Name ¢ Favoritesw 3 Visited Pages v
o i 2 wi | create | stats
i M Disk space g Tesffic [
Pl 0 wiew|create 96,4 MB fres of 100.0 ME 1500 M free of 150.0 MB
AcCounts
Domains = A Web Site - -
Damains ~= Domain Termplates Wirtual Host " dit in Site e < Web Hosting Subdamains
(=) [*-3| Template 2 Settings w
Dormain Alisses | Frontpage Frontpage
Miail » - @ | E}a i
232 Mail Accounts g' g;::ot: "l:lml A Create Redirect 3 Wb Lisers @ Site Preview
1 Create r\ Mailing Lists /@ Wirus Protection
O Autoresponder d g Applications & Services = ~

cha Spam Filtering ? Open Webmail o Web Applications @ Toolsfrom Daksbases
‘ < MyPlesk.Com

g Java Applications Register Domain
Files = ~ Eg Q/

File Manager % Anonymaus FTP i 55 Terminal
Additional Tools » -

Password 4 Backup Manager . IP Addresses 2 Scheduled Tasks == 5L Certificates
g Protected -» ! .rl") .

Directories

= Active Sessions Bandwidth Custom Buttons
) -] Limiting *

Statistics = a

& Web Statistics : Resaurce Usage r_’rr.l Traffic Usage

Log Manager

Help & Support
LeipDely Account -
Help i‘ Personal Data S Change Password (53 Interface
P | Preferences
() ControlPanel Permissions e

Branding "] :I
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The top banner area provides access to the following functions:

A

A

A

My accountThis is where you can select a language and theme for your control
panel and change your contact information.

Switch userThis is where you can switch between user accounts. This shortcut is
shown only when single sign-on technology is enabled on the server.

Log out.This is where you close your session when you have finished working with
control panel.

The navigation pane on the left provides access to the following sets of functions:

A

A

>

A

Home This is where you start working with the control panel. Most of the operations
you might need to perform are accessible from this area.

DomainsThis is where you perform operations on Web sites. You can accomplish
the following tasks from this area of the control panel:

A Add Web sites (set up DNS, configure hosting settings and resource usage
limits), modify hosting settings, remove Web sites

A Create, modify, remove Web site hosting templates (referred to as Domain
templates)

Mail.This is where you perform operations on e-mail accounts. You can accomplish
the following tasks from this area of the control panel:

A Set up and manage mailboxes.
A Set up mailing lists, automatic responses, mail forwarders.
ApplicationsThis is where you can view and install applications on your Web sites.

Global AccounfThis shortcut appears in your Parallels Plesk Panel when the single
sign-on capabilities are switched on on the hosting server. Single sign-on
technology allows you to log in to different Parallels products using a single global
login name and password. This shortcut is used for changing the global login
settings.

Help DeskKThis is the help desk system integrated with your control panel. If you see
this shortcut in the navigation pane, then it is likely that your provider uses it; so you
can use it to report your problems to provider's technical support staff.

Help.Provides context sensitive help.

To see information about a tool or an item on the page, hover the cursor over an item,
without clicking it, and a small hover box appears with supplementary information
regarding the item being hovered over.

/@, YirugPratection

Configure wirus protection far a mail
account
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If your hosting plan includes the Web site creation and management service using
Parallels Plesk Sitebuilder, the following shortcuts are also shown in your control
panel's navigation pane under the Sitebuilder Administratiagroup:

A Home pageThis provides shortcuts to the task-oriented wizards. Here you can
perform any operations on your account and Web sites through the Sitebuilder
system. For more information, see
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en _US/html/using des
ktop _interface.htm.

A Users Here you can add and manage user accounts and service plans for your
customers. For more information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en _US/html/signing u
p_customers.htm.

A Sites Here you can add and manage sites. For more information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/managing
sites.htm.

A Server Here you can view and manage the following system settings:

A Trial Sites Sings Here you can configure settings for trial sites created by your
prospective customers. For more information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/setting

up_sitebuilder_wizard for_anonymous Vvisits.htm

A Branding Here you can configure the logo and title setting for your prospective
customers. For more information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en _US/html/setting

up_logo and title bar text.htm

A NotificationsHere you can configure settings for notifications sent by Sitebuilder
to your users. For more information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en US/html/config
uring_email message sent at trial site publishing attempt.htm.

A ModulesHere you can view the list of available modules. For more information,
see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en US/html/viewin
g _and configuring_sitebuilder wizard presets and modules.htm.

A Page SetsHere you can view the list of available page sets. For more
information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en _US/html/viewin
g_and_configuring_sitebuilder wizard presets and modules.htm.

A Site Familieddere you can view the list of available templates that combine
design templates and page sets. For more information, see
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/viewin
g_and _configuring_sitebuilder_wizard presets _and modules.htm.

The main working area on the right provides access to the tools available for the
current section of the control panel selected in the navigation pane. Additional
operations are accessible from drop-down menus that open when you click group titles.


http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/using_desktop_interface.htm
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/using_desktop_interface.htm
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/signing_up_customers.htm
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/signing_up_customers.htm
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/managing_sites.htm
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/managing_sites.htm
http://download1.parallels.com/SiteBuilder/4.5.0/doc/reseller/en_US/html/setting_up_sitebuilder_wizard_for_anonymous_visits.htm
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To navigate through Parallels Plesk Panel, you can use a path bar: a chain of links that
appears in the right part of the screen, below the banner area.

Harne » Dormains » examplecorn b Mail Sccounts »

To the right of the path bar, there are Favoritesand Visited Pagemenus. The Visited
Pagesmenu keeps the shortcuts to the recently visited control panel screens. These
shortcuts are added automatically. The Favoriteanenu keeps the shortcuts to the
screens that you manually add to favorites. For information about working with
shortcuts in the Favoriteamenu, see the section Customizing Your Home Page (on
page 21).

To return to a previous screen, use the shortcuts in the path bar, or the Up Levelcon in
the upper-right corner of the screen.

When changing settings for a user account, domain name, or e-mail account, you can
quickly select another user account, domain name, or e-mail account whose settings
you also want to change. To do this, click a small arrow icon located to the right of the
user name, domain name, or e-mail address.

Harme » Dormains » examplecom » Mail Accounts »

mail @example.com ()

%

This will open a list of user accounts, domain names or e-mail addresses that you can
select.

Home » Domains » example.com b Mail Accounts »

ma|| @example.com \:f Go to another mail account:

weebrmaster@example.com
Tools

To sort a list by a certain parameter in ascending or descending order, click on the
parameter's title in the column heading. The order of sorting will be indicated by a small
triangle displayed next to the parameter's title.
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Changing Your Contact Information and
Password

If you need to update your contact information, or change password:
On your Home page, click Personal Data

2 Update your information as required, or type a new password, and
click OK

If you forgot your password:

I n your web browserdés address bar, type
Plesk Panel is located.

For example, https://your-domain.com:8443.
Press ENTER. Parallels Plesk Panel login screen will open.
Click the Forgot your passwordihk.

Type your login name into the Loginbox, type your e-mail address
registered in the system into the E-mailbox, and click OK

Your password will be sent to your e-mail address.

a b~ W0 DN



CHAPTER 2

Setting Up a Global Account

Global Account is a single sign-on (SSO) technology feature that allows you to log in to
different Parallels products using a single global login and password. If you have
several accounts in Parallels Plesk Panel, you can connect them all to a global account
and switch between these accounts without entering a password every time. You can
also connect all your accounts in other Parallels products to your global account and
switch between them without providing credentials.

In this chapter:

Creating a Global ACCOUNT.........uuuiiiiiiiiiiiiiiiiieiiiiieie bbb enenenne 16
Connecting Local Accounts To Your Global Account..............ccoovviiieiiieeecceenn, 17
Switching BEtWEEN ACCOUNTS .....uuuiiiii it e e e e e e e eea e e e e e eeeeees 18
Changing Global ACCOUNt PASSWOI ............uuuuuiuiiiiiiiiiiiiiiiiiiiiiiieieieenneeeneeeennennes 18
Disconnecting Local Accounts From Global Account...............ccoovviiiiiiiiieeeeeennn, 19

Creating a Global Account

After you create a global account and connect local accounts to it, you will be able to
choose from any account connected to your global account when logging in under your
global account.

To create a global account:

Log in to Parallels Plesk Panel, go to Global Accounand click Connect
To Global Account

2 Select Create new global accowarid provide the login and password for
your global account.

3 Click OK

Your global account is active now, so you can proceed with connecting other accounts

to it. Refer to the section Connecting Local Accounts to Your Global Account (on page
17) for more information.
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Connecting Local Accounts To Your
Global Account

To comect a local Parallels Plesk Panel account to your global account:

Log in to Parallels Plesk Panel under the local account you want to
connect.

2 Go to Global Accounand click Connect To Global Account

3 Make sure that Use existing global accowtion is selected and provide
the login and password for the global account you want to connect to.

4 Click OK

Repeat steps 1-4 for other local accounts as necessary.

To connect an account in another product with SSO support to your global account:

Log in to software product with SSO support under the account you
want to connect.

2 Follow the instructions on connecting to a global account in respective
software product documentation. Make sure that you provide the
credentials for the existing global account when you are asked to.

Repeat steps 1-2 for other accounts or products as necessary.

Note. Different software products may use different names for the Global Account
feature, such as Federated Identity or Global Login. Refer to respective software
product documentation for more information.

After you have connected all required accounts to your global account, you can log in
under your global account all the time in any product where you have a local account
connected to your global account. You will be shown the list of local accounts
connected to your global account every time you log in under it, so you can choose
which account you would like to use now. You can switch to another account any time
you want. Refer to the section Switching Between Accounts for more information.
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Switching Between Accounts

U To switch to another account:
Click Switch Usein the upper right corner.
2 Select the account you want to switch to:

A Choose the required local account from the list of accounts connected to your
global account

or

A Select Specify credentials for another accaamd provide login and password for a
local account not connected to your global account or to another global account.
You can also specify the language for your control panel from the Interface
languagemenu. If you had previously specified the interface language for that
account and saved it in its interface preferences, leave the Defaultvalue
selected.

3 Click OK

Changing Global Account Password

To change password of your global account:

Log in to Parallels Plesk Panel under your global account or any local
account connected to it.

2 Go to Global Accounand click Change Password
3 Enter your old and new passwords, and click OK
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Disconnecting Local Accounts From
Global Account

To disconnect a local account fromryglobal account:

Log in to Parallels Plesk Panel under the local account you want to
disconnect.

2 Go to Global Accounand click Disconnect From Global Accaunt
3 Confirm the disconnection and click OK

Repeat steps 1-3 for other local accounts as necessary.



CHAPTER 3

Customizing Your Control Panel

In this chapter:

Customizing YOUr HOME Page .......cccooiiiiiiiiiii i
Customizing Home Pages for Domain Administrator ACCOUNtS ..............ccceeeeees
Setting Interface Language and Skin for Your Control Panel..................cceeee.
Setting @ CUSTOM LOQO ... ..uuuuuiiiiiriiiiiiiieeieineieteieeessesesesnsesaeassessssssensesenneesennnnnennes
Adding and Removing Hyperlink BUttONS ............cceiiiiieiiiiiiii e
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Customizing Your Home Page

N B & Ol

c:

To add or remove items from the Home page:
Go to Home> Accountgroup title menu > Customize Home page

Specify what server information and statistics should be shown on the
Home page by selecting the corresponding items check boxes.

Specify what actions should be shown on the Home page. The Selected
actionslists show the tasks for which shortcuts are already placed on
the Home page. The Available actioniists show the tasks for which you
do not yet have shortcuts on your Home page.

A To add a shortcut to the Home page, select the required tasks in the Available
actionslist and click Add >>

A To remove a shortcut from the Home page, select the task that you do not need
in the Selected etionslist and click << Remove

Specify what actions should be shown in the drop-down menus on the
Home page by selecting the corresponding check boxes.

Click OK

To add shortcuts to control panel screens té-#weritemenu on the Home page:
Navigate to the control panel screen you need.
In the Favoritesmenu, select Add to Favorites

To edit shortcut descriptions in thavoritemenu on the Home page:
On your Home page, open the Favoritesmenu.

Place the mouse pointer over the shortcut you need and click Edit
favorite's name

Type the shortcut title and description and click Save

To remove shortcuts from thavoritemenu:
On the Home page, open the Favoritesmenu.

Place the mouse pointer over the shortcut you want to remove and
click Remove from Yarites
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Customizing Home Pages for Domain
Administrator Accounts

To customize the Home page of a domain owner:

Go to Home> Domains> Domaingroup title menu > Customize Home
page

2 Specify what domain information and statistics should be shown on
the Home page by selecting the corresponding items check boxes.

3 Specify what actions should be shown on the Home page. The Selected
actionslists show the tasks for which shortcuts are already placed on
the Home page. The Available actioniists show the tasks for which you
do not yet have shortcuts on your Home page.

A To add a shortcut to the Home page, select the required tasks in the Available
actionslist and click Add >>

A To remove a shortcut from the Home page, select the task that you do not need
in the Sekcted actiondist and click << Remove

4 Specify what actions should be shown in the drop-down menus on the
Home page by selecting the corresponding check boxes.

5 Click OK

Setting Interface Language and Skin for
Your Control Panel

U To select an interfatenguage and theme (skin) for your control panel:
1 On your Home page, click Interface Preferences

2 Select the desired interface language and skin from the respective
menus.
Parallels Plesk Panel s interface has been t

if you do not see your own language in the list, ask your provider to install the
respective language pack.

3 Click OK
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Setting a Custom Logo

0 To set up a custom logo image in the Parallels Plesk Panel:

On your Home page, open the Accountgroup title menu, and select
Control PaneBranding

2 Click Browse..to navigate to the desired image file that you have on
your local computer.

We recommend that you use an image that is 50 pixels in height, in GIF, JPEG or
PNG format, and preferably not larger than 100 kilobytes to minimize the download
time.

3 If you wish to attach a hyperlink to the logo image, type the URL into
the Enter new URL for logpmx.

4 Click OKto submit.

To restore the original Parallels Plesk Panel logo image:

On your Home page, open the Accownt group title menu, and select
Control PaneBranding

2 Click Default Logo
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Adding and Removing Hyperlink Buttons

U To add a custom hyperlink button to your Parallels Plesk Panel and specify whether
your customers will see it in their control panels:

1 Go to Home> Custom Buttonsand click Create Custom Button
2 Specify properties of the button:
A Type the text that will show on your button in the Button labefield.

A Choose the location for your button. To place it in the right frame of your Home
page, select the Client home pagealue from the Locationdrop-down box. To
place it on each domain's administration screen (Domains> domain nanme select
the Domain Administration pagelue. To place it in the left frame (navigation
pane) of your control panel, select the Navigation panealue.

A Specify the priority of the button. Parallels Plesk Panel will arrange your custom
buttons on the control panel in accordance with the priority you define: the lower
the number i the higher is priority. Buttons are placed in the left-to-right order.

A To use an image for a button background, type the path to its location or click
Browseto browse for the desired file. It is recommended that you use a 16x16
pixels GIF or JPEG image for a button to be placed in the navigation pane, and
32x32 pixels GIF or JPEG image for buttons placed in the main frame.

A Type the hyperlink of your choice to be attached to the button into the URLbox.

A Using the check boxes, specify whether to include the information, such as
domain name, FTP login, FTP password and other data to be transferred within
the URL. These data can be used for processing by external web applications.

A In the Context help tip contenitsput field, type in the help tip that will be displayed
when you hover the mouse pointer over the button.

A Select the Open URL in the control padleéck box if you wish the destination URL
to be opened in the control panel's right frame, otherwise leave this check box
unchecked to open the URL in a separate browser window.

A If you wish to make this button visible to the mailbox users with access to control
panel, select the Visible to all sulbginscheck box.

3 Click OKto complete creation.

To remove a hyperlink button from your Parallels Plesk Panel:
Go to Home> Custom Buttons

2 Select a check box corresponding to the button that you want to
remove and click Remove
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Viewing Resource Allotments and
Hosting Features Included in Your
Hosting Package

In this chapter:

Viewing IP addresses Included in Your Hosting Package.............ccccccvvvvueenne... 25
Viewing Resource Allotments for Your ACCOUNT...........ccooveeeeeeiieeieiieeeeeeeeeeeee 26
Viewing the List of Operations You Can Perform within Your Control Panel...... 28
Viewing Your ACCOUNt BalANCE............ueiiiiiiiiiieeics e 29

Viewing IP addresses Included in Your
Hosting Package

To view the IP addresses included in your hosting package, go to Home> Additional
Toolsgroup title menu > IP Addressesyour IP addresses are listed and the following
supplementary information is given:

A

An icon in the S (Status) column shows @ i your |IP address is properly configured
on the network interface. If your IP address was removed from the network

interface by your provider, an icon will show W,

The Certificatecolumn shows which SSL certificate (for what domain name) is tied to
an IP address. See the section Securing E-commerce Transactions with Secure
Sockets Layer Encryption (on page 82) for details.

The FTP over SStolumn shows whether it is possible to use secure FTP
connection (FTP over SSL) on one of the domains hosted on this IP. To switch on
FTP over SSL for an exclusive IP address, select the check box corresponding to
the required IP address under the FTP over SStolumn.

The Hostingcolumn shows a number of web sites hosted on an IP address. To view
the domain names of these web sites, click the number in the Hostingcolumn.
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Viewing Resource Allotments for Your
Account

To view the resource allotments for your account, on your Home page, click Resource
Usage The resource allotments are shown as follows:

A Maximum number of domaifi$ie total number of domain names/web sites you can
host on the server. This includes web sites that you host on this server, and domain
forwarders that point to web sites hosted on other servers. Domain aliases
(additional domain names for a site hosted on this server) are not limited by this
resource type.

A Maximum number of subdomaifke total number of subdomains that can be hosted
for your sites.

A Maximum number of domain aliadé® total number of additional alternative domain
names that you can use for your sites.

A Disk spaceThe total amount of disk space in megabytes that can be occupied by
your web sites and sites of your customers. It includes disk space occupied by all
files related to all domains/web sites: web site contents, databases, applications,
mailboxes, log files and backup files. This is the so-called soft quota: when it is
exceeded, domain names and web sites are not suspended automatically, only the
appropriate notices are sent to your and your provider's e-mail addresses.

A Maximum amount of traffithe amount of data in megabytes that can be transferred
from your web sites during a month. Once the limit is reached, the appropriate
notices are sent to your and your provider's e-mail addresses.

A Maximum number of web uséfke total number of personal web pages that you or
your customers can host for other users. This service is mostly used in educational
institutions that host non-commercial personal pages of their students and staff.
These pages usually have web addresses like http://your-domain.com/~username.
Refer to the Hosting Personal Web Pages on Your Web Server section for details.

A Maximum number of databasEke total number of databases that can be hosted on
the server.

A Maximum number of mailbox&ke total number of mailboxes that can be hosted on
the server.

A Mailbox quotaThe limit on amount of disk space in kilobytes that can be allocated to
each mailbox for storing e-mail messages and autoresponder attachment files.

A Maximum number of mail forward@ise total number of mail forwarders that can be
set up on the server.

A Maximum number of mail autorespondEne total number of automatic responses that
can be set up on the server.

A Maximum number of mailing lisEe total number of mailing lists that can be hosted
on the server. The mailing lists are served by the GNU Mailman software, which
may or may not be installed on the server. If it is not installed and you or your
customers would like to use it, ask your provider to install it.

A Maximum number of Java applicatidie total number of Java applications or applets
that can be hosted on the server.
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A Validity periodThe term of your hosting or reseller account. At the end of the term,
your domains/web sites will be suspended, their Web, FTP and mail services will no
longer be accessible to the Internet users, and domain owners will not be able to
log in to their control panels.
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Viewing the List of Operations You Can
Perform \whin Your Control Panel

To view the list of operations you can perform within your control panel, go to Home>
PermissionsThe permissions for operations are listed as follows:

A

A

Domain creatiorshows whether you can host new domain names (Web sites) on
the server.

Physical hosting managemes8hows whether you can fully control hosting accounts
for your Web sites. If it says Ng, then you can only change FTP password for
accessing your Web spaces.

Hosting performance settings managent&mbws whether you can limit connections
and bandwidth usage for your sites.

PHP safe mode managemé&ftows whether you can switch the PHP safe mode off

for your sites. By default, PHP is configured to operate in safe mode with functional
restrictions. To learn more about PHP safe mode, refer to
http://php.net/features.safe-mode. Some web applications may not work properly

with safe mode enabled: If an application on a site fails due to safe mode, switch

the safe mode off (or ask your provider to do this) by clearing the PHP 'safe_mode' on
check box in the hosting account properties (Domains > domain name > Web Hosting
Settings.

Management of shell access to the seBlwws whether you can access the server
shell and allow other users to do so.

Hard disk quota assignme8hows whether you can set up the hard quotas on disk
space allocated to your sites.

Subdomains manageme8hows whether you can set up, modify and remove
subdomains.

Domain aliases managemestiows whether you can set up additional alternative
domain names for your Web sites.

Log rotation manageme®hows whether you can adjust the cleanup and recycling of
processed log files for your site.

Anonymous FTP managemeiiows whether you can have an FTP directory where
all users could download and upload files without the need to enter login and
password. A Web site should reside on a dedicated IP address in order to use
anonymous FTP service.

Task schedulingshows whether you can schedule tasks in the system. Scheduled
tasks can be used for running scripts or utilities on schedule.

Limits adjustmenShows whether you can change resource usage limits for your
Web sites.

DNS zone managemeBhows whether you can manage the DNS zones of your
domains.

Javaapplications manageme@hows whether you can install Java applications and
applets on Web sites through the control panel.

Mailing lists managemefhows whether you can use mailing lists provided by the
GNU Mailman software.
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A Spam filter managemeBhows whether you can use spam filter provided by the
SpamAssassin software.

A Antivirus managemerhows whether you can use server-side antivirus protection
for filtering incoming and outgoing mail.

A Backup and restore functiorBhows whether you can use the control panel's facilities
to backup and restore your sites. Scheduled and on-demand backups are
supported.

Home page managemeBhows whether you can customize your Home page.

A Ability to use remote XML interfa8bows whether you can remotely manage Web
sites through custom applications. The XML interface can be used for developing
custom applications integrated with Web sites, which could be used, for instance,
for automating setup of hosting accounts and provisioning of services for customers
purchasing hosting services from your site. To learn more about using Parallels
Plesk Panel's XML interface (also referred to as Parallels Plesk Panel APl RPC),
refer to the documents: http://downloadl.parallels.com/Plesk/Plesk9.0/Doc/en-
US/plesk-9.0-api-rpc-quide/index.htm and
http://downloadl.parallels.com/Plesk/Plesk9.0/Doc/en-US/plesk-9.0-api-
rpc/index.htm.

A Hosting performance managem@&tows whether you can limit number of
connections and bandwidth usage for your sites.

A Ability to select a database sen&mows whether you can select a database server of
each type for creating your databases, not only use the default database server.

S

Viewing Your Account Balance

To view an account balance report in the billing system, on your Home page, click
Billing Detailslf there is no Billing Detaildutton, it means that billing system is not
accessible from your control panel.


http://download1.parallels.com/Plesk/Plesk9.0/Doc/en-US/plesk-9.0-api-rpc-guide/index.htm
http://download1.parallels.com/Plesk/Plesk9.0/Doc/en-US/plesk-9.0-api-rpc-guide/index.htm
http://download1.parallels.com/Plesk/Plesk9.0/Doc/en-US/plesk-9.0-api-rpc/index.htm
http://download1.parallels.com/Plesk/Plesk9.0/Doc/en-US/plesk-9.0-api-rpc/index.htm

CHAPTER 5

Simplifying Setup of Web Sites

Before you start hosting Web sites, you should create hosting configuration presets,
referred to as domain templates. The templates cover all resource usage allotments,
permissions and resource limits that you can define for a hosting account, plus mail

bounce and Web statistics retention settings. There is a predefined domain template
available from the control panel: You can modify it as required and use it, or you can
create your own templates. The default template cannot be removed.

U To create a domain template:
Go to Home> Domain Templates Create Domain Template
2 Specify the following settings:

A Template nam&pecify a name for this template. During setup of a new hosting
account for a Web site, you will be prompted to select the required template by
its name. Therefore, we recommend that you choose a meaningful name that
describes the amount of allotted resources. For example, Mail hosting, 1GB disk
space, 500 mailboxes

A Mail to nonexistent userSpecify the domain-wide mail bounce options: When
somebody sends an e-mail message to an e-mail address that does not exist
under your domain, the mail server on your domain accepts mails, processes it,
and when it finds out that there is no such a recipient under your domain, it
returns the mail back to sender with
notice. You can choose to:

A change the default notice if you do not like it (leave the Bounceor Bounce with
messageption selected and type another message into the input box),

A forward undelivered mail to another e-mail address (select the Forward to
addressoption and specify the e-mail address you need), or

A reject mail without accepting it (select the Rejectoption). This setting can
decrease mail server load caused by a large amount of spam, which is often
directed at randomly generated user names. However, for spammers this
can somewhat speed up scanning your mail server for valid e-mail
addresses.

A forward to external mail server (available only for Windows hosting). With
this setting, all mail addressed to nonexistent users will be forwarded to the
specified external mail server.

A WebmailSpecify whether the users of mailboxes in this domain should be able
to read their mail through a browser based webmail application, and select the
webmail application that should be used.

A SubdomainsSpecify the number of subdomains that can be hosted under this
domain.

A Domain ahses Specify the total number of additional alternative domain names
that the site owner will be able to use for his or her Web site.

t

he
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Disk spaceSpecify the total amount of disk space allocated to a hosting account
associated with the domain. This amount is measured in megabytes. It includes
disk space occupied by all files related to the domain/Web site: Web site
contents, databases, applications, mailboxes, log files and backup files.

Traffic Specify the amount of data in megabytes that can be transferred from the
Web site during a month.

Web usersSpecify the number of personal Web pages that the domain owner
can host for other users under his or her domain. This service is mostly used in
educational institutions that host non-commercial personal pages of their
students and staff. These pages usually have Web addresses like http://your-
domain.com/~username. If you wish to allow execution of scripts embedded in
personal Web pages, select also the Allowthe web users scriptindheck box. See
the Hosting Personal Web Pages (on page 113) section for details.

Databasegavailable only for Linux hosting). Specify the number of databases
that can be hosted in a domain.

MySQL databasé¢available only for Windows hosting). Specify the maximum
number of MySQL databases that can be hosted under a domain.

MailboxesSpecify the number of mailboxes that can be hosted in a domain.

Mailbox quotaSpecify the amount of disk space in kilobytes that is allocated for
storing e-mail messages and autoresponder attachment files to each mailbox in
a domain.

Mail redirectsSpecify the number of mail forwarders that can be used in a
domain.

Mail groupsSpecify the number of mail groups that can be hosted in a domain.

Mail autoresponderSpecify the number of automatic responses that can be set
up in a domain.

Mailing lists Specify the number of mailing lists that the domain owner can run in
a domain. To allow the use of mailing lists, you should also put a check mark
into the Mailing listcheck box under the Preferences group.

Java applicationsSpecify the maximum number of Java applications or applets
that the domain owner can install under a domain.

MySQL databases quatiad Microsoft SQL databasquota(available only for
Windows hosting). Specify the maximum disk space amount in megabytes that
MySQL and Microsoft SQL Server databases respectively can occupy under a
domain.

FrontPage accoungsnly for Windows hosting). Specify the maximum number of
additional Microsoft FrontPage accounts that can be created under a domain.

FTP account&@vailable only for Windows hosting). Specify the maximum number
of additional FTP accounts that can be created under a domain.

Microsoft SQL server databagagailable only for Windows hosting). Specify the
maximum number of Microsoft SQL Server databases that can be hosted under
a domain.

Shared SSL linKawvailable only for Windows hosting). Specify the total number of
shared SSL links that can be used under a domain.

ODBC connectiorfavailable only for Windows hosting). Specify the total number
of ODBC connections that can be used under a domain.
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A

ColdFusion DSN connectidasailable only for Windows hosting). Specify the total
number of ColdFusion DSN connections that can be used under a domain.

Expiration dateSpecify the term for a hosting account. At the end of the term, the
domain (Web site) will be suspended, its Web, FTP and mail services will no
longer be accessible to the Internet users, and domain owner will not be able to
log in to the control panel. Hosting accounts cannot be automatically renewed,
therefore, in order to bring the hosted domain name/web site back to operation,
you will need to manually renew the hosting account: click the Domainsshortcut
in the navigation pane, click the domain name your need, click the Resource
Limitsicon, specify another term in the Expiration dat®éox, click OK then click
UnsuspendDomains> domain name > Unsuspégnd

Log rotationAll connections to the Web server and requests for files that were
not found on the server are registered in log files. These log files are analyzed
by the statistical utilities running on the server, which then present graphical
reports on demand. If you need to view the contents of these raw log files for
debugging purposes, go to Domains> domain name Log Manage®&and then click
the log file name you need. To prevent these log files from growing too large,
you should enable automatic cleanup and recycling of log files:

>

select the Switch orlog rotationcheck box,
specify when to recycle log files,

> >

specify how many instances of each log file processed by Parallels Plesk
Panel's statistical utilities to store on the server,

A specify whether they should be compressed,
A specify whether they should be sent to an e-mail address after processing.

Web and traffic statistics retenti@pecify the number of months during which the
Web and bandwidth usage statistics should be kept on the server.

DNS Specify whether the DNS server on your Web host should act as a master
(primary) or slave (secondary) name server for the domain name zone. A
primary name server stores locally the zone file it serves, while a secondary
server only retrieves a copy of this file from the primary. You would normally
leave the Masteroption selected.

Physical hosting accourf you are going to host not only domain names (DNS
zone settings), but also Web sites, select the Physical hostingheck box and
specify the hosting features:

A Hard disk quotdn addition to the soft quota, you can specify the so-called
hard quota that will not allow writing more files to the web space when the
limit is reached. At attempt to write files, users will get "Out of disk space"
error.
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SSL supportSecure Sockets Layer encryption is generally used for protecting
transfer of sensitive data during online transactions on e-commerce Web
sites that run on dedicated IP addresses. SSL certificates that participate in
the encryption process are usually applied to a single domain name on a
single IP address, therefore, each site that needs SSL protection must be
hosted on a dedicated IP address. An exception to this is subdomains, which
you can protect with a wildcard certificate. Installing an SSL certificate on a
Web server that hosts several web sites with different domain names on a
single IP address (shared or name-based hosting) is technically possible,
however, it is not recommended: the encryption will be provided, but users
will get warning messages on attempt to connect to the secure site. To allow
SSL encryption for Web sites, select the SSL supportheck box.

Use a single directory for housing SSL andS8Incontenfavailable only for
Linux hosting). By default, when users publish their sites through their FTP
accounts, they need to upload the Web content that should be accessible via
secure connections to the httpsdocs directory, and the content that should
be accessible via plain HTTP, to the httpdocs directory. For the convenience
of publishing all content through a single location 7 httpdocs directory, select
the Use a single directory for housing SSL and3&incontentheck box.

Create and publish Web site using Sitebuildes will enable the site owner to
create and manage a Web site using Sitebuilder.

Microsoft FrontPagripport Microsoft FrontPage is a popular Web site
authoring tool. To enable users to publish and modify their sites through
Microsoft FrontPage, select the Microsoft FrontPage suppartd FrontPage over
SSL supportheck boxes and set the Remote MicrosofirontPage authoring
option to allowed

Support for programming and scripting languages used in development of dynamic
Web sites and servside Web applicationSpecify which of the following
programming and scripting languages should be interpreted, executed or
otherwise processed by the Web server: Active Server Pages (ASP), Server

Side Includes (SSI), PHP hypertext preprocessor (PHP), Common Gateway
Interface (CGl), Fast Common Gateway Interface (FastCGl), Perl, Python,
ColdFusion, and Miva scripting required for running Miva e-commerce

solutions.

Web statisticsTo allow domain (Web site) owner to view the information on
the number of people visited his or her site and the pages of the site they
viewed, select the statistical package you need from the Web statisticsnenu,
and select the accessible via password protected directory /gedkvebstat
check box. This will install the statistical software of your choice, which will
generate reports and place them into the password-protected directory. The
domain/web site owner will then be able to access Web statistics at the URL:
https://lyour-domain.com/plesk-stat/webstat using his or her FTP account
login and password.

Custom error documentd&/hen visitors coming to your site request pages that
the Web server cannot find, the Web server generates and displays a
standard HTML page with an error message. If you wish to create your own
error pages and use them on your server, select the Custom erroracuments
check box.
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A Shell access to the server with FTP user's creddatiaitable only for Linux
hosting). This allows a site owner to upload securely Web content to the
server through a Secure Socket Shell or Remote Desktop connection,
however, allowing access to the server also poses a potential threat to the
server security, so we recommend that you leave the Forbidderoption
selected.

A Additional write/modify permissiq@asailable only for Windows hosting). This
option is required if Web applications on the site are using a file-based
database (like Jet) located in the root of httpdocs  or httpsdocs  folders.
Please note that selecting this option might seriously compromise the Web
site security.

A Use dedicated IIS application gawhilable only for Windows hosting). This
option enables the use of dedicated IIS application pool for Web applications
on the site. Using dedicated IIS application pool dramatically improves the
stability of domain Web applications due to worker process isolation mode.
This mode gives each Web site hosted on the server the possibility to
allocate a separate process pool for execution of its Web applications. This
way, malfunction in one application will not cause stopping of all the others.
This is especially useful when you are using a shared hosting package.

A Use dedicated pofdvailable only for Windows hosting). This option enables
the use of dedicated IIS application pool for Web applications on a domain.
Using dedicated IIS application pool dramatically improves the stability of
domain Web applications due to worker process isolation mode. This mode
gives each Web site hosted on the server the possibility to allocate a
separate process pool for execution of its Web applications. This way,
malfunction in one application will not cause stopping of all the others. This
is especially useful when you are using shared hosting package.

A Maximum CPU ugavailable only for Windows hosting). To limit the amount of
CPU resources that domain's 1S application pool can use, clear the Unlimited
check box and type in the number (in percents).

A PerformanceTo avoid excessive usage of bandwidth, which can lead to
resources overage, you can set various performance limitations for a domain.

A Maximum bandwidth usade limit the maximum speed (measured in kilobytes
per second) that a domain can share between all its connections, clear the
Unlimitedcheck box and type in a number in kilobytes.

A Connections limiting:o limit the maximum number of simultaneous
connections to a domain, clear the Urlimitedcheck box and type in a number.

3 Click OKto complete creation of a template.

During setup of a hosting account for a new domain (Web site), you will select the
required template and the hosting account will be created and allocated the
resources and hosting services you defined.

U To reflect the changes in your domain templates that will apply to the newly created
Web site hosting accounts:
1 Go to Home> Domain Templates

2 Click the template name corresponding to the domain template you
want to update.

3 Modify the settings as required and click OK
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Note that modifying templates does not affect the existing domains and Web sites.

To remove a template that you no longer need:

Go to Home> Domain Templates

Select a check box corresponding to the template you no longer need.
Click Remove Confirm removal and click OK
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Prepackaging Branded Default Site Pages
(Virtual Host Template)

You can set your control panel to automatically include specific files and directories into
Web spaces created for newly hosted Web sites. This can be a set of useful scripts,
custom error messages, a placeholder index.html page, or any other files of your
choice. These files can then be replaced, edited or removed on a per-site basis.

i

To set up the control panel so as to automatically include your Wésti cdo Web
spaces:

On your local file system, create the required directories: httpdocs ,
httpsdocs , cgi - bin , anon_ftp , error_docs

Place the files you need into the directories you have created: Place
web pages into httpdocs and httpsdocs  directories, scripts to
cgi - bin directory, and custom error messages to error_docs
directory.

Pack the directories and files into an archive file in tgz, tar, tar.gz, or
zip format.

Make sure that the directories are in the root of the archive file and not in a
subdirectory.

Log in to your Parallels Plesk Panel.
On your Home page, click Virtual Host Template

Click the Browsebutton to locate the archive file on your local
computer, select the file, and click the Send Fildutton.

To revert back to the original struetof Web server directories and files:
On your Home page, click Virtual Host Template
Click the Defaultbutton.
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Setting Up Hosting Account for a Web
Site

To host a new Web site:
Go to Domainsclick Create a Domain

2 Specify the domain name that was previously registered with a
domain name registrar. Leave the wwwcheck box selected if you wish
to allow users to access your site by a common and habitual URL like
www.your-domain.com.

Having the www alias preceding your domain hame will not cost you anything, but it
will allow users to get to your site no matter what they type in their browsers:
www.your-domain.com and your-domain.com will both point to your site.

3 If you have a number of IP addresses to choose from, select the
required address from the Assign IP addressienu.

Bear in mind that e-commerce sites need a dedicated IP address (not shared
among other sites) to implement Secure Sockets Layer data encryption.

After your Web site is set up, you will be able to assign another IP address to it, if
you have several IP addresses and if you are authorized to perform this operation.
Note that after you change a site's IP address, your domain/site will be unreachable
and e-mail messages sent to mailboxes under your domain will not reach them until
the information about the new IP address is propagated across the DNS system.
This can take one or two days.

4 If you have previously created a domain template and predefined all
hosting features and resource usage allotments (as described in
Simplifying Setup of Web Sites (see page 30)), select the required
template from the Use domain template settingfseck box.

5 Select the Mailand DNScheck boxes.
6 Select the Web Site Hostingption to host the Web site on this machine.

Upon completion of this procedure, your control panel will set up the domain name
server on this machine to serve the new domain name and prepare the web server
to serve the new Web site: a new zone file with appropriate resource records will be
added to the Domain Name Server's configuration files, a web space will be created
inside the Web server's directory, and necessary user accounts will be created on
the server.
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Note: If your site is hosted on another machine, and you wish to set up your control
panel's DNS server only to serve the DNS zone for that site, select the Forwarding
option. In the Forwarding settingarea, specify the URL where users will be
redirected and select either Standad forwardingr Frame forwardingption. With
standard forwarding, a user is redirected to the site and the actual site's URL is
shown in the user's browser, so the user always knows that he or she is redirected
to another URL. With frame forwarding, a user is redirected to the site without
knowing that the site actually resides at another location. For example: your
customer has a free personal web site with his or her Internet Service Provider or a
free Web host, and the Web site address is
http://www.geocities.com/~myhomepage. The customer purchased a second level
domain hame www.myname.com and wants you to provide domain forwarding to
his Web site. In this case you would normally choose the Frame forwardingervice.
See the chapter Serving Domain Names for Sites Hosted on Other Servers
(Domain Forwarding) (on page 126) for details.

Type in the username and password that will be used for uploading
Web site content over FTP and Microsoft FrontPage.

Select the Configure advanced Web site hosting settifggck box and click
OK

Specify the following settings:

A SSL supportSecure Sockets Layer encryption is generally used for protecting
transfer of sensitive data during online transactions on e-commerce Web sites
that run on dedicated IP addresses. SSL certificates that participate in the
encryption process are usually applied to a single domain name on a single IP
address, therefore, each site that needs SSL protection must be hosted on a
dedicated IP address. An exception to this is subdomains, which you can
protect with a wildcard certificate. Installing an SSL certificate on a Web server
that hosts several web sites with different domain names on a single IP address
(shared or name-based hosting) is technically possible, however, it is not
recommended: the encryption will be provided, but users will get warning
messages on attempt to connect to the secure site. To allow SSL encryption for
Web sites, select the SSL supportheck box.

A Use a single directory for housing SSL andS&incontentavailable only for Linux
hosting). By default, when users publish their sites through their FTP accounts,
they need to upload the web content that should be accessible via secure
connections to the httpsdocs directory, and the content that should be
accessible via plain HTTP, to the httpdocs directory. For the convenience of
publishing all content through a single location 1 httpdocs directory, select the
Use asingle directory for housing SSL and-8&L contentheck box.

A FTP Logirand FTP passworhavailable only for Linux hosting) or FTP/Microsoft
FrontPage Logiand FTP/Microsoft FrontPage passw@nehilable only for Windows
hosting). Specify the user name and password that will be used for publishing
the site to the server through FTP or Microsoft FrontPage. Retype the password
into the Confirm Passwordox.
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A Hard disk quotaSpecify the amount of disk space in megabytes allocated to the
web space for this site. This is the so-called hard quota that will not allow writing
more files to the web space when the limit is reached. At attempt to write files,
users will get the "Out of disk space" error. Hard quotas should be enabled in
the server's operating system, so if you see the "Hard disk quota is not
supported” notice to the right of the Hard disk quotéeld, but would like to use the
hard quotas, contact your provider or the server administrator and ask to enable
the hard quotas.

A Management of access tova over SSkhavailable only for Linux hosting) or
Management of access to server over Remote Déskaipble only for Windows
hosting). This allows a site owner to upload securely Web content to the server
through a Secure Socket Shell or Remote Desktop connection, however,
allowing access to the server also poses a potential threat to the server security,
so we recommend that you set this option to Forbidden

A Create and publish Web site using Sitebuildes allows a site owner to create and
manage his or her Web site using the Sitebuilder service installed on the server.

A Microsoft FrontPage suppawticrosoft FrontPage is a popular Web site authoring
tool. To enable users to publish and modify their sites through Microsoft
FrontPage, select the options Microsoft FrontPage suppdvticrosoft FrontPage over
SSL supportand RemoteFrontPage authoring allowed.

A Servicesor support for programming and scripting languages widely used in
development of dynamic Web sites and server-side Web applications. Specify
which of the following programming and scripting languages should be
interpreted, executed or otherwise processed by the web server: Active Server
Pages (ASP), Server Side Includes (SSI), PHP hypertext preprocessor (PHP),
Common Gateway Interface (CGlI), Fast Common Gateway Interface (FastCGl),
Perl, Python, ColdFusion, and Miva scripting languages. By default, PHP is
configured to operate in safe mode with functional restrictions. To learn more
about PHP safe mode, refer to http:/php.net/features.safe-mode. Some web
applications may not work properly with safe mode enabled: If an application on
a site fails due to safe mode, switch the safe mode off (or ask your provider to
do this) by clearing the PHP 'safe_mode' @heck box in the hosting account
properties (Domains> domain name Web Hosting Settings

A Web statisticsTo allow Web site owner to view the information on the number of
people visited his or her site and the pages of the site they viewed, select the
statistics program you need from the Web statisticenenu, and select the
accessible via password protected directory /gegkvebstatheck box. This will
install the statistics program of your choice, which will generate reports and
place them into the password protected directory. The domain/web site owner
will then be able to access Web statistics at the URL: https://your-
domain.com/plesk-stat/webstat using his or her FTP account login and
password.

Note: When you switch from one statistics program to another, all reports
created by the previously used statistics program are deleted and new
reports are created in accordance with the information read from log files
kept on the server. This means that if you configured the system (at Domains
> domain name Log Manager Log Rotationso as to keep log files only for
the last month, then Web statistics will be available only for the last month.
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A Custom error document#/hen visitors coming to your site request pages that the
Web server cannot find, the Web server generates and displays a standard
HTML page with an error message. If you wish to create your own error pages
and use them on your Web server or allow your customers to do that, select the
Custom error documentieck box.

A Additional write/modify permissidiasailable only for Windows hosting). This
option is required if Web applications under a domain will be using a file-based
database (like Jet) located in the root of httpdocs or httpsdocs  folders.
Please note that selecting this option might seriously compromise the Web site
security.

A Use dedicated IIS application fawhilable only for Windows hosting). This option
enables the use of dedicated IS application pool for Web applications on a
domain. Using dedicated IIS application pool dramatically improves the stability
of domain Web applications due to worker process isolation mode. This mode
gives each Web site hosted on the server the possibility to allocate a separate
process pool for execution of its Web applications. This way, malfunction in one
application will not cause stopping of all the others. This is especially useful
when you are using shared hosting package.

10 Click OK

Now the server is ready to accommodate the new web site, and the site owner can
publish the site to the server. For instructions on publishing a Web site, refer to the
Creating and Publishing a Site (see page 47) section of this guide.

Note: If you transferred this domain name from another Web host, you will need to
update the host DNS address with the domain name registrar so as to point to your
name servers: log in to your registrar's web site, locate the forms used to manage
the domain host pointers, and replace the current DNS host settings with your
name servers' hosthnames. The information on new name servers will spread across
the DNS system within 48 hours.

If you have registered several domain names that you would like to point to a site
hosted on this server, you should set up domain aliases. Refer to the section Setting
Up Additional Domain Names for a Site (Domain Aliases) (on page 102) for details.

If you need to host on your account several domains, which will point to a site hosted
on another server, you should set up domain forwarding. Refer to the section Serving
Domain Names for Sites Hosted on Other Servers (Domain Forwarding) (on page 126)
for details.

In this section:

Limiting the Amount of Resources a Site Can CONSUME ..........ccoeevvveiiiieeeereeens 42
Allowing the Site Owner to Log in to Control Panel..............ccoooeeiieiie, 45
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Limiting the Amount of Resources a Site Can Consume

By default, new Web sites that you set up without the help of domain templates, are
allowed to consume unlimited amounts of bandwidth (data transfer) and disk space.

To limit the amount of resources a site can consume:
Click Domains and then click the domain name you need.
Click ResourcdJsage

Adjust the following settings as required:

A Overuse policySpecify what should be done when disk space and monthly
bandwidth (traffic) allotments are exceeded. We recommend setting this option
to Overuse is allowe®therwise, the Web site will be suspended when the
resource limits are exceeded.
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Note: The overuse policy does not apply to the limits set on size of mailboxes
(mailbox quota). Therefore, even if you enable overuse, be sure to allocate
enough disk space to mailboxes.

A Disk spaceSpecify the total amount of disk space allocated to the hosting
account associated with this domain (Web site). This amount is measured in
megabytes. It includes disk space occupied by all files related to the domain
(Web site): Web site contents, databases, applications, mailboxes, log files and
backup files.

A Traffic Specify the amount of data in megabytes that can be transferred from the
Web site during a month.

A SubdomainsSpecify the number of subdomains that can be hosted under this
domain.

A Domain aliasesSpecify the total number of additional alternative domain names
that can be used for this site.

A Web usersSpecify the number of personal Web pages that the domain owner
can host for other users under his or her domain. This service is mostly used in
educational institutions that host non-commercial personal pages of their
students and staff. These pages usually have web addresses like http://your-
domain.com/~username. See the Hosting Personal Web Pages (on page 113)
section for details.

A FrontPage accountavailable only for Windows hosting). Specify the maximum
number of additional Microsoft FrontPage accounts that can be created for this
site.

A FTP accountgvailable only for Windows hosting). Specify the maximum number
of additional FTP accounts that can be created for this site.

A MailboxesSpecify the number of mailboxes that can be hosted under the
domain.

A Mailbox quotaSpecify the amount of disk space in kilobytes that is allocated for
storing e-mail messages and autoresponder attachment files to each mailbox
under the domain.

A Mail redirectsSpecify the number of mail forwarders that can be used under the
domain.
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A Mail groupsSpecify the maximum number of mail groups that can be used in a
domain.

A AutorespondersSpecify the number of automatic responses that can be set up
under the domain.

A Mailing lists Specify the number of mailing lists that the domain owner can run
under the domain. The mailing lists are served by the GNU Mailman software,
which may or may not be installed on the server. If it is not installed and your
customers would like to use it, contact your service provider to have it installed.

A Total mailboxes quotavailable only for Windows hosting). Specify the total
amount of disk space available for all mailboxes on a domain.

A Databasegavailable only for Linux hosting). Specify the number of databases
that can be hosted for this site.

A MySQL databasesmd Microsoft SQL server databag@sailable only for Windows
hosting). Specify the maximum number of MySQL and Microsoft SQL Server
databases that can be used by the site.

A MySQL databases quatad Microsoft SQL databasgsota(available only for
Windows hosting). Specify the maximum disk space amount in megabytes that
MySQL and Microsoft SQL Server databases used by this site can occupy.

A ODBC connectior{available only for Windows hosting). Specify the total number
of ODBC connections that can be used by this site.

A ColdFusion DSN connectiqasailable only for Windows hosting). Specify the total
number of ColdFusion DSN connections that can be used by this site.

A Java applicationsSpecify the maximum number of Java applications or applets
that the domain owner can install on the site.

A Shared SSL linKgvailable only for Windows hosting). Specify the total number of
shared SSL links that can be used on the site.

A Expiration dateSpecify the term for the Web site hosting account. At the end of
the term, the domain (Web site) will be suspended, its Web, FTP and malil
services will no longer be accessible to the Internet users, and site owner will
not be able to log in to the control panel. Hosting accounts cannot be
automatically renewed, therefore, in order to bring the hosted domain name
(Web site) back to operation, you will need to manually renew the hosting
account: click the Domainsshortcut in the navigation pane, click the domain
name your need, click Resource Usagspecify another term in the Expiration date
box, click OK then click Unsuspend

Click OK

To potect your site from DoS attacks and to ensure that your site responds promptly
when there are many visitors, you can limit the number of simultaneous connections
to the site and limit the amount of bandwidth that visitors to the site can consume:

Click the Domainsshortcut in the navigation pane.
Click the domain name you need.
Click Bandwidth Limiting
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4 Select the Switch on bandwidth limitimpeck box, and in the Maximum
bandwidth usage (KB/Byx, type the maximum speed in kilobytes per
second that a site can share among all its connections. For example:

128.

5 Select the Switch on connections limitimtpeck box, and in the Connections
limited tobox, type the maximum number of simultaneous connections.

For example: 100.
6 Click OK
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Allowing the Site OwnterLog in to Control Panel

To allow the site owner to log in to control panel for managing his or her Web site:
Go to Domains> domain name Personal Data

Select the Allow domain administrator's accesseck box.

Type the password for access to the site owner's control panel.
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For security reasons, the password should be more than 8 symbols, and it should
comprise a combination of letters, numbers, and punctuation; dictionary words and
proper names should be avoided.

4 Specify the settings related to the appearance of user's control panel,
if desired: interface language, theme (skin), the limit on number of
characters that can appear on custom buttons placed into the control
panel by the site owner.

5 Leave the Allow multiple sessionsheck box selected to allow the site
owner to have several simultaneous sessions in the control panel.

6 Leave the Prevent users from working with the control panel until interface screens
are completely loadatheck box selected.

This will forbid users from submitting data or performing operations until the control
panel is ready to accept them.

7 Specify the operations that the site owner will be able to perform in
his or her control panel:

A Physical hosting managemefitiow or disallow full control of the hosting account
and Web space.

A Hosting performance managem&mtecify whether the user will be able to limit
bandwidth usage and number of connections to his or her Web site.

A Manage FTP passwdevailable only for Linux hosting). Specify whether the user
will be able to manage the FTP password.

A Management of access to server over(@&lable only for Linux hosting) or
Management of access to server over Remote Démkailpble only for Windows
hosting). Specify whether the user will be able to access the server shell
through Secure Shell or Remote Desktop protocols. Note that allowing access
to the server also poses a potential threat to the server security.

A Hard disk quota assignmeBpecify whether the user will be able to assign hard
guota on disk space for this Web site.

A Subdomains managemefipecify whether the user will be able to set up
additional sites under this domain.

A Domain aliases managemedpecify whether the user will be able to set up
additional alternative domain names for this site.

A Log rotation manageme@pecify whether the user will be able to adjust the
cleanup and recycling of processed log files for this sites.
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A Anonymous FTP managemeyiecify whether the user will be able to have an
FTP directory where all other users could download and upload files without the
need to enter login and password. A Web site should reside on a dedicated IP
address in order to use anonymous FTP service.

A FTP accounts managemgmtailable only for Windows hosting). Specify whether
the user will be able to create and manage additional FTP accounts.

A Scheduler manageme8pecify whether the user will be able to schedule tasks in
the system. Scheduled tasks can be used for running scripts or utilities on
schedule.

A DNS zone manageme®pecify whether the user will be able to manage the DNS
zone of this site.

A Java applications managemespecify whether the user will be able to install Java
applications and applets on the site.

A Web statistics manageme8pecify whether the user will be able to manage Web
statistics for this site.

A Mailing lists manageme®pecify whether the user will be able to use mailing lists.
A Spam filter manageme®pecify whether the user will be able to use spam filter.

A Antivirus managemerpecify whether the user will be able to use server-side
antivirus protection for filtering incoming and outgoing mail.

A Allow backing up and restoring d&@gecify whether the user will be able to use
the control panel's facilities to back up and restore the site.

A Ability to use SitebuildeBpecify whether the user will be able to use Sitebuilder
for creating and editing his or her Web site.

A IS application pool managem@wailable only for Windows hosting). Specify
whether the user will be able to manage his or her IIS application pool.

A Additional write/modifyepmissions managemefatvailable only for Windows
hosting). Specify whether the user will be able to manage additional write/modify
permissions for this site. These permissions are required if user's Web
applications are using a file-based database (like Jet) located in the root of
httpdocs or httpsdocs  folders. Please note that selecting this option might
seriously compromise the Web site security.

A Home page manageme®pecify whether the customer will be able to customize
his or her Home page.

A Ability toselect a database serv&pecify whether the site owner will be able to
select a database server of each type for creating his or her databases, not only
use the default database server.

8 Specify the site owner's contact information.

9 Click OK

Now you can send the control panel's URL, login and password to the site owner. The
URL is https://user's_domain_na8#3, where user's_domain_nanigthe domain name

without the www alias. The login name that the site owner should specify in order to log
in to the control panel is his or her domain name, for example, your-domain.com.
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Creating and Publishing a Site

If your hosting plan includes the Web site creation and management service using
Sitebuilder, you can create and publish Web sites using Sitebuilder. Or you can create
your site content (Web pages, scripts and graphic files that compose your site) on your
home or office computer and then publish it to the server in any of the following ways:
A Through FTP connection (most common and easiest way)

A Through control panel's file manager

A Through Secure Shell connection (only for users of Linux and FreeBSD operating
systems)

A Through Adobe Dreamweaver or Microsoft FrontPage software (only for users of
Microsoft Windows operating systems)

In this section:

Creating and Publishing Web Sites Using Sitebuilder.............ccccoiiiiiinnn, 47
Publishing Sites Through FTP .......coooiiiiiiiiiieeeeee 48
Publishing Sites Through Parallels Plesk Panel's File Manager ........................ 51
Publishing Sites Through SSH ConNECtioN ............cccoviiiiiiiiiiiieicee e, 52
Publishing Sites with Microsoft FrontPage (Windows Hosting) ..........cc..ccccoeee. 52
Using Additional Microsoft FrontPage Accounts (Windows Hosting) ................. 55
Changing Microsoft FrontPage Settings (Windows Hosting).........ccccceeevveeeiinnn, 56
Publishing Sites with Adobe Dreamweaver ..............ccccccvvieeiiiiiiiieeiicee e, 57

Creating and Publishing Web Sites Using Sitebuilder

To start creating a Web site using Sitebuilder:
Go to Domains ¥lomain name Edit in SitebuildeiThe Sitebuilder wizard
opens.

2 Select the Create your siteption and click Nextat the bottom of the
screen.

For further instructions on creating or editing your site, refer to the online Sitebuilder
Wizard user's guide at
http://downloadl.parallels.com/SiteBuilder/4.5.0/doc/user/en_US/html/index.htm.
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Publishing Sites Through FTP

To publish Web site through FTP:

Connect to the server with an FTP client program, using FTP account
credentials that you specified during setup of hosting account or
obtained from your provider. The FTP address should be ftp://your-
domain-name.com, where your-domain-name.com is your site's
Internet address.

Enable the passive mode if you are behind a firewall.

2 Upload files and directories that should be accessible through HTTP
protocol to the httpdocs directory, and files/directories that should
be transferred securely over SSL protocol to the httpsdocs
directory.

3 Place your CGI scripts into the cgi - bin directory.
4 Close your FTP session.

In this section:

Changing FTP PASSWOI ........cccuviiiiiiiiiiiiiiiiiiiiiieieeee ettt 48

Using Additional FTP Accounts (Windows HOSEING) .......coooeeeeiieiiiiieeeeeeeeeen 48
Changing FTP Password

To change FTP password for a Web site owner:

Go to Domains lomain name Web Hosting Settings
Specify new password.

Click OK

Using Additional FTP Accounts (Windows Hosting)

If you are working on your Web site together with someone else or host subdomains for
other users, you might want to create additional FTP accounts.

w N -

In this section:

Creating Additional FTP ACCOUNTS........uuuuuuiiiieiiiiiiiiieeiiiiiiiieneennensensnenneeensneeneenee 49
Changing Settings of Additional FTP ACCOUNLS ..........couuuiiiiiiiiiiiiiiiiieee e 50
Removing Additional FTP ACCOUNTS ......cooiiiiiiiiiiie e 50
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Creating Additional FTP Accounts

A WODN P C

To create an additional FTP account for a domain:

On your Home page, click FTP Accounts

On the Additional FTP Accountab, click Add New FTP Account
Specify the FTP account nama the appropriate field.

Specify the Home directorpy clicking 7 and select the directory
required. Alternatively, you can specify the path in the input field.

Type the new password into the New passwordnd Confirm password
boxes.

By default, the Hard disk quotés set to Unlimited To set the required
parameter, clear the Unlimitedcheck box and type the amount of disk
space in megabytes into the Hard disk quotaox.

If required, select the Read permissiooheck box. The FTP account
users will be able to view the content of the home directory and
download files from it.

If required, select the Write pernssioncheck box. The FTP account
users will be able to create, view, rename and delete directories in the
home directories.

If you don't grant any permissions, the connection to the FTP account will be made,
but the home directory will be not displayed for users.

Click OK A new additional FTP account will be added.
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Changing Settings of Additional FTP Accounts

A WODN P C

©

To change the properties of an additional FTP account:

On your Home page, click FTP Accounts

On the Additional FTP Accountab, click the required account in the list.
Specify the FTP account nama the appropriate field.

Specify the Home directorpy clicking 7 and select the directory
required. Alternatively, you can specify the path in the input field.

Type the new password into the New passwordnd Confirm password
boxes.

By default, the Hard disk quotés set to Unlimited To set the required
parameter, clear the Unlimitedcheckbox and type the amount of disk
space in megabytes into the Hard disk quotaox.

If required, select the Read permissionheckbox. The FTP account
users will be able to view the content of the home directory and
download files from it.

If required, select the Write permissiocheckbox. The FTP account
users will be able to create, view, rename and delete directories in the
home directories.

If you don't grant any permissions, the connection to the FTP account will be made,
but the home directory will be not displayed for users.

Specify the changes as required and click OK

Removing Additional FTP Accounts

i
1
2

3

To remove an additional FTP account:
On your Home page, click FTP Accounts

On the Additional FTP Accountab, select the check box corresponding
to the account you want to remove and click Remove

Confirm removal and click OK The FTP account will be removed.
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Publishing Sites Through Parallels Plesk Panel's File
Manager

To upload files through Parallels Plesk Panel's File Manager:
Log in to Parallels Plesk Panel.
Go to Domains ®lomain name FileManager

w N -

Create and upload files and directories.

Place the files and directories that should be accessible via HTTP protocol to the
httpdocs  directory, and files/directories that should be transferred securely over
SSL protocol to the httpsdocs  directory. Place your CGI scripts into the cgi - bin
directory.

A To create a new directory within your current location, click Add New Directary

A To create new files in the required directory, click Add New Filgn the File creation
section specify the file name, select the Use html templatheck box, if you want
file manager to insert some basic html tags to the new file, and click OK A page
will open allowing you to enter the content or html-formatted source of a new
file. When finished, click OK

A To upload a file from the local machine, click Add New Filespecify the path to its
location in the File sourcéox (or use the Browsebutton to locate the file), and
click OK

A To edit a Web page in the built-in visual editor (available only to users of
Microsoft Internet Explorer), click -@. When editing an HTML file, Parallels Plesk
Panel opens internal WYSIWYG editor by default. If you want to edit the source
code of the HTML file, click HTMLTo return back to WYSIWYG mode, click
Design

To edit the source code of a file, click # .
To view the file, click [

To rename a file or directory, click . Type in a new name and click OK

> > > >

To copy or move a file or directory to another location, select the required file or
directory using the appropriate check box, and click Copy/MoveSpecify the
destination for the file or directory to be copied or renamed to, then click Copyto
copy, or Moveto move it.

A To update the file or directory creation date, click Change timestamffhe time
stamp will be updated with the current local time.

A To remove a file or directory, select the corresponding check box, and click
RemoveConfirm removal and click OK

When you upload Web content through File Manager or FTP, your control panel
automatically sets the appropriate access permissions for files and directories. If you
need to change the permissions for files and directories, refer to the sections:
Setting File and Directory Access Permissions (Linux hosting) (see page 93).

Setting File and Directory Access Permissions (Windows hosting) (see page 93).
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Publishing Sites Through SSH Connection

If your are using a Linux or FreeBSD operating system on your local computer and

have access to secpvercommalnld, twseotplyefdl es and

server: scp your_file_name login@remoteserver.com:path to copy files,
and scp i ryour_directory_name login@remoteserver.com:path to copy
entire directories.

After publishing, you will be able to work with files and directories on your account
using SSH terminal web application integrated in your Parallels Plesk Panel (Domains>
domain name SSH Termingl

Publishing Sites with Microsoft FrontPage (Windows
Hosting)

Microsoft FrontPage deals with two kinds of Web sites: disk-based and server-based.
In short, a disk-based site is a FrontPage Web site you create on your local hard disk
and then later publish to a Web server. A server-based site is one you create and work
with directly on a Web server, without the extra step of publishing. This section
provides you with instructions on publishing only disk-based web sites.

You can publish disk-based web sites either through FTP or HTTP. If your server is
running FrontPage Server Extensions, you would publish your site to an HTTP location.
For example: http://your-domain.com/MyWebSite. If your server supports FTP, you
would publish to an FTP location. For example: ftp://ftp.your-domain.com/myFolder.

After publishing, you can manage your site through FrontPage Server Extensions.

To access FrontPage Server Extensions management interface:
Log in to Parallels Plesk Panel.
Click the domain name you need.

To manage a site, which is not protected by SSL, open the Web Site
group title menu, and click Frontpage Webadmifio manage an SSL-
enabled site, open the Web Sitggroup title menu, and click Frontpage SSL
Webadmin

4 Typeyour FrontPage administratoros | ogin
click OK

w N -

For instructions on using FrontPage server extensions, see online help (Frontpage
Webadmir» Help or visit Microsoft Web site.

In this section:

Publishing from Microsoft FrontPage through FTP ........ccccooiiiiiiiii s 53
Publishing from Microsoft FrontPage through HTTP........ccccoiiiiiiiiiii s 54

name
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Publishing from Microsoft FrontPage through FTP

To publish files through FTP:

Open your FrontPage program.

2 Open a FrontPage Web site: open Filemenu and select the Open Site
item.

3 Go to Remote Web sitaew: click the Web Sit¢ab, and then the Remote
Web Sitdbutton at the bottom of the window.

4 Set up your Remote Web Site Properties:

A Click the Remote Web SiRropertiesdoutton in the upper-right corner of the
window.

A Select FTPas the remote Web server.

A In the Remote Web site locatibox, type your host name (e.qg., ftp:/ftp.your-
domain.com)

A In the FTP directorpox, type your FTP directory if your hosting company
provided one. Leave it blank if they did not specify one.

A Select the Use Passive FTéheck box if your computer or network is protected by
a firewall.

5 Click OKto connect to the remote site.

The Remote Web site view will show files that you have in your local and remote
sites.

6 Click the Publish Web sitbutton in the lower-right corner of the window.
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Publishing from Microsoft FrontPage through HTTP

To publish files through HTTP on a server that suppontfRge Server Extensions:

Open your FrontPage program.

2 Open a FrontPage Web site: open Filemenu and select the Open Site
item.

3 Go to Remote Web sitaew: click the Web Sitd¢ab, and then the Remote
Web Sitdbutton at the bottom of the window.

4 Click the Remote Web Site Propertiegton in the upper-right corner of
the window.

5 On the Remote Web Sitab, under Remote Web server typdick FrontPage or
SharePoint Services.

6 In the Remote Web site locatibox, type the Internet address, including
the protocol, of the remote Web site that you want to publish folders
and files to 8 for example, http://www.your-domain.com & or click
Browseto locate the site.

7 Do any of the following:

A To use Secure Sockets Layer (SSL) for establishing a secure communications
channel to prevent the interception of critical information, click Encryption
connection required (SSIp use SSL connections on your Web server, the
server must be configured with a security certificate from a recognized certificate
authority. If the server does not support SSL, clear this check box. Otherwise,
you will not be able to publish folders and files to the remote Web site.

A To remove specific types of code from Web pages as they are being published,
on the Optimize HTMiab, select the options you want.

A To change the default options for publishing, on the Publishingtab, select the
options you want.

8 Click OKto connect to the remote site.
The Remote Web sitgew will show files that you have in your local and remote sites.
9 Click the Publish Web sitbutton in the lower-right corner of the window.
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Using Additional Microsoft FrontPage Accounts
(Windows Hosting)

If you are working on your Web site together with someone else or host subdomains for
other users, you might need to create additional Microsoft FrontPage accounts.

In this section:

Creating Additional Microsoft FrontPage ACCOUNtS.........ccceeeeeeiiiiiiiiiiiiieeeeeeeeeanns 55
Changing Settings of Additional Microsoft FrontPage Accounts ..............c..c.eo. 55
Removing Additional Microsoft FrontPage ACCOUNES ...........cccevvvvviiviiiiiiiiiinnnnnn. 56

Creating Additional Microsoft FrontPage Accounts

To create an additional Microsoft FrontPage accountdaraard
Go to Domains> domain name Web Sitggroup title menu > FrontPage
Management

2 Click Add New FrontPage Accaunt

3 Specify the login and password for this account.

4 If you wish to limit the amount of disk space that can be used by this
account, clear the Unlimitedcheck box and type the desired value in
megabytes into the Hard disk quotaox.

When the specified limit is exceeded, the account owner will not be able to add files
to his or her Web space.

5 Click OKto finish the creation of an additional Microsoft FrontPage
account.

Changing Settings of Additional Microsoft FrontPage Accounts

To change settings for an additional Microsoft FrontPage account:

Go to Domains> domain name Web Sitggroup title menu > FrontPage
Management

2 Click the required account in the list.

3 Adjust the settings as necessary and click OKto save changes.
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Removing Additional Microsoft FrontPage Accounts

To remove an additional Microsoft FrontPage account:

Go to Domains> domain name Web Sitggroup title menu > FrontPage
Management

2 Select the check box corresponding to the account you want to
remove.

3 Click Remove
4 Confirm the removal and click OK

Changing Microsoft FrontPage Settings (Windows
Hosting)

If you want, you can set Microsoft FrontPage to use its own IIS Index Server to build
the full-text index of your Web site.

To make Microsoft FrontPage use its own IIS Index Server:

Go to Domains> domain name Web Siteggroup title menu > FrontPage
Management Preferences

2 Select Use the IIS Index Senadreck box and click OK

If you use FrontPage forms that submit information by e-mail on your site, you may
want to specify the following preferences:

A SMTP mail server that will be used for sendingByalefault, SMTP server specified in
the domain's DNS zone is used for sending mail. If no SMTP server is specified in
the zone, then FrontPage uses the mail service running on the server where the
domain (site) is hosted.

A Sender's enail addressBy default, domain owner's e-mail address is used. If the
domain owner's e-mail address is not specified in domain owner's profile, then
FrontPage uses the e-mail address of the client, to whom the domain belongs. If the
client's e-mail address is not specified in the client's profile, then the server
administrator's e-mail address is used.

U To change the preferences:

Go to Domains> domain name Web Sitggroup title menu > FrontPage
Management Preferences

2 Under Mail Settingsspecify the SMTP server and the e-mail address
you want to use, and then click OK
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Publishing Sites withdobe Dreamweaver

Before publishing a site from Dreamweaver, you need to define the site properties, that
is, you need to tell Dreamweaver where your site files are located on your computer,
and to specify the server to which you want to publish the site.

U To define a site in Dreamweaver:

From the Sitemenu, choose New SiteThe Site Definition screen
opens.

2 Click the Advancedab.
3 In the Local Infocategory, specify the following:
A Sitename Thi s wi || show in Web browseros tit]l

A Local root foldefThis is the folder on your computer where all of your site files
are stored. For example c: \ My Site

A Defaultimages folder Speci fy the folder where your si
For example c: \ My Site \images

A HTTP addres$pecify your domain name. For example, http://your -
domain.com

4 From the Categorymenu, select the Remote Infatem.

5 From the Accessmenu, select the FTPoption. Most likely, your server
supports publishing through FTP (File Transfer Protocol, commonly
used for transferring files over the Internet).

6 Specify the following settings:

A FTP hostType your FTP host name without the ftp:// prefix. For example,
your - domain.com .

A Host directorySpecify the directory on the server where your site will reside. In
most cases, this is httpdocs

A Login and passwor®pecify the login name and password for access to the FTP
account.

A Use passive FTBelect this option only if your computer is behind a firewall.

7 To ensure that you specified the correct login and password, and that
Dreamweaver can connect to the server, click the Testbutton.

8 To save the settings, click OK

To publish your site:
Open your site in Dreamweaver.

2 From the Sitemenu, select the Putoption (or press Ctrl+Shift+U
simultaneously).
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Previewng a Site

Once you published a site on the server, you may want to make sure that it functions
properly in the actual hosting environment. You can preview the site through your
favorite Web browser, even if the information on the domain name has not yet
propagated in the Domain Name System. Note that Adobe Flash and CGI scripts will
not work during preview. Also, site preview does not work for Web sites and Web
pages that include absolute paths to other files (like <a
href="http://domain.tld/image.gif">).

U To preview a site:
1 Go to Domains> domain name
2 Click Site Preview

Configuring ASP.NET (Windows Hosting)

ASP.NET is a flexible set of tools and web development technologies that allows you to
employ a number of applications based on ASP.NET framework. Parallels Plesk Panel
supports both 1.1.x and 2.0.x versions of the .NET framework and allows configuring
most of its settings.

In this section:

Configuring ASP.NET for DOMANS.........coouviiiiiiiiieeiiieeeiee e eeaens 59
Configuring ASP.NET for Virtual DIr€CtOres. ...........uuuuuuumuieiiiiiiiieiiiiiiiiiiiiiennnennns 62
Restoring Default ASP.NET Configuration ............cccccvvviiiiiiiiiiiiiiiiiiiiiiiiieeeeeee 64
Changing .NET Framework Version for DOmains ...........cccooveeeiiiiiiiiiiiiieeeeeeeees 64

Changing .NET Framework Version for Virtual Directories ..........ccccceeevveeeeeeenens 65
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Configuring ASP.NET for Domains

Most ASP.NET configuration settings that commonly need to be customized in order
for ASP.NET applications to function in a desirable way can be edited through Parallels
Plesk Panel.

U To configure ASP.NET for a domain:

1 On your home page, click the domain name you need.
2 Click ASP.NET Settings the Hostinggroup.
3

Set up the strings that determine database connection data for
ASP.NET applications which use databases. This option is available
only for ASP.NET 2.0.x.

When you open the ASP.NET configuration page for the first time, sample
connection parameters with common constructions are displayed. You can then
delete them and specify your own strings.

A To add a string, enter the required data into the Nameand Connection Parameters
input fields and click @ next to them.
A To remove a string, click @ next to it.

4 Set up custom error messages that will be returned by ASP.NET
applications in the Custom Error Settingeeld:

A To set the custom error messages mode, select an appropriate option from the
Custom error mod@aenu:

A On- custom error messages are enabled.

A Off- custom error messages are disabled and detailed errors are to be
shown.

A RemoteOnly custom error messages are displayed only to remote clients,
and ASP.NET errors are shown to the local host.

A To add a new custom error message (which will be applied unless the Offmode
was selected), enter the values in the Status Codand Redirect URfields, and

click &.

A Status Codeéefines the HTTP status code resulting in redirection to the error
page.

A Redirect URHefines the web address of the error page presenting
information about the error to the client.

Due to possible conflicts, you cannot add a new custom error message with an
error code that already exists, but you can redefine the URL for the existing
code.

A To remove a custom error message from the list, click '@ next to it.
5 Configure compilation settings in the Compilation and Debuggifigld:

A To determine the programming language to be used as default in dynamic
compilation files, choose an entry from Page default languagst.
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A To enable compiling retail binaries, leave the Switch on debuggingheckbox
empty.

A To enable compiling debug binaries, select the Switch on debuggintheckbox. In
this case, the source code fragments containing error will be shown in a
diagnostic page message.

Note. When running applications in debug mode, a memory and/or performance
overhead occurs. It is recommended to use debugging when testing an application
and to disable it before deploying the application into production scenario.

Configure encoding settings for ASP.NET applications in the
Globalization Settingsection:

A To set an adopted encoding of all incoming requests, enter an encoding value
into the Request encodinfield (default is utf-8).

A To set an adopted encoding of all responses, enter an encoding value into the
Response encodirfgeld (default is utf-8).

A To set an encoding which must be used by default for parsing of .aspx , .asmx ,
and .asax files, enter an encoding value into the File encodindield (default is
Windows-1252).

A To set a culture which must be used by default for processing incoming web
requests, select an appropriate item from the Culturelist.

A To set a culture which must be used by default when processing searches for a
locale-dependent resource, select an appropriate item from the Ul Culturdist.

Set a code access security trust level for ASP.NET applications in the
Code Access Securitield.

CAS trust level is a security zone to which applications execution is assigned,
defining what server resources the applications will have access to.

Important. When an assembly is assigned a trust level that is too low, it does not
function correctly. For more information on the permissions levels see
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMChQ9.asp?frame=true#c09618429 010.

Enable the usage of the auxiliary scripts in the Script Library Settings
field. Specifying the script library settings is necessary if the validation
web controls are used on your web site. This option is available only
for ASP.NET 1.1.x.

A If you need to use auxiliary scripts (specifically, scripts implementing objects for
validating input data), provide the settings for .NET framework script library. To
do so, enter the path beginning with the domain root directory preceded by the
forward slash into the Path to Microsoft script librdigld, or click the folder icon
next to the Path to Microsoft script librdigld and browse for the required location.

A Toinitiate the auto-installation of files containing the scripts to the specified
location, select the Installcheck box. If the files already exist there, they will be
rewritten.

Set client session parameters in the Session SettingSeld:

A To set up the default authentication mode for applications, select an appropriate
item from the Authentication modeést. Windowsauthentication mode should be
selected if any form of IIS authentication is used.


http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
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A To set up time that a session can idle before it is abandoned, enter appropriate
number minutes into the Session timeotteld.

10 Click OKto apply all changes.

Note: Parallels Plesk Panel supports separate configurations for different versions of
the .NET framework (1.1.x and 2.0.x).
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Configuring ASP.NET for Virtual Directories

To improve the performance of ASP.NET-based web applications, Parallels Plesk
Panel allows using individual settings of .NET framework per virtual directory.

U To configure ASP.NET for a virtual directory:

1 On your home page, click the domain name you need.
2 Click Web Directories

3 Browse to the required directory and enter it.

4 Click ASP.NET Settings

5

Set up the strings that determine database connection data for
ASP.NET applications which use databases. This option is available
only for ASP.NET 2.0.x.

When you open the ASP.NET configuration page for the first time, sample
connection parameters with common constructions are displayed. You can then
delete them and specify your own strings.

A To add a string, enter the required data into the Nameand Connection Parameters
input fields and click @ next to them.
A To remove a string, click @ next to it.

6 Set up custom error messages that will be returned by ASP.NET
applications in the Custom Error Setigs field:

A To set the custom error messages mode, select an appropriate option from the
Custom error mod®enu:

A On- custom error messages are enabled.

A Off- custom error messages are disabled and detailed errors are to be
shown.

A RemoteOnly custom error messages are displayed only to remote clients,
and ASP.NET errors are shown to the local host.

A To add a new custom error message (which will be applied unless the Offmode
was selected), enter the values in the Status Codand Redirect URfields, and

click &.

A Status Codelefines the HTTP status code resulting in redirection to the error
page.

A Redirect URHefines the web address of the error page presenting
information about the error to the client.

Due to possible conflicts, you cannot add a new custom error message with an
error code that already exists, but you can redefine the URL for the existing
code.

A To remove a custom error message from the list, click @ next to it.
7 Configure compilation settings in the Compilation and Debuggifigld:

A To determine the programming language to be used as default in dynamic
compilation files, choose an entry from Page default languadjst.
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A To enable compiling retail binaries, leave the Switch on debuggincheckbox
empty.

A To enable compiling debug binaries, select the Switch ordebuggingcheckbox. In
this case, the source code fragments containing error will be shown in a
diagnostic page message.

Note. When running applications in debug mode, a memory and/or performance
overhead occurs. It is recommended to use debugging when testing an application
and to disable it before deploying the application into production scenario.

8 Configure encoding settings for ASP.NET applications in the
Globalization Settingsection:

A To set an adopted encoding of all incoming requests, enter an encoding value
into the Request encodinfield (default is utf-8).

A To set an adopted encoding of all responses, enter an encoding value into the
Response encodirfgeld (default is utf-8).

A To set an encoding which must be used by default for parsing of .aspx , .asmx ,
and .asax files, enter an encoding value into the File encodindield (default is
Windows-1252).

A To set a culture which must be used by default for processing incoming web
requests, select an appropriate item from the Culturelist.

A To set a culture which must be used by default when processing searches for a
locale-dependent resource, select an appropriate item from the Ul Qilturelist.

9 Set a code access security trust level for ASP.NET applications in the
Code Access Securitield.

CAS trust level is a security zone to which applications execution is assigned,
defining what server resources the applications will have access to.

Important. When an assembly is assigned a trust level that is too low, it does not
function correctly. For more information on the permissions levels see
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMChQ9.asp?frame=true#c09618429 010.

10 Enable the usage of the auxiliary scripts in the Script Library Settings
field. Specifying the script library settings is necessary if the validation
web controls are used on your web site. This option is available only
for ASP.NET 1.1.x.

A If you need to use auxiliary scripts (specifically, scripts implementing objects for
validating input data), provide the settings for .NET framework script library. To
do so, enter the path beginning with the domain root directory preceded by the
forward slash into the Path to Microsoft script librdigld, or click the folder icon
next to the Path to Microsoft script librdigld and browse for the required location.

A Toinitiate the auto-installation of files containing the scripts to the specified
location, select the Installcheckbox. If the files already exist there, they will be
rewritten.

11 Set client session parameters in the Session Settinggeld:

A To set up the default authentication mode for applications, select an appropriate
item from the Authentication modeést. Windowsauthentication mode should be
selected if any form of IIS authentication is used.


http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
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A To set up time that a session can idle before it is abandoned, enter appropriate
number minutes into the Session timeotteld.

12 Click OKto apply all changes.

Note: Parallels Plesk Panel supports separate configurations for different versions of
the .NET framework (1.1.x and 2.0.x).

Restoring Default ASP.NET @oinfition
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To restore the default ASP.NET configuration:

On your home page, click the domain name you need.
Click ASP.NET Settings the Hostinggroup.

Click Set to Default

Confirm the restoring and click OK

Changing .NET Framework Version for Domains

Since Parallels Plesk Panel supports both 1.1.x and 2.0.x versions of the .NET
framework, it is possible to choose the version used by your domains on a per-domain
basis.

w N -

4
5

To change the version of .NET framework used by a domain:
On your home page, click the domain name you need.
Click ASP.NET Settings the Hostinggroup.

Click Change Versiom the Toolsgroup. If this button is absent, only one
version of .NET framework is available. You can see the version
number in the Framework Versidield.

Select the required version number and click OK
Click OKto save changes.

Alternatively, on your home page you can click the domain name you need, then click
Setupand select the .NET framework version in the Microsoft ASP.NET suppdrop-down
menu.
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Changing .NEFramework Version for Virtual
Directories

In order to provide running ASP.NET applications which use different .NET framework
versions within one domain, Parallels Plesk Panel allows setting up the framework
version per virtual (web) directory, where the applications are deployed.

To choose the version of .NET framework for a virtual (web) directory:

On your home page, click the domain name you need.
Click Web Directorieis the Hostinggroup.

Enter the required web directory and click ASP.NET Settings the Tools
group.

4 Select the required .NET framework version and adjust other settings
as necessary.

5 Click OK

w N -

Setting PHP Version for a Domain
(Windows Hosting)

To set PHP version for a domain:

On your Home page, click the required domain name in the list.
Click PHP Settings

Choose the required version of PHP and click OK

w N -
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Deploying Databases

If your Web server incorporates data processing applications or is designed to
generate Web pages dynamically, you will likely need a database for storing and
retrieving data. You can either create a new database for your site or import the data
from your previously backed up MySQL, PostgreSQL, or Microsoft SQL database.

In this section:

Creating or Importing 8 Database.............uuuuuiiiiiiiiiiiiiiiiiiiiiiieeieieeeeeeeeeeeeeeeenee 67
Creating Database USer ACCOUNLES ..........ccuuiuiiiiiiieeeiieeiiiiee s e e e e e e e eeaees 68
Changing Database User PassWOrds...........cceeiieeeiiiieiiiiieeeeeee et eeeeeeenens 68
Removing Database USer ACCOUNTS...........couiiiiiiiiiiiiiiiiiiiiiiiieeieeeeeeeeeeee e 68

REMOVING Dat@basSeS ......uci i e e e e e e e aeanes 69
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Creating or Importing a Database

To create a new database on your hosting account:
Go to Domains> domain name Databasesnd click Add New Database
2 Enter a name for the database.

We recommend that you choose a name that starts with a Latin alphabet symbol
and comprises only alphanumeric and underscore symbols (up to 64 symbols).

3 Select the database type that you are going to use: MySQL,
PostgreSQL or Microsoft SQL Server.

4 Select the database server of the selected type from the list. Click OK

5 To set up database admi niAsdNemDambases cr e c
User

6 Type a user name and a password that will be used for accessing the
contents of the database.

7 Click OK

Toimport an existing database:
Go to Domains> domain name Databasesnd click Add New Database

2 Enter a name for the database. We recommend that you choose a
name that starts with a Latin alphabet symbol and comprises only
alphanumeric and underscore symbols (up to 64 symbols).

3 Select the database type that you are going to use: MySQL,
PostgreSQL, or Microsoft SQL Server. Click OK

4 To set up database admi niAsdNeveDa@mbrases cr e c
User

5 Type a user name and a password that will be used for accessing the
contents of the database. Click OK

6 Click the DB WebAdmircon in the Toolsgroup. An interface to
phpMyAdmin, phpPgAdmin, or ASPEnterpriseManager database
management tool will open in a separate browser window.

If you have a MySQL database:
1. Click Query windowin the left frame, click the Import filesab,
2. Select the text file that contains the data and click Ga
3. Click the Insert data from a text fli@k.

If you have a MS SQL database:

1. Click the name of your database in the left frame
2. Click Query(the magnifying glass button)
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3. Copy the text of your script into the text area and click Run
Query

To manage your databases and their contents, use your favorite MySQL, PostgreSQL,
or Microsoft SQL Server client or the Web based database management tool
accessible from Parallels Plesk Panel (Domains> domain name Database$ database
name> DB WebAdm)n

Creating Database User Accounts

If you collaborate with other people on managing a Web site and wish to give them
access to the database, you should create separate user accounts for them.
To create a database user account:

Go to Domains> domain name Databases database namend click
Add New Database User

2 Type a user name and a password that will be used for accessing the
contents of the database. Click OK

Changing Database User Passwords

To change password for a database user:

Go to Domains> domain name Databases database name database
user name

2 Type a new password and click OK

Removing Database User Accounts

To remove database user account:

=

Go to Domains> domain name Databases database name

Select a check box corresponding to the user account that you want
to remove.

3 Click RemoveNext, confirm removing and click OK

N
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Removing Databases

To remove a databasehwiits contents:
Go to Domains> domain name Databases

2 Select a check box corresponding to the database that you want to
remove.

If the required check box appears grayed out, this means that this database is used
by a Web application and you can remove it only by uninstalling the respective
application.

3 Click Remove
4 Confirm removal and click OK

Accessing Data From External Databases
(Windows Hosting)

If you want to access data from an external database management system, you should
create ODBC connections through Parallels Plesk Panel.

In this section:

Creating Connections to External Databases...........cccccoeeeeiiiiiiiiiiiiiiiiine e, 70
Changing Settings Of Existing ODBC CoNNECLiONS .........ceevieeeeiiiiiiiiiinieeeeeeenaens 70
Removing Connections to External Databases..............ccceeiiiiiiiiieiiiiiiiieeeeeceeees 70
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Creating Connections to External Databases

To let your Web applications use external databases for storing the data, you need to
create connections to these external databases.

To create an ODBC connection to an external database:
Go to Domains> domain name ODBC Data Sources
Click Add New ODBC DSN

Specify the ODBC connection name and description in the
corresponding fields.

Select the required driver in the Driverfield.
Click OK

6 Choose the appropriate options on the driver configuration screen.
Typically, you should specify the path to the database, user
credentials and other connection options, depending on the selected
driver.

7 Click Testto check whether the connection will function properly with
provided settings. Click Finishto complete the creation.

w N -
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Changing Settings Of Existing ODBC Connections

To change settings of an existing ODBC connection:

Go to Domains> domain name ODBC Data Sources
Click the required connection name in the list.
Change the settings as needed.

Click Testto check whether the connection will function properly with
new settings. Click Finishto save changes.

A WON PP C

Removing Connections to External Databases

To remove a redundant ODBC cotoe:
Go to Domains> domain name ODBC Data Sources

2 Select the check box corresponding to a connection you want to
remove.

3 Click Removeconfirm the removal and click OK
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Configuring Data Source Names for
Adobe ColdFusion (Windows Hosting)

If you are using Adobe ColdFusion, you can configure data source names (DSNs) for
ColdFusion through Parallels Plesk Panel. Data source hames allow your ColdFusion
Web applications to use local and remote databases for processing and storing
application data.

In ths section:

Creating a New Data Source NamME .........coovuiiiiiieeiiiiiiiiee e eeeees 71
Changing Settings of a Data Source Name ...........ccooovviiiiiiiiee e e, 72
Removing a Data Source NamMe ..........coovviiiiiiiiiiiiiiieee e 72

Creating a New Data Source Name

To create a new Data Source Name for Adobe ColdFusion on a domain:

Go to Domains> domain name ColdFusion DSEnd click Add New
ColdFusion DSN

2 Specify the data source name and select the required driver for this
data source in the Drivermenu. Click Next >>

3 Choose the appropriate options on the driver configuration screen.
Typically, you should specify the path to the database, user
credentials and other connection options, depending on the selected
driver. Refer to Adobe ColdFusion documentation for more information
on the driver configuration options.

4 Click OKto finish.
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Changing Settings of a Data Source Name

To change the settings of a data source name for Adobe ColdFusion on a domain:

Go to Domains> doman name> ColdFusion DSEnd click the required
data source name in the list.

2 Specify the data source name and select the required driver for this
data source in the Driver menu. Click Next >>

3 Choose the appropriate options on the driver configuration screen.
Typically, you should specify the path to the database, user
credentials and other connection options, depending on the selected
driver. Refer to Adobe ColdFusion documentation for more information
on the driver configuration options.

4 Click OK

Reming a Data Source Name

To remove a redundant ColdFusion DSN connection:
Go to Domains> domain name ColdFusion DSN

2 Select the check box corresponding to a DSN connection you want to
remove.

3 Click Removeconfirm the removal and click OK



Hosting Web Sites 73

Installing Aplications

To enhance your Web site with valuable features, such as guest books, forums, hit
counters, photo galleries, and e-commerce solutions, you can install the respective
applications from the control panel's application vault (Domains> domain name Web
Application¥. The number and variety of available applications depend on your

providerodés policy and your hosting pl an.

U To install an application on your site:

1 Go to Domains> domain name Web ApplicationsA list of applications
installed on your site will be displayed.

2 Click Add New Applicatioicon in the Toolsgroup.

3 In the left menu, select a category to which the application you need
belongs.

4 Select the required application in the list, and then click @# Install

5 Some applications will display a license agreement. Read the license
agreement carefully, and if you agree with it, select the | agreecheck
box and click Next >>

6 Specify whether you wish to create a hyperlink to the application and
place it in the control panel.

7 Specify the installation preferences and other information that may be
required by the application (the requirements may vary among
applications). Click Install

8 If you have chosen to create a hyperlink button inside your control
panel, specify its properties:

A Type the text that will show on your button in the Button labebox.

A Choose the location for your button. To place it on the domain administration
screen (Domains> domain namje select the Domain Administration gavalue as
the location. To place it in the left frame (navigation pane) of your control panel,
select the Navigation panealue.

A Specify the priority of the button. The buttons you create will be arranged on the
control panel in accordance with the priority you define: the lower the number 1
the higher is priority. Buttons are placed in the left-to-right order.

A To use an image for a button background, type the path to its location or click
Browseto browse for the desired file. It is recommended that you use a 16x16
pixels GIF or JPEG image for a button to be placed in the navigation pane, and
32x32 pixels GIF or JPEG image for buttons placed in the main frame.

A Type the hyperlink to be attached to the button into the URL box

A Using the check boxes, specify whether to include the data, such as domain id
and domain name to be transferred within the URL. These data can be used for
processing by external Web applications.

A In the Context help tip conteniisput field, type in the help tip that will be displayed
when you hover the mouse pointer over the button.
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A Select the Open URL in the control padleéck box if you wish the destination URL
to be opened in the control panel's right frame, otherwise leave this check box
unchecked to open the URL in a separate browser window.

A If you wish to make this button visible to the domain owners and e-mail users
who you granted access to control panel, select the Visible to all stlbginscheck
box.

9 Click OKto complete creation.

Now the application is installed and you can insert a link to this application into the Web
pages of your site, for example, on your home page. Otherwise, you and your users will
have to access this application by typing its URL, which can be too long to remember.
U To access the Web interface of gpliaation, do any of the following:

Type the URL in your browser. For example: http://your-domain.com/forum/.

A Go to Domains> domain name Web Applicationsand click an icon # ', corresponding
to the application you need.

A If you chose to add a hyperlink button to your Parallels Plesk Panel during
installation of an application, then click the respective button on the domain
administration screen (Domais > domain nameor navigation pane.

O To reconfigure an application, <change
install a license key for a commercial application:

1 Go to Domains> domain name Web Applications
2 4l i ¢ k &hcorrespomling to the application.

U To upgrade an application to a newer version (if it is available on the server):
Go to Domains> domain name Web Applications
2 Click a corresponding shortcut in the U column.

To uninstall an application:

Go to Domains> domain name Web Applicationsand select a check
box corresponding to the application that you no longer need.

2 Click Removeconfirm the removal and click OK The application will be
uninstalled and its databases removed from the server.

If you want a certain Web application to be started when someone visits the site, it can
be done by creating a default domain application.

U To set an application as default for a domain (available only for Windows hosting):
1 Go to Domains> domain name Web Applications

t

h
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2 Select a check box corresponding to Web Application you want to set
as default and click [& Default Click OKto confirm.

Now, when a user visits the site, he or she is taken to the default Web application's
pages.

In this section:

Installing Java Web ApplICAtIONS .........cooeeiieieeeeeeeee e 76
Installing ASP.NET Web Applications (Windows HOStING) ..........cccevvvvviiinennnnnn. 77
Installing Ruby Web Applications (Linux HOStING)...........ccovviiiiiiiiieeiiieeceee e, 79
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Installing Java Web Applications

You can install Java Web application packages in the Web archive format (WAR).
These Java applications are not distributed with Parallels Plesk Panel, therefore you
should obtain them separately.

i

To install a Java Web application:
Go to Domains> domain name Java Applicationand click Switch On

This will start the Tomcat service, which provides an environment for Java code to
run in cooperation with a Web server.

Click Install New Application

Specify the path to an application package you wish to install (this
can be an application package in WAR format saved on your
comput er 6 s har dBroive to nawigate tooitr thea tlickcOK

Now the application is installed and the respective entry is added to the list of installed
Java applications (Domains> domain name Java Applications

i

N
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To access the web interface of a Java Web application, darenfolbdwing:

Go to Domains> domain name Java Applicationsand click a respective hyperlink in
the Pathcolumn.

Type the URL in your browser. For example: http://your-
domain.com:9080/storefront/.

To stop, start or restart a Java Web application:

Go to Domains> domain name Java ApplicationsA list of installed
applications will open.

Locate an application on the list, and use the icons in the right part of
the list to perform the required operations:

To start an application, click the icon &4,
To stop an application, click the icon W)
To restart an application, click the icon @,

To uninstall a Java Web application:

Go to Domains> domain name Java Applications

Select a check box corresponding to the application that you no
longer need. Click Removeconfirm the removal and click OK

The application will be uninstalled and its databases removed from the server.
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Installing ASP.NET Web Applications (Windows
Hosting)

In addition to the applications from the Application Vault and Java Web Applications,
you can install ASP.NET Web application packages provided with Parallels Plesk
Panel.

To install an application on your site:

Go to Domains> domain name Web Applications ASP.NET 1.1
Applications
A list of ASP.NET 1.1 Web applications installed on your site will be displayed.

2 Click Install New Applicatidn the Toolsgroup. A list of Web applications
available for installation will be displayed. To specify which
application you wish to install, select a radio button corresponding to
the application of your choice.

3 Click @ Install
4 Specify the domain folder in which the application should be installed,
database name for the application, and click Install

Now the application is installed and you can insert a link to this application into the Web
pages of your site, for example, on your home page. Otherwise, you and your users will
have to access this application by typing its URL, which can be long enough to
remember.

U To access the Web interface of an applicaticanydof the following:
A Type the URL in your browser. For example: http://your-domain.com/forum/.
A Go to Domains> domain name Web Applications ASP.NET 1.1 Applicatipasd click
an icon =, corresponding to the application.
0 To reconfigure an application or change

Go to Domains> domain name Web Applications ASP.NET 1.1 Applicatipasd click an
icon %#, corresponding to the application.

To uninstall an application:

Go to Domains> domain name Web Applications ASP.NET 1.1
Applications and select a check box corresponding to the application
that you no longer need.

2 Click RemoveThe application will be uninstalled and its databases
removed from the server.

If you want a certain Web application to be started when someone visits a site, it can
be done by creating a default domain application.

U To st an application as default for a domain:

1 Go to Domains> domain name Web Applications ASP.NET 1.1
Applications
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A list of application packages installed on the site will be displayed.

2 Select a check box corresponding to the application package you

want to set as default, then click Default Click OKto confirm the
creation of the default Web application.

Now, when a user visits the site, he or she is taken to the default Web application's
pages.
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Installing Ruby Web Applications (Linux Hosting)

You can install on your site custom Web applications developed in the Ruby
programming language.

i
1
2
3

8

To install on your site an application written in Ruby:
Go to Domains domain name Web Hosting Setgs.
Select the CGland FastCGtheck boxes, and click OK

Connect to your FTP account, change to the /httpdocs  directory,
and create a subdirectory where the application files will reside. Let's
call this directory <your_application> , for illustration purposes.

Upload the application files to the httpdocs/<your_application>
directory.

Locate the readme file in the application directory. Follow the
instructions from this file to install the application. Note that
installation of additional Ruby modules or operating system
components may be required. In such a case, contact your hosting
service provider or server administrator for assistance.

Log in to the server shell over SSH and issue the command cd
/<path_to_virtual_hosts>/<your_domain_name>/httpdocs;

mv <your_application> <your_application>.real; In -S
<your_application>.real/public <your_application>

where <path_to_virtual_hosts> is the path to the directory with virtual host
configuration files, <your_domain_name> is the name of your domain, and
<your_application> is the directory where your Ruby application is located.

If you do not have access to server shell, ask your server administrator or hosting
service provider to perform this step for you.

Create a file with name .htaccess in the directory
<your_domain_name>/httpdocs/<your_application>/public, open it
with a text editor of your choice and add the following lines into the
file:

AddHandler fcgid - script .fcqi

Options +FollowSymLinks +ExecCGlI

RewriteEngine On

RewriteBase /<your_application>

RewriteRule *$ index.html [QSA]

RewriteRule ~([*.]+)$ $1.html [QSA]

RewriteCond %{REQUEST_FILENAME}! -f

RewriteRule ~(.*)$ dispatch.fcgi [QSA,L]

ErrorDocument 500 "<h2>Application error</h2>Rails
application failed to start properly"

Save the file.
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9 Make sure that the proper path to the Ruby interpreter is specified in
the file public/dispatch.fcgi . issue the commands head -nl
dispatch.fcgi and which ruby . The both commands must return
identical values.

Now the Web application will be accessible at the following URL: http://your-
domain.com/your_application.

Using IIS Application Pool

IIS Application Pool contains all web applications on your domains. If your service
provider has given you a dedicated IS application pool, it allows you to have a level of
isolation between web applications used by your domains and web applications used
by other domain owners that host their web sites on the same server. Because each
application pool runs independently, errors in one application pool will not affect the
applications running in other application pools.

Once you enable the application pool, all web applications on your domains will be
using it.

To stop all applications running in the application pool, click [ISApplication Poabn your
home page and click Stop

To start all applications in the application pool, click IS Application Pooh your home
page and click Start

To restart all applications running in the application pool, click IIS Application Pooh

your home page and click Recycle This can be handy if some applications are known to
have memory leaks or become unstable after working for a long time.

In this section:

Setting Up IS ApPliCation POOL...........coiiiiiiiiiee e 81
Disabling 1S Application POOL......... oo e 81
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Setting Up IIS Application Pool

A W NP C
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To enable IIS application pool for a domain:

On your Home page, select a domain from the list.

Click IIS Application Paol

Click Switch On

To limit the amount of CPU resources that this domain's application

pool can use, select the Switch on CPU monitoricpeckbox and provide a

number (in percents) in the Maximum CPU use (fi@ld.
Click OK

To enable IIS application pool for all your d@nai
On your Home page, click IIS Application Pool
Click Switch On

To limit the amount of CPU resources that the application pool can
use for all your domains, select the Switch on CPU monitorieeckbox
and provide a number (in percents) in the MaximunCPU use (%)eld.

Click OK

Disabling IS Application Pool

A W NP C
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To disable IIS application pool for a domain:

On your Home page, select a domain from the list.
Click IIS Application Paol

Click Switch Off

Click OK

To disable IIS application pool for ailrydomains:
On your Home page, click 11S Application Pool
Click Switch Off

Click OK
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Securing Web Sites

This chapter describes the measures for securing Web sites you host.

In this section:

Securing E-commerce Transactions with Secure Sockets Layer Encryption ..... 82

Restricting Bandwidth Usage for SIteS..........uuviieiiiiiiiiie e 89
Restricting the Amount of Simultaneous Connections to Sites ..........cc.oeeeeveeeees 89
Protecting Sites From Bandwidth Stealing (Windows HOStING) ..........cccvvvveveeeee. 90
Restricting Access to Web Server's Resources with Password Protection ........ 90
Setting File and Directory Access Permissions (Linux Hosting) ........ccceeeeeeeieees 93
Setting File and Directory Access Permissions (Windows HoOStING) ................... 93

Securing Eommerce Transactions with Secure
Sockets Layer Encryption

If you are running an e-commerce business, you need to secure transactions between
your customers and your site. To prevent the valuable data, such as credit card
numbers and other personally identifiable information from stealing, you should use the
Secure Sockets Layer protocol, which encrypts all data and transfers them securely
over the SSL connection. And even if someone intercepts the data for malicious intent,
they will not be able to decrypt and use them.

To implement the Secure Sockets Layer protocol on your web server, you should
purchase an SSL certificate from a reputable certificate vendor (these vendors are
called Certificate Authorities), and then install this certificate on your site. To enable
SSL protection, you must host your site on a dedicated IP address, which is not shared
among other web sites.

There are numerous certificate authorities to choose from. When considering one, pay
attention to reputation and credibility of the CA. Knowing how long they have been in
business and how many customers they have will help you make the right choice.

Your Parallels Plesk Panel provides facilities for purchasing SSL certificates from
Comodo, GeoTrust, Inc and GoDaddy.

In this section:

Obtaining and Installing SSL Certificates from Comodo, GeoTrust, Inc. or GoDaddy

.......................................................................................................................... 83
Obtaining and Installing SSL Certificates from Other Certification Authorities.... 85
Creating and Installing Free Self-sighed SSL Certificate .............cccceeeeivieeeeinnnns 86
Uninstalling a Certificate from YOur Site€ ..........ooovviiiiiiiiiiiiiiiiiieeeee 87

Using SSL Certificate Shared By Another Domain (Windows Hosting Only) ..... 88
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Obtaining and Installing SSL Certificates from Comodo,
GeoTrust, Inc. or GoDaddy

U To purchase an SSL certificate through MyPleskCom online store and secure your
site:

1 Go to Domains xlomain name SSL Certificate®\ list of SSL certificates
that you have in your repository will be displayed.

2 Click Add SSL Certificate

3 Specify the certificate properties:
A Certificate name. This will help you identify this certificate in the repository.

A Encryption level. Choose the encryption level of your SSL certificate. We
recommend that you choose a value more than 1024 bit.

A Specify your location and organization name. The values you enter should not
exceed the length of 64 symbols.

A Specify the domain name for which you wish to purchase an SSL certificate.
This should be a fully qualified domain name. Example: www.your-domain.com.

A Enter the domain administrator's e-mail address.

4 Make sure that all the provided information is correct and accurate, as
it will be used to generate your private key.

5 Click Buy SSL Certificatéfour private key and certificate signing request
will be generated 8 do not delete them. MyPlesk.com login page will
open in a new browser window.

6 Register or login to an existing MyPlesk.com account and you will be
taken step by step through the certificate purchase procedure.

7 Choose the type of certificate that you wish to purchase.

8 Click Proceed to Bugnd order the certificate. In the Approver BMaildrop-
down box, please select the correct Approver e-mail.

9 The approver e-mail is an e-mail address that can confirm that
certificate for specific domain name was requested by an authorized
person.

10 Once your certificate request is processed, you will be sent a
confirmation e-mail. After you confirm, the SSL certificate will be sent
to your e-mail.

11 When you receive your SSL certificate, save it on your local machine
or network.

12 Return to the SSL Certificates repository (Domains> domain name SSL
Certificates

13 Click Browsein the middle of the page and navigate to the location of
the saved certificate. Select it, and then click Send FileThis will upload
and install the certificate against the corresponding private key.

14 Return to your domain's administration screen (Domains> domainnamé
and click Web Hosting Settings
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15 Select the SSL certificate that you wish to install from the Certificate
menu.

If there is no Certificatanenu on the screen, this means that you are on a shared
hosting account; therefore, you need to upgrade your hosting package and
purchase a dedicated IP address from your hosting provider.

16 Select the SSL supportheck box and click OK
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Obtaining and Installing SSL Certificates from Other
Certification Authorities

To secure your site with an SSL certificate fther certificate authorities:

Go to Domains ¥lomain name SSL Certificate®d list of SSL certificates
that you have in your repository will be displayed.

2 Click Add SSL Certificate
3 Specify the certificate properties:
A Certificate name. This will help you identify this certificate in the repository.

A Encryption level. Choose the encryption level of your SSL certificate. We
recommend that you choose a value more than 1024 bit.

A Specify your location and organization name. The values you enter should not
exceed the length of 64 symbols.

A Specify the domain name for which you wish to purchase an SSL certificate.
This should be a fully qualified domain name. Example: www.your-domain.com.

A Enter the domain administrator's e-mail address.

4 Make sure that all the provided information is correct and accurate, as
it will be used to generate your private key.

5 Click RequestYour private key and certificate signing request will be
generated and stored in the repository.

6 In the list of certificates, click the name of the certificate you need. A
page showing the certificate properties opens.

7 Locate the CSR sectioon the page, and copy the text that starts with
the line ----BEGIN CERTIFICATE REQUESINd ends with the line ----END
CERTIFICATE REQUESTO0 the clipboard.

8 Visit the Web site of the certification authority from which you want to
purchase an SSL certificate, and follow the links on their site to start a
certificate ordering procedure. When you are prompted to specify CSR
text, paste the data from the clipboard into the online form and click
Continue The certification authority will create an SSL certificate in
accordance with the information you supplied.

9 When you receive your SSL certificate, save it on your local machine
or network.

10 Return to the SSL Certificates repository (Domains> domain name SSL
Certificates

11 Click Browsein the middle of the page and navigate to the location of
the saved certificate. Select it, and then click Send FileThis will upload
and install the certificate against the corresponding private key.

12 Return to your domain's administration screen (Domains> domain name
and click Web Hosting Settings

13 Select the SSL certificate that you wish to install from the Certificate
menu.
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If there is no Certificatanenu on the screen, this means that you are on a shared
hosting account; therefore, you need to upgrade your hosting package and
purchase a dedicated IP address from your provider.

14 Select the SSL supportheck box and click OK

Creatiig and Installing Free Ssifned SSL Certificate

If you do not want to purchase SSL certificates, but still need to secure your site, you

can create a self-signed certificate and install it on your Web server. This will provide

data encryption; however,your cust omer s6é browsers will show
telling that your certificate is not issued by a recognized authority. Thus, using self-

signed certificates is not recommended as it will not instill confidence in customers, and

is likely to adversely affect your online sales.

To secure your site with a s&fined SSL certificate:

Go to Domains ¥lomain name SSL Certificate®d\ list of SSL certificates
that you have in your repository will be displayed.

2 Click Add SSL Certificate
3 Specify the certificate properties:
A Certificate name. This will help you identify this certificate in the repository.

A Encryption level. Choose the encryption level of your SSL certificate. We
recommend that you choose a value more than 1024 bit.

A Specify your location and organization name. The values you enter should not
exceed the length of 64 symbols.

A Specify the domain name for which you wish to generate an SSL certificate. For
example: www.your-domain.com.

A Enter the domain owner's e-mail address.

4 Click SelfSigned Your certificate will be generated and stored in the
repository.

5 Return to your domain's administration screen (Domains> domain name
and click Web Hosting Settings

6 Select the self-signed SSL certificate from the Certifiate menu.

If there is no Certificatanenu on the screen, this means that you are on a shared
hosting account; therefore, you need to upgrade your hosting package and
purchase a dedicated IP address from your hosting provider.

Select the SSL supportheck box and click OK

\]
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Uninstalling a Certificate from Your Site

To uninstall a certificate from your site and disable SSL protection:

Make sure that the certificate you want to remove is not used at the
moment.

2 Go to Domains> domain name Web Hosting Settjs. The Certificatemenu
indicates which SSL certificate is currently used.

3 If the certificate that you want to remove is currently in use, you
should first release it: in the Certificatedrop-down box, select another
certificate and click OK

4 Remove the certificate from repository.

5 To permanently remove the certificate from repository, go to Domains>
domain name SSL Certificates

6 Select a check box corresponding to the certificate that you no longer
need and click Remove

7 Confirm removal and click OK

8 Disable SSL support if you no longer need it: Go to Domains> domain
name> Web Hosting Settings.

9 Clear the SSL supportheck box and click OK
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Using SSL Certificate Shared By Another Domain (Windows
Hosting Only)

Shared SSL is a means of securing access to a site with SSL (Secure Sockets Layer)
without purchasing your own SSL certificate. Web sites that employ shared SSL are, in
fact, using the certificate shared by another domain. The domain that shares its SSL
certificate with others is called Master SSL Domain.

Note: In order to use shared SSL, the Master SSL Domain should be set either by your
server administrator or by you on another domain, if you have the permission to do so.

To configure the Master SSL Domain and enable shared SSL fomgins:do
On your Home page, click Shared SSL
Select the Switch on shared SQilheck box.

Select the required domain name. Only those domains that are hosted
by you and have SSL enabled, are present in the list.

Click OK

5 Now you need to create the shared SSL links for every domain that
needs SSL protection: Go to Domains> domain name Shared SSL

6 Select the Switch on shared SSiheck box.

7 Specify the virtual directory name in the corresponding input field.
The virtual directory with the supplied name will be created on the
Master SSL Domain. This directory will be used for accessing your
site through SSL.

For example, let us suppose that you have a domain named mydomain.com,
Master SSL Domain is defined as master_ssl_domain.com, and the virtual directory
name you supplied is my_virtual_dir . In this case, to access your site through
SSL, you need to use the following address:
https://master_ssl_domain.com/my_virtual_dir.

w N -
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Note: You cannot use your domain name (for example, mydomain.com) to access
your site via SSL if you are using shared SSL.

8 Select the directory where protected content is located on your
domain. The documents within specified directory will be accessible
only through SSL. You can only choose either httpdocs or
httpsdocs as a target directory.

9 To make your domain accessible via SSL only, select the Require SSL
check box.

10 Click OK

U To disable shared SSL for your domains:
1 On your Home page, click Shared SSL
2 Clear the Switch on share8SLcheck box.
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3

Click OK

Restricting Bandwidth Usage for Sites

To avoid excessive usage of bandwidth, which can lead to resources overage, you can
limit bandwidth usage for a site.

w N =

To limit the bandwidth for a site:
Go to Domains> domain name Bandwidh Limiting
Select the Switch onbandwidth limitingheck box.

Specify the maximum speed (measured in KB per second) that a
domain can share between all its connections in the Maximum bandwidth
usage (KB/Sjeld.

Click OK

Restricting the Amount of Sitaneous Connections
to Sites

To avoid Denial Of Service attacks and to prevent excessive usage of bandwidth, you
can set a limit of maximum number of simultaneous web connections your domain can
have.

w N -

To limit the maximum number of simultaneous conngttiaWeb site:
Go to Domains xlomain name Bandwidth Limiting
Select the Switch on connections limitimineck box.

Specify the maximum number of simultaneous connections in the
Connections limited tideld.

Click OK
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Protecting Sites From Bandwi&tealing (Windows
Hosting)

Hotlinking (also called file leeching, remote linking, direct linking, bandwidth stealing or
bandwidth banditism) is a term used for describing a situation when a Web page of one
domain owner is directly linking to images (or other multimedia files) on the Web pages
of another domain owner, usually using an <IMG> tag. If your domains are hotlinked,
you may face the problem of excessive bandwidth usage.

To protect a domain from hotlinking:
Go to Domains> domain name HotlinkProtection
Click Switch Orto enable the protection from hotlinking.

Specify the extensions of files you wish to be protected from
hotlinking (for example, jpg, bmp, and so on) in the Protected files
extensiondield. When listing several file extensions, separate them
with spaces.

4 Click OK

w N =

Restricting Access to Web Server's Resources with
Password Protection

If you have URLSs on your site that only authorized users should see, restrict access to
these URLs with password protection.

In this section:

ProteCting @ RESOUICE .. ... iiiiieeeiiee et e e e e e e a e e e e e e e eeeaees 91
SpeCifying AULNONZEA USEIS .......uuiiiiiiiiiiiiiiiiiiiiiieiiiiiieieieieieaeebeeeeeeeeeeeeeeeeeeennenne 92
UNProtecting @ RESOUICE........ccoviiiiiiiiiiiiiieeeeee e 92
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Protecting a Resource

w N R

To passvord protect a directory in your site and to specify authorized users:
Go to Domains xlomain name Password Protected Directories
Click Add New Directory

Specify the path to the directory that you wish to password protect in
the Directory naméox.

This can be any directory existing in your site, for example: /private . If the
directory that you would like to protect has not yet been created, specify the path
and the directory name i Parallels Plesk Panel will create it for you.

Specify in what location (also called document root) your password
protected directory resides or will reside (available only for Linux
hosting). For example:

A To protect the httpdocs/private directory, type ‘/private’ in the Directory name
box and select the NonSSLcheck box.

A To protect the httpsdocs/private directory, type '/private' in the Directory
namebox and select the SSLcheck box.

A To protect your CGI scripts stored in the cgi - bin directory, leave '/' in the
Directory nambox and select the cgi-bin check box. Make sure there are no
white spaces after the slash symbol; otherwise, a protected directory will be
created with the name consisting of white spaces.

In the Header Textox, type a resource description or a welcoming
message that your users will see when they visit your protected area.

Click OK The directory you specified will be protected.
To add authorized users, click Add New User

Specify the login name and password that will be used for accessing
the protected area. The password should be from 5 to 14 symbols in
length. Click OK

To add more authorized users for this protected resource, repeat the
steps 7 and 8.
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Specifying Authorized Users

A WODN PP C

To add an authorized user of a protected directory:

Go to Domains xlomain name Password Protected Directories
Click the name of the directory you need.

Click Add New User

Specify the login name and password that will be used for accessing
the protected area. The password should be from 5 to 14 symbols in
length.

Click OK

To change password for an authorized usepuitacted directory:
Go to Domains ¥lomain name Password Protected Directories

Click the name of the directory you need. A list of authorized users
will open.

Click the userds name.
Specify the new password and re-type it for confirmation.
Click OK

To revoke a permission to access the protected directory from a user:
Go to Domains xlomain name Password Protected Directories

Click the name of the directory you need. A list of authorized users
will open.

Select a check box corsnaneponding t
Click Remove Confirm the operation and click OK

Unprotecting a Resource

To remove password protection and make the resource available to the public:

Go to Domains ¥lomain name Password Protected Directoridslist of
password protected directories will open.

Select a check box corresponding to the name of the directory, from
which you want to remove protection.

Click Remove The protection will be removed and the contents of the
directory will be accessible to the public without restrictions.

o

t

h ¢
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Setting File and Directory Access Permissions (Linux
Hosting)

U To review or change the permissions set for files and directories:
1 Go to Domains> domain name
2 Click File Manager

The permissions are represented as three sets of symbols, for example, 'rwx rwx r--'.
The first set tells what the owner of the file or directory can do with it; the second tells
what the user group, the file or directory belongs to, can do with the file or directory; the
third set indicates what other users (the rest of the world, i.e. Internet users visiting a
site) can do with the file or directory. R means the permission to read the file or
directory, W means the permission to write to the file or directory, and X means the
permission to execute the file or look inside the directory.

To modify permissions for a file or directory, in the Permissionsolumn, click the
respective hyperlink representing the set of permissions. Modify the permissions as
desired and click OK

Setting File and Directory Access Permissions
(Windows bkting)

Parallels Plesk Panel provides setting up file and folder access permissions, including
defining special permissions and permissions inheritance, similarly to the way it is
presented in Windows interface.

Note. For security reasons, permissions for Administrators, SYSTEM and Parallels
Plesk Panel Domain Administrator cannot be changed or removed.

In this section:

Setting and Changing Access Permissions for Groups and Users..................... 94
Removing Access Permissions from Groups and USers...........coooevvvciinieeeeneenns 95
Setting Up Access Permissions Inheritance for Files and Folders...................... 95
Setting, Changing and Removing Special Access Permissions..............ccceceee. 96
Setting Access Permissions for Virtual DireCtories .........cccceeveeeeviieeiiiiiiieeeeeeennns 96

Repairing ACCESS PEIMISSIONS ........uiiiieeeiiieiiiiis e e e 97
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Setting and Changing Accd3srmissions for Groups and
Users

To set or change access permissions for a group or user:
Go to Domains> domain name File Manager
2 Click &1 corresponding to the required file or folder.

A To change or remove permissions from a group or user, click the required name
in the Group or user namédist.

A To set permissions for a group or user, which is not in the Group or user names
list, select the required user/group name from the drop-down box located above
the list and click @: the user/group appears in the list. Select it.

3 To allow or deny permissions to a selected group/user, select the
Allowor Denycheck boxes corresponding to permissions listed under
Permissions for [user/group name]

Note. If check boxes in Allowand/or Denycolumns are shaded, it means that the
corresponding permissions are inherited from a parent folder.

A To deny the permission, which are inherited from a parent object as allowed,
select the required check boxes under Deny This will override inherited
permissions for this file/folder.

A To allow the permission, which are inherited from a parent object as denied,
clear the Allow inheritable permissions from the parent tpagate to this object and all
child objects. Include these with entries explicitly definedheck box: this removes
the inherited permissions. Then select the required check boxes under Allowand
Deny

4 Click OK
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Removing Access Permissions from Gsaam Users

To remove access permissions from a group or user:
Go to Domains> domain name File Manager
Click the icon Il corresponding to the required file or folder.

Select the required name in the Group or user naméist and click @ next
to it.

w N -

Note: The & icons appear unavailable for entries with permissions inherited from a
parent object.

4 Select the required entry.

5 Clear the Allow inheritable permissions from the parent to propagate to this object
and all child objects. Include these with entries explicitly definechieare box.

6 Select the entry again and click &.
7 Click OK

Setting Up Access Permissions Inheritance for Files and Folders

To set up access permissions inheritance for files and folders:
Go to Domains> domain name File Manager
Click an icon Il corresponding to the required file or folder.

To make the file/folder inherit permissions from a parent folder (if it

does not), select the Allow inheritable permissions from the parent to propagate
to ths object and all child objects. Include these with entries explicitly defined here
check box.

4 To make the files and folders, which are contained in this folder,

inherit the folder permissions defined here, select the Replace permission
entries on all chdlobjects with entries shown here that apply to child olgkeetsk

box.

5 Click OK

w N R
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Setting, Changing and Removing Special Access Permissions

You can also set, change and remove special permissions including advanced
management of folder permissions inheritance. In Advancegermissions management
mode, several permission entries can be associated with a single group or user, each
containing different set of permissions. Also, the list of permissions in Advancednode is
more detailed and gives more opportunities for fine-tuning file/folder permissions. It
contains permissions that cannot be seen in Microsoft Windows interface, but present
combinations of native Microsoft Windows permissions. They are Read Control, Write
Control, and Execute Control.

To setchange or remove file/folder special permissions:
Go to Domains> domain name File Manager
Click an icon Il corresponding to the required file or folder.

Click Advanced

A To create a permission entry for a group or user, select the required name from
the Group or user namdist and click @.

w N R

A To set or change file/folder permissions for a group or user, select the required
name from the Growp or user namdsst, select the required Allowand Denycheck
boxes corresponding to permissions listed under Permissions for [group/user
name]

A To remove a permission entry for a group or user, select the required name from
the Group or user namdist and click @,

A To make child objects of a folder inherit its permissions defined under
Permissions for [group/user napsglect the Replace permission entries on all child
objects with entries shoviaere that apply to child objectseck box, and select check
boxes in the Apply ontolist which correspond to objects you want to inherit the
permissions.

4 Click OK

Setting Access Permissions for Virtual Directories

Access permissions can also be applied to virtual (Web) directories.

To set access permissions for a virtual directory:
Go to Domains> domain name Virtual Directories
Navigate the web site structure and click the required directory.

Click Permissionsn the Toolsgroup and set access permissions for this
virtual directory, as described in the preceding sections.

w N -
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Repairing Access Permissions

If some scripts on your sites stop working, this might be due to the incorrectly defined
or corrupted file and folder access permissions. It is advised to run check and repair
process to restore proper access permissions, thereby restoring scripts functioning.

U To check and repair access permissions for a domain or a group of domains, restoring
scripts functioning:

1 Click the Domainsshortcut in the navigation pane.

2 Select the check boxes corresponding to the domain names you want
to perform permissions check on.

3 Click [ Check permissions
4 Adjust the settings as required:

A Clear the Checkonly moe check box to check and repair access permissions.
Leave the Checkonly modecheck box selected to run the checking in the read-
only mode, when permissions are only checked (with errors reported), but not
fixed.

A Leave the Send notification bymailcheck box selected to receive check and
repair report by e-mail, and specify the required e-mail address in this field.

5 Click OK Parallels Plesk Panel will start checking permissions and
correcting them, if the corresponding option is set. Please note that
this procedure might take a lot of time, depending on the complexity
of file and folder structure of your domains.
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Organizing Site Structure with
Subdomains

Subdomains are additional domain names that enable you to:

A Organize logically the structure of your site

A Host additional Web sites or parts of a Web site on the same server without the
need to pay for registration of additional domain names

An example of using subdomains:

You have a Web site your-product.com dedicated to promoting your software product.

For publishing userbé6s guides, tutorials and
organize the subdomain 'userdocs' so that your users will be able to access online user
documentation directly by visiting the domain name userdocs.your-product.com.

Inthis section:

Setting Up Subdomains (LiNUX HOSEING) ....ccuvuiiiiiieiiiieecee e 99
Setting Up Subdomains (Windows HOSHING) .........uvuuuiriiiiiiiiiiiiiiiiiiiiiiiiiieeieennnnnns 100
RemoviNg SUDAOMEAINS .......coiviiiiiiiiiiiiiiiecee e 102
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Setting Up Subdomains (Linux Hosting)

w N =

To set up a subdomain:
Go to Domains> domain name Subdomains
Click Add New Subdomain

Type the subdomain name as desired. This can be, for example, a
topic of your site, organization department, or any other combination
of letters, numbers and hyphens (up to 63 characters in length).

The subdomain hame must begin with an alphabet character. Subdomain names
are case insensitive.

If this subdomain will require secure transactions, select the SSL
suppat check box. Then, the SSL certificate installed under the parent
domain will be used for encrypting transactions.

By default, when you publish the site, you need to upload the web content that
should be accessible via secure connections to the httpsdocs  directory, and the
content that should be accessible via plain HTTP, to the httpdocs  directory. For
your convenience, you can choose to publish all content through a single location 1
httpdocs  directory, to do this, select the option Use a single directpfor housing SSL
and norSSL content

If this subdomain will hold a part of your own Web site that you

manage on your own, leave the Use the FTP user account of the parent domain
option selected. If this subdomain will hold a separate web site that

will belong to or will be managed by another person, select the Create a
separate user account for this subdonmgition, and specify the login name

and password that will be used for accessing the web space through

FTP and publishing web site content.

If you wish to limit the amount of disk space that can be occupied by
Web content under this subdomain, type the desired value in
megabytes into the Hard disk quotaox.

When the specified limit is exceeded, you will not be able to add files to the web
space, and editing existing files may corrupt them.

Specify the programming languages in which your Web site is
developed. Otherwise, your Web site may not function properly.

For example, if your Web site is written mainly in ASP and uses some applications
written in PHP, such as those from the Application Vault (Domains> domain name
Web Applicationsselect the ASP supporand PHP supportheck boxes.

To complete the setup, click OK It may take up to 48 hours for the
information on new subdomain to spread in the Domain Name System
and become available to the Internet users.

To publish web content to the subdomai nés
in the Creating and Publishing a Site (see page 47) section.

We b
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Setting Up Subdomai@Windows Hosting)

w N =

To set up a subdomain:

Go to Domains> domain name Subdomains

Click Add New Subdomain

Select the required Hosting typeand click OK

A Select Physical hostingo create a virtual host for the domain.

A Select Subdomain on subfold&r create a virtual subdomain. Subdomain on
subfoldemill use physical structure of the domain. The creation of a separate
FTP user account will be not possible: the FTP user account of the domain will
be used.

Type the subdomain name as required. This can be, for example, a

topic of a site, organization department, or any other combination of
letters, numbers and hyphens (up to 63 characters in length). To add
the WWWprefix, select the appropriate check box.

The subdomain name must begin with an alphabet character. Subdomain names
are case insensitive.

If you are creating subdomain on subfolder, specify the physical
location for the subdomain files in the Site home directorfyeld:

A Clear the Create physical directory for subdonaiiack box and specify the existing

directory to the right of httpdocsfield. You can click ' to browse for the required
directory, select it and click OK

A Leave the Create physical directory for subdonaiack box selected to create a
corresponding physical directory with the same name as the subdomain.

If you are creating subdomain with physical hosting, specify the FTP
user account for it:

A If this subdomain will hold a part of your own Web site that you manage on your
own, leave the Use the FTP user account of the main doomgiion selected.

A I this subdomain will hold a separate web site that will belong to or will be
managed by another person, select the Create a separate user account for this
subdomairoption, and specify the login name and password that will be used for
accessing the web space through FTP and publishing web site content. Specify
the hard disc quota in the appropriate field in megabytes or leave the Unlimited
check box selected. When the specified limit is exceeded, you will not be able to
add files to the web space, and editing existing files may corrupt them.

If you wish to limit the amount of disk space that can be occupied by
web content under this subdomain, type the desired value in
megabytes into the Hard disk quotaox.

When the specified limit is exceeded, you will not be able to add files to the web
space, and editing existing files may corrupt them.

Leave the Create and publish site with Sitebuilcleeck box selected to be
able to access Sitebuilder and build web site through your Parallels
Plesk Panel interface. When the Create and publish site with Sitebuilder
option is selected, a site will be created in Sitebuilder.
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All publishing parameters will be set in the paths predefined: for subdomain with
Physical hosting /subdomains/SUBDOMAINNAME/httpdocs/sitebuilder; for
subdomain with Subdomain on subfolderhttpdocs/SUBDOMAINNAME/.

9 If you want to enable Microsoft FrontPage supposelect the appropriate
check box. Enable or disable Renote Microsoft FrontPage authoring
selecting the appropriate option.

10 Specify the programming languages support in the Servicesgroup by
selecting the required languages. Use select allor clear allto select or
clear all of the languages available.

If the ASP.NET support is disabled on the domain for which you are creating
subdomain, it is also unavailable on Subdomain on subfolddn case the ASP.NET
support is enabled on the domain, the ASP.NET is available for subdomain created
on a subfolder.

11 To allow you to view the information on the number of people visited
the site and the pages of the site they viewed, select a module in Web
statisticsdrop-down menu and select the accessible via password protected
directory /plesistat/webstatheck box, if required. This will install the
selected statistical software module, which will generate reports and
place them into the password protected directory. The subdomain
administrator will then be able to access Web statistics at the URL:
https://subdomain.domain.com/plesk-stat/webstat using their FTP
account login and password.

Note: If subdomain administrator changes the FTP credentials, web statistics
access credentials do not change. The original login and password specified upon
the subdomain creation should always be used for accessing password-protected
Web statistics directory.

12 Select the Additional write/modify permissiooption if this subdomain's
Web applications will use a file-based database (like Jet) located in
the root of httpdocs or httpsdocs folders. Please note that
selecting this option might seriously compromise the web site
security.

13 To complete the setup, click OK It may take up to 48 hours for the
information on new subdomain to spread in the Domain Name System
and become available to the Internet users.

To publish Web content to the subdomainbés Web
presented in the Creating and Publishing a Site (see page 47) section.
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Remoing Subdomains

To remove a subdomain with its Web content:
Go to Domains> domain name Subdomains

2 Select a check box corresponding to the subdomain name that you
wish to remove, and click Remove

3 Confirm removal and click OK The subdomain configuration and its
Web content will be removed from the server.

Setting Up Additional Domain Names for a
Site (Domain Aliases)

If you have registered with a domain name registrar several domain names that you
would like to point to the same Web site that you host on this server, you should set up
domain aliases.

If you need to serve several domain names that point to a Web site hosted on another
server, you should set up domain forwarding: see the section Serving Domain Names
for Sites Hosted on Other Servers (Domain Forwarding) (on page 126) for instructions.

In this section:

Setting Up a DOmMain AlI@S........cuuuuiiiiiii e e e 103
Modifying Properties of @ Domain AlIaS...........coovviviiiiiiiiiie 104
Removing @ DOmMain AlIaS .........ccooiiiiiiiiiiiiiiii e 104
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Setting Up a Domain Alias
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To set up a domain alias:

Go to Domains> domain name Domain Aliases

Click Add Domain Alias

Type the desired domain alias name, for example alias.com.

Domain aliases can comprise letters, digits and hyphens. Each part of the domain
alias between dots should not be longer than 63 symbols.

Select the Synchronize DNS zone with the primary dooteok box if you
want the domain alias to use the same DNS zone resource records as
in primary domain. With this setting, any subsequent changes in
resource records of the primary domain's zone will be applied to the
DNS zone of this domain alias.

Select the Mailcheck box, if you want e-mail directed at the e-mail
addresses under the domain alias to be redirected to the e-mail
addresses under your original domain name.

Example: You have an e-mail address mail@yourdomain.com. You have set up an
alias for your domain name, for example, alias.com. If you want to receive mail to
your mailbox mail@yourdomain.com when it is sent to mail@alias.com, select the
Mailcheck box.

Select the Webcheck box. Otherwise, the web server will not serve the
web content to users coming to your site by typing the domain alias in
their browsers.

If you use hosting services based on a Linux platform, and you have
Java applications installed on your site that you want to make
accessible through the domain alias, select the Java Web applications
check box.

Click OK
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Modifying Properties of a Domain Alias

U To change the properties of an alias:

1 Go to Domains> domain name Domain Aliases

2 Click the alias name you need.

3 Click Preferencesn the Toolsgroup.

4 Modify the domain alias properties as required and click OK
U To modify resource records in the DNS zone of a domain alias:

1 Go to Domains> domain name Domain Aliases

2 Click the alias name you need.

3 Click DNS Seittigs.

4 Add, edit or remove the resource records as required:

A To add a resource record to the zone, click Add New Recor&pecify the required
values and click OKto write the values to the zone.

A To modify a resource record, under the Hostcolumn, click a hyperlink
corresponding to the record you need.

A To remove a record, select a check box corresponding to the record you wish to
remove and click Remove

Removing a Domain Alias

To remove an alias from a domain:
Go to Domains> domain name Domain Aliases

2 Select a check box corresponding to the domain alias that you want to
remove.

3 Click Remove
4 Confirm removal and click OK
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Using Virtual Directories

A virtual directory in Parallels Plesk Panel is a link to existing physical directory that is
present on the server's hard disk. Virtual directories can have a number of specific
settings like custom ASP.NET configuration, access permissions, URL password
protection, and so on.

Since any virtual directory can have its own settings, including customized ASP.NET
configuration, virtual directories are very useful in setting up your web applications,
especially those written in ASP.NET. For example, if you have three web applications
that use ASP.NET version 1.1, and you need to install one web application that uses
ASP.NET version 2.0, you can create a virtual directory for the ASP.NET 2.0
application, configure ASP.NET settings for this directory, enabling version 2.0 only for
this directory, and successfully install the required application.

Virtual directories can also be used as aliases. For example, you have a web
application installed on your domain ‘example.com' in the physical folder
''my_data/web_apps/forum ". To access this web application, users need to type
‘example.com/my_data/web_apps/forum ', which is hard to remember and too
long to type. You can create virtual directory 'forum ' in the root of your virtual host, and
link this virtual directory to '/my_data/web_apps/forum ', SO users who want to
access the web application have to type 'example.com/forum ', which is much
shorter and easier to remember.

To open a virtual directory in your browser, click the required domain name on your

Home page, click Web Directoriesand click the icon #- corresponding to the directory
you wish to open.

In this section:

Creating Virtual DIr€CIOIIES. ......uuiiiei i e e e e e aeanes 106
Changing Virtual DireCtory SettingS ........ooeeuuuuuiirieeeeieeeiiee e e e 108
Adding and Removing MIME TYPES .....coooviiiieeeeeeeeeeeeeeeee e 110
Setting PHP Version for Virtual DIr€CtOres.........cvvivviiiiiceeie e 112

Removing Virtual DIr€CLOMNES ......cuuueiiie e e e e e eeeees 112
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Creating Virtual Diretctes

To create a new virtual directory on a domain:
On your home page, click the domain name you need.

2 Click Web Directories the Hostinggroup. You are in your web site root
now.

3 Navigate to the directory in which you want to create a new virtual
directory.

4 Click Create Virtual Directory

Note: To create a physical directory instead of virtual directory, click Create Directoyy
specify the name of the directory and click OK

5 Specify the required parameters:
A Name- specify the virtual directory name.
A Pah - specify the virtual directory path:

A Select the Create physical directory with the same name as virtual dicketoky
box to automatically create a physical directory with the same name as the
virtual directory you are creating.

A Clear the Create phyisal directory with the same name as virtual direchegk
box and specify the path in the field to select the physical directory that
already exists.

A Script source accessselect this check box to allow users to access source code
if either Read or Write permissions are set. Source code includes scripts in ASP
applications.

A Read permissionselect this check box to allow users to read files or directories
and their associated properties.

A Write permissionselect this check box to allow users to upload files and their
associated properties to the virtual directory or to change content in a write-
enabled file. Write access is allowed only if browser supports the PUT feature of
the HTTP 1.1 protocol.

A Directory browsingselect this check box to allow users to see a hypertext listing
of the files and subdirectories in the virtual directory.

A Log visits- select this check box if you want to store the information about visits
of the virtual directory.

A Create applicationselect this check box to make the web directory an 1IS
Application. The directory becomes logically independent from the rest of the
web-site.

A Execute permissionsselect the appropriate program execution level allowed for
the virtual directory.

A None- allow access only to static files such as HTML or image files.
A Scripts only allow running scripts only, not executables.

A Scripts and Executablesemove all restrictions so that all file types can be
executed.
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A ASP Settings set specific settings for ASP-based web applications.

A If you are using ASP-based applications that cannot operate correctly under
data transfer restrictions currently set by 1S, clear the Defined by parent
directorycheck box corresponding to the field you want to change and type in
the required number.

A If you want to enable debugging of ASP applications on the server side,
clear the corresponding Defined by parent directarfyeck box and select the
Enable ASP servside script debuggingheck box.

A If you want to enable debugging of ASP applications on the client side, clear
the corresponding Defined by parent directafyeck box and select the Enable
ASP clienside script debuggingheck box.

Note that if you are trying to change ASP Settings for the root web directory, the
default check box names will be Defined byiSinstead of Defined by parent
directory

Click OKto complete the creation.

To set access permissions for a virtual directory:
Click the required domain name on your Home page.
Click Web Directories

Click the icon & corresponding to the directory you wish to open, and
set the access permissions for this directory and all its files.

Refer to the Setting File and Folder Access Permissions section for more
information on setting access permissions.

To configure ASP.NET for a virtual directory:

Click the required domain name on your Home page,
Click Web Directories

Browse to the required directory and enter it.

Click ASP.NET Settingsd set the options accordingly.

Refer to Configuring ASP.NET for Virtual Directories section for more information
on configuring ASP.NET
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Changing Virtual Directory Settings

To change preferences of an existing virtual directory on a domain:
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On your home page, click the domain name you need.
Click Web Directories the Hostinggroup.

Find the directory which preferences you wish to change, and click ©*,
or click DirectoryAccess Permissions the required directory.

Change the preferences of the virtual directory:

A
A

A

Name- specify virtual directory name.

Path- specify the path to the physical directory which virtual directory is linked
to.

Script source accessselect this checkbox to allow users to access source code if
either Read or Write permissions are set. Source code includes scripts in ASP
applications.

Read permissionselect this checkbox to allow users to read files or directories
and their associated properties.

Write permissionselect this checkbox to allow users to upload files and their
associated properties to the virtual directory or to change content in a write-
enabled file. Write access is allowed only if browser supports the PUT feature of
the HTTP 1.1 protocol.

Directory browsingselect this checkbox to allow users to see a hypertext listing
of the files and subdirectories in the virtual directory.

Log visits- select this checkbox if you want to store the information about visits
of the virtual directory.

Create applicationselect this checkbox to make the web directory an IIS
Application. The directory becomes logically independent from the rest of the
web-site.

Execute permissionsselect the appropriate program execution level allowed for
the virtual directory.

None- allow access only to static files such as HTML or image files.
Scripts only allow running scripts only, not executables.

Scripts and Executablesemove all restrictions so that all file types can be
executed.

Allow to use parent pathselect this checkbox to allow using double period in the
pathname when referring to a folder above the current web directory. This
makes users able to move up the folder tree without knowing the folder name or
the whereabouts in the hierarchy. If the option is selected, parent path
directories should not have the Execute permigsn checkbox selected in their
preferences, so that applications do not have the ability of unauthorized running
of programs in the parent paths.
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Allow application execution in MTA (rtluifdaded apartment) modselect this
checkbox to allow the application execution in multi-threaded apartment (MTA)
mode. Otherwise the application will run in a single-threaded apartment (STA)
mode. Using STA, each application pool is executed in a dedicated process.
With MTA, several concurrent application pools are executed in one thread
which can increase performance in some cases.

Use default documentselect this checkbox to allow the use of default
documents for the current web directory. The default document is sent when
users access the directory on the Web without a specific file name (for example,
using 'http://'www.parallels.com' as opposed to
‘http://www.parallels.com/index.html"). If this checkbox is cleared and the
Directory browsingheckbox is selected, the Web server returns a folder listing. If
this checkbox is cleared and the Directory browsingheckbox is cleared as well,
the Web server returns an "Access Forbidden" error message.

Default documents search ordepecifies the order in which IS searches for the
default document, sending user the first available file it finds. If no match is
found, IIS behaves as in the cases when the default content page is disabled.

Allow anonymous accesselect this checkbox if you want to make the directory
public so that web users could access it without authentication.

Require SSE select this checkbox to enable SSL-only access to the folder.
ASP Settings set specific settings for ASP-based web applications.

A If you are using ASP-based applications that cannot operate correctly under
data transfer restrictions currently set by 11S, deselect the Defined by parent
directorycheck box corresponding to the field you want to change and type in
the required number.

A If you want to enable debugging of ASP applications on the server side,
deselect the corresponding Definel by parent directorgheck box and select
the Enable ASP servside script debuggingheck box.

A If you want to enable debugging of ASP applications on the client side,
deselect the corresponding Defined by parent directarfieck box and select
the Enabé ASP clierside script debuggingheck box.

Note that if you are trying to change ASP Settings for the root web directory,
the default check box names will be Defined by Ilistead of Defined by parent
directory

Click OKto save changes.

To change aess permissions for a virtual directory:
Click the required domain name on your Home page.
Click Web Directories

Click the icon & corresponding to the directory you wish to open, and
change the access permissions for this directory and all its files.

Refer to the Setting File and Folder Access Permissions section for more
information on setting access permissions.
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To reconfigure ASP.NET for a virtual directory:

Click the required domain name on your Home page,
Click Web Directories

Browse to the required directory and enter it.

Click ASP.NET Settingsnd change the options accordingly.

Refer to the Configuring ASP.NET for Virtual Directories section for more
information on configuring ASP.NET
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Adding and Removing MIME Types

Multipurpose Internet Mail Exchange (MIME) types instruct a Web browser or mail
application how to handle files received from a server. For example, when a Web
browser requests an item on a server, it also requests the MIME type of the object.
Some MIME types, like graphics, can be displayed inside the browser. Others, such as
word processing documents, require an external helper application to be displayed.

When a web server delivers a Web page to a client Web browser, it also sends the
MIME type of the data it is sending. If there is an attached or embedded file in a
specific format, 1IS also tells the client application the MIME type of the embedded or
attached file. The client application then knows how to process or display the data
being received from IIS.

IIS can only operate files of registered MIME types. These types could be defined both
on the global IIS level and on the domain or virtual directory level. Globally defined
MIME types are inherited by all the domains and virtual directories while ones defined
on the domain or virtual directory level are used only for the area where they are
defined. Otherwise, if the web server receives request for a file with unregistered MIME
type, it returns the 404.3 (Not Found) error.

In this section:

AdAING MIME TYPES ..o 111
Changing MIME TYPES ... i e e e e et e e e e e e e eeaees 111
REMOVING MIME TYPES ..t e e e e e e et e e e e e e e aeeeees 112
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Adding MIME Types
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To add a new MIME type for a virtual directory on a domain:
On your Home page, click the domain name you need.
Click Web Directories the Hostinggroup.

Navigate to the required virtual directory and enter it.
Select the MIME Typetab.

Click Add MIME e

A Type the filename extension in the Extensiorfield. Filename extention should
begin with a dot (.), or a wildcard (*) to serve all files regardless of filename
extension.

A Specify the file content type in the Contentffield.

A You can either select the appropriate value from the list or define a new content
type. To do this, select Custom..and enter the content type in the input box
provided.

Click OKto finish the creation.

Changing MIME Types
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To edit an existing MIME type for a virtual directorgaemain:
On your Home page, click the domain name you need.
Click Web Directories the Hostinggroup.

Navigate to the required virtual directory and enter it.
Select the MIME Typetab.

Select the required MIME type in the list.

A Type the filename extension in the Extensiorfield. Filename extention should
begin with a dot (.), or a wildcard (*) to serve all files regardless of filename
extension.

A Specify the file content type in the Contenffield.

A You can either select the appropriate value from the list or define a new content
type. To do this, select Custom..and enter the content type in the input box
provided.

Click OKto save changes.
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Removing MIME Types

To remove a MIME type for a virtual directory on a domain:
On your Home page, click the domain name you need.
Click Web Directories the Hostinggroup.

Navigate to the required virtual directory and enter it.
Select the MIME Typetab.

Select the check box corresponding to the MIME type you wish to
remove.

Click Remove
Confirm removal and click OK
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Setting PHP Version for Virtual Directories

In addition to be able to choose the PHP version you would like to use on each of your
domains, you also have the additional ability to specify the PHP version for any given
virtual directory on your domains, allowing you to use web applications that require
PHP4 as well as PHPS5.

To set PHP version for a virtual directory:
On your Home page, click the domain name you need.
Click Web Directories the Hostinggroup.

Click PHP Settings
Choose the required version of PHP and click OK
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Removing Virtual Directories

To remove an existing virtual directory:
On your home page, click the domain name you need.
Click Web Directories the Hostinggroup.

Select the check box corresponding to the directory you wish to
remove.

Click Remove
Confirm the removal and click OK

w N -
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Hosting Personal Web Pages on Your
Web Server

You can host on your Web server personal Web pages for individuals who do not need
their own domain names. This service is popular with educational institutions that host
non-commercial personal pages of their students and staff.

These pages usually have Web addresses like http://your-domain.com/~username.

U To accommodate a personal Web page on ymer sallocate a separate Web space
and set up an FTP account for publishing:

1 Go to Domains> domain name Web Users
2 Click Preferences

3 If you wish to allow execution of scripts embedded in personal web
pages, select the Allow the web users scripticheck box.

4 Click OK

The settings you have defined at the step 4 are common for all personal Web
pages you might host on your Web server. Therefore, you will not need to perform
steps 3 to 6 next time you set up a Web space for a personal Web page.

5 Click AddNew Web User

6 Specify a user name and password that will be used for accessing the
web space through FTP and publishing the Web page.
You can use only lower-case alphanumeric, hyphen and underscore symbols in
user name. The user name should begin with an alphabet character. It cannot

contain white spaces. The password cannot contain quotation marks, white space,
user's login name, and should be between 5 and 14 characters in length.

7 If you wish to limit the amount of disk space that can be occupied by
the Web page content, type the desired value in megabytes into the
Hard disk quotaox.

When the specified limit is exceeded, the Web page owner will not be able to add
files to his or her Web space.

8 Specify the programming languages that should be supported for the
Web page.

For example, if the web page is written in PHP, select the PHP supportheck box.

9 Select the Additional write/modify permissiooption if this personal web
page's Web applications will use a file-based database (like Jet)
located in the root of httpdocs or httpsdocs folders. Please note
that selecting this option might seriously compromise the web site
security.

10 Click OK

Now you can tell your user the FTP account credentials, so that he or she can publish
their Web page.
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In this sectin:
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Changing FTP Password for a Web Page Owner

To change FTP password for a web page owner:
Go to Domains> domain name Web Users
Click the user name you need.

Type the new password into the New passwordnd Confirm password
boxes.

4 Click OK
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Allocating More Disk Space to the Web Page Owner

To allocate more disk space to the web page owner:
Go to Domains> domain name Web Users
Click the user name you need.

Type the amount of disk space in megabytes into the Hard disk quat
box.

4 Click OK
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Removing Web Page Owner's Account

O To remove a Web page ownerdés account tog
1 Go to Domains> domain name Web Users

2 Select a check box corresponding to the user account you want to
remove and click Remove

3 Confirm removal and click OK
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Setting Up Anonymous FTP Access to the
Server

If you host a site on a dedicated IP address, you can set up a directory within the site,
where other users will be able to anonymously download or upload files through FTP.
Once anonymous FTP is enabled, the users will be able to log in to the ftp://ftp.your-
domain.com with the "anonymous" login name and any password.

U To allow anonymous FTP access:

1 Go to Domains> domain name Anonymous FTP

2 To activate anonymous FTP service, click Switch On

3 To set up a welcoming message to be displayed when users log in to
FTP site, select the Display login messagtheck box and type the
message text in the input field as desired.

Note that not all FTP clients display welcoming messages.

4 To allow visitors to upload files to the /incoming directory, select
the Allow uploading to incoming directatyeck box.

5 To allow users to create subdirectories in the /incoming directory,
select the Allow creation of dirgaries in the incoming directotheck box.

6 To allow downloading files from the /incoming directory, select the
Allow downloading from the incoming directdrgck box.

7 To limit the amount of disk space that can be occupied by uploaded
files, clear the Unimitedcheck box corresponding to the Limit disk space in
the incoming directorgption, and specify the amount in kilobytes.

This is the hard quota: the users will not be able to add more files to the directory
when the limit is reached.

8 To limit the number of simultaneous connections to the anonymous
FTP server, clear the Unlimitedcheck box corresponding to the Limit
number of simultaneous connectia®ion and specify the number of
allowed connections.

9 To limit the bandwidth for anonymous FTP connections, clear the
Unlimitedcheck box corresponding to the Limit download bandwidth for this
virtual FTP domaioption and enter the maximum bandwidth in kilobytes
per second.

10 Click OK

U To modify settings for anonymous FTP server or to switch it off:

1 Go to Domains> domain name Anonymous FT.P

2 Adjust the settings as required and click OK To switch off the

anonymous FTP service, click Switch Off
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Customizing Web Server Error Messages
(Linux Hosting)

When visitors coming to your site request pages that the Web server cannot find, the
Web server generates and displays a standard HTML page with an error message. The
standard error messages may inform of problems, but they do not usually say how to
resolve them or how to get the lost visitor on his way, and they also look dull.

You may want to create your own error pages and use them on your Web server. With
Parallels Plesk Panel you can customize the following error messages:

A

A

400 Bad File Requebisually means the syntax used in the URL is incorrect (for
example, uppercase letter should be lowercase letter; wrong punctuation marks).

401 Unauthorize8erver is looking for some encryption key from the client and is not
getting it. Also, wrong password may have been entered.

403 Forbidden/Access deni8dnilar to 401; a special permission is needed to access
the site - a password and/or username if it is a registration issue.

404 Not Foun&erver cannot find the requested file. File has either been moved or
deleted, or the wrong URL or document name was entered. This is the most
commaon error.

405 Method Not Allowéthe method specified in the Request-Line is not allowed for
the resource identified by the Request-URI.

406 Not Acceptabl€he resource identified by the request is only capable of
generating response entities which have content characteristics not acceptable
according to the accept headers sent in the request.

407 Proxy Authentication RequirBds code is similar to 401 (Unauthorized), but
indicates that the client must first authenticate itself with the proxy.

412 Precondition Failethe precondition given in one or more of the request-header
fields evaluated to false when it was tested on the server. This response code
allows the client to place preconditions on the current resource metainformation
(header field data) and thus prevent the requested method from being applied to a
resource other than the one intended.

414 RequesiiRI Too Long@:-he server is refusing to service the request because the
Request-URI is longer than the server is willing to interpret. This rare condition is
only likely to occur when a client has improperly converted a POST request to a
GET request with long query information, when the client has descended into a URI
"black hole" of redirection (e.g., a redirected URI prefix that points to a suffix of
itself), or when the server is under attack by a client attempting to exploit security
holes present in some servers using fixed-length buffers for reading or manipulating
the Request-URI.

415 Unsupported Media Typee server is refusing to service the request because
the entity of the request is in a format not supported by the requested resource for
the requested method.

500 Internal Server Err@ould not retrieve the HTML document because of server-
configuration problems.
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A

501 Not Implementethe server does not support the functionality required to fulfill
the request. This is the appropriate response when the server does not recognize
the request method and is not capable of supporting it for any resource.

502 Bad Gateny.The server, while acting as a gateway or proxy, received an invalid
response from the upstream server it accessed in attempting to fulfill the request.

To configure Parallels Plesk Panel

Switch on support for custom error documents through Parallels Plesk
Panel: Go to Domains> domain name Web Hosting SettingSelect the
Custom error documentheck box and click OK

Connect to your FTP account on the Parallels Plesk Panel server, and
go to the error_do cs directory.

Edit or replace the respective files. Be sure to preserve the correct file
names:

400 Bad File Request - bad_request.html

401 Unauthorized - unauthorized.htm|

403 Forbidden/Access denied - forbidden.html

404 Not Found - not_found.html

405 Method Not Allowed - method_not_allowed.html
406 Not Acceptable - not_acceptable.html

> > > > > > P

407 Proxy Authentication Required -
proxy_authentication_required.html

412 Precondition Failed - precondition_failed.html
414 Request-URI Too Long - request - uri_too_long.htm I
415 Unsupported Media Type - unsupported_media_type.html

500 Internal Server Error - internal_server_error.html

> > > > >

501 Not Implemented - not_implemented.html
A 502 Bad Gateway - bad_gateway.html

Wait for a few hours till your Web server is restarted. After that, the
Web server will start using your error documents.

We
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Customizing Web Server Error Messages
(Windows Hosting)

When visitors coming to a site request pages that the Web server cannot find, the Web
server generates and displays a standard HTML page with an error message. The
standard error messages may inform of problems, but they do not usually say how to
resolve them or how to get the lost visitor on his way, and they also look dull.

You may want to create your own error pages and use them on your Web server. The
following error messages are the ones customized most often:

A 400 Bad File Request. Usually means the syntax used in the URL is incorrect (e.g.,
uppercase letter should be lowercase letter; wrong punctuation marks).

A 401 Unauthorized. Server is looking for some encryption key from the client and is
not getting it. Also, wrong password may have been entered.

A 403 Forbidden/Access denied. Similar to 401; a special permission is needed to
access the site i a password and/or username if it is a registration issue.

A 404 Not Found. Server cannot find the requested file. File has either been moved or

deleted, or the wrong URL or document name was entered. This is the most
common error.

A 500 Internal Server Error. Could not retrieve the HTML document because of
server-configuration problems.

0 To configure Parallels Plesk Panel 6s Web
domain:

1 Switch on support for custom error documents through Parallels Plesk
Panel.

1. Go to Domains> domain name Web Hosting Settings
2. Select the Custom error documentheck box.
3. Click OK

2 Go to Domains> domain name Virtual Directorieto see the list of error
documents for the root Web directory (error documents located here
are used for all domain Web pages). If you want to customize error
pages for a certain Web directory, go to that directory.

3 Click Error Documentsab and click the required error document in the
list.

A To use the default document provided by IS for this error page, select Defaultin
the Typemenu.

A To use a custom HTML document already located in the error_docs  directory
on a domain, select Filein the Typemenu and specify the file name in the
Locationfield.
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A To use a custom HTML document located in directory other than error_docs
on a domain, select URLin the Type menu and enter the path to your document
in the Locationfield. The path should be relative to the virtual host root (that is,
<vhosts> \ <domain> \ httpdocs ).

For example, you have created a file forbidden_403_1.html and saved it in
the my_errors directory located in the httpdocs . To use this file as an error
document, the following path should be entered in the Locatiorfiled:
/my_errors/forbidden_403_1.html

Note. You can use both FTP and File Manager to upload your custom error
document to the server. By default, all error documents are stored in the
Ivhosts/your - domain.com/error_docs/ directory (located in C:\ InetPub
by default).

4 Once the Web server is restarted, it will start using your error
documents.

Customizing DNS Zone Configuration for
Domains

For each new domain name, your control panel automatically creates DNS zone in
accordance with the configuration preset defined by your provider. The domain names
should work fine with the automatic configuration, however if you need to perform
custom modifications in the domain name zone, you can do that through your control
panel.

Note: Here you can update the DNS zone with multiple changes in DNS records at
once, and then confirm the changes by clicking the Applybutton. Unconfirmed changes
will not be saved.

U To view the resource records in a DNS zone of a domain:

Go to Domains ®omain name DNS Settings the Web Siteggroup). A screen will show alll
resource records for this domain.

To learn about modifying resource records in the DNS zone of a domain alias, refer to

the Setting Up Additional Domain Names for a Site (Domain Aliases) (see page 102)
section.

In this section:

Adding RESOUICE RECOIS. ... .coiieiiiieeiiie e 120
Modifying RESOUICE RECOIS .........uuiiiiiieiiieeiiee e 121
Removing RESOUICE RECOIUS........uuuiiiiei e e e e e e e e enaees 122

Restoring the Original Zone Configuration...............ccooeiiiiiii i 123
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Adding Resource Records

To add a newesource record to the zone:
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Go to Domains xlomain name DNS Setting@n the Web Sitegroup).
Click Add New Record
Select a resource record type, and specify the appropriate data:

A

For an A record you will need to enter the domain name for which you wish to
create an A record. If you are simply defining an A record for your main domain,
then you should leave the available field empty. If you are defining an A record
for a name server then you will need to input the appropriate entry for the given
name server (ie. nsl). Then, you need to enter the appropriate IP address to
which to associate the domain name.

For a NS record, you will need to enter the domain hame for which you wish to
create the NS record. If you are defining an NS record for your main domain,
then you will leave the available field blank. Then enter the appropriate name
server name in the field provided. You will need to enter the complete name (i.e.
nsl.mynameserver.com).

For a MX record, you will need to enter the domain for which you are creating
the MX record. For the main domain, you would simply leave the available field
blank. You will then need to enter your mail exchanger, this is the name of the
mail server. If you are running a remote mail server named
'mail.myhostname.com' then you would simply enter 'mail.myhostname.com'
into the field provided. You will then need to set the priority for the mail
exchanger. Select the priority using the drop-down box: 0 is the highest and 50
is the lowest. Keep in mind you would also need to add the appropriate A
record, and/or CNAME if applicable for the remote mail exchange server.

For a CNAME record, you will need to first enter the alias domain name for
which you wish to create the CNAME record. You then need to enter the domain
name within which you want the alias to reside. Any domain name can be
entered. It does not need to reside on the same server.

For a PTR record you will first enter the IP address/mask for which you wish to
define the pointer. Then enter the appropriate domain name for this IP to be
translated to.

For a TXT record, you will be able to enter an arbitrary text string, which could
be a description or an SPF record.

For a SRV record, you will need to enter the service hame, protocol name, port
number, and target host. Service and protocol names should start with the
underline symbol. You can also specify the priority of service and weight of
service in the appropriate fields.

4 Click OKto submit the data.

Note: When you are finished with modifying DNS records of the DNS zone, confirm the
changes by clicking the Applybutton on the DNS zone screen (DNS Settings
Unconfirmed changes will not be saved.
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Modifying Resource Records

To modify the properties of a resource record:
Go to Domains xlomain name DNS Setting@n the Web Sitegroup).

2 Click the hyperlink in the Hostcolumn corresponding to the resource
record you want to modify.

3 Modify the record as required and click OK

To modify the entries in the Start of Authority (SOA) record for a domain:
Go to Domains domain nene> DNS Setting@n the Web Sitggroup).
Click SOA Record

Specify the desired values:

A TTL This is the amount of time that other DNS servers should store the record in
a cache. Parallels Plesk Panel sets the default value of one day.
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A RefreshThis is how often the secondary name servers check with the primary
name server to see if any changes have been made to the domain's zone file.
Parallels Plesk Panel sets the default value of three hours.

A Retry This is the time a secondary server waits before retrying a failed zone
transfer. This time is typically less than the refresh interval. Parallels Plesk
Panel sets the default value of one hour.

A Expire This is the time before a secondary server stops responding to queries,
after a lapsed refresh interval where the zone was not refreshed or updated.
Parallels Plesk Panel sets the default value of one week.

A MinimumThis is the time a secondary server should cache a negative response.
Parallels Plesk Panel sets the default value of three hours.

4 Click OK

Usage of serial number format recommended by IETF and RIPE is mandatory for many
domains registered in some high-level DNS zones, mostly European ones. If your
domain is registered in one of these zones and your registrar refuses your SOA serial
number, using serial number format recommended by IETF and RIPE should resolve
this issue.

Parallels Plesk Panel servers use UNIX timestamp syntax for configuring DNS zones.
UNIX timestamp is the number of seconds since January 1, 1970 (Unix Epoch). The
32-bit timestamp will overflow by July 8, 2038.

RIPE recommends using YYYYMMDDNN format, where YYYY is year (four digits), MM
is month (two digits), DD is day of month (two digits) and NN is version per day (two
digits). The YYYYMMDDNN format won't overflow until the year 4294.
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To change the Start of Authority (SOA) serial number format to YYYYMMDDNN for a
domain:

Go to Domains xlomain name DNS Setting@n the Web Sitegroup).
Click SOA Record
Select the Use serial number format recommended by IETF andiié¥box.

Note: See the sample of SOA serial number generated with the selected format. If
the resulting number is less, than the current zone number, the modification may
cause temporary malfunction of DNS for this domain. Zone updates may be
invisible to Internet users for some time.

Click OK

Removing Resource Records
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To remove a resource record from the zone:

Go to Domains xlomain name DNS Setting@n the Web Sitegroup).
Select a check box corresponding to the record you wish to remove.
Click Remove

Confirm removal and click OK

Note: When you are finished with modifying DNS records of the DNS zone, confirm the
changes by clicking the Applybutton on the DNS zone screen (DNS Settings
Unconfirmed changes will not be saved.




Hosting Web Sites 123

Restoring the Original Zone @guration

i

To restore the original zone configuration in accordance with the configuration preset
defined by your provider:

Go to Domains xlomain name DNS Setting@n the Web Sitegroup).

In the IP addresslrop-down box, select the IP address to be used for
restoring the zone, specify whether a www alias is required for the
domain, and click the Defaultbutton. The zone configuration will be
recreated.

To restore the default Start of Authority (SOA) serial number format (UNIX timestamp)
for a domain:

Go to Domains domain name DNS Setting@n the Web Sitggroup).
Click SOA Record
Clear the Use serial number format recommended by IETF andiRIEEbox.

Note: See the sample of SOA serial number generated with the selected format. If
the resulting number is less, than the current zone number, the modification may
cause temporary malfunction of DNS for this domain. Zone updates may be
invisible to Internet users for some time.

Click OK
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Serving Sites with External Domain Name
Servers

If you host Web sites on this server and have a standalone DNS server acting as a
primary (master) name server for your sites, you may want to set up your control
panel's DNS server to function as a secondary (slave) name server.

To make the control panel's DNS semteasaa secondary hame server:
Go to Domains xlomain name DNS Setting@n the Web Sitegroup).
Click Switch DNS Service Mode

Specify the IP address of the primary (master) DNS server.

Click Add

Repeat steps from 1 to 5 for each Web site that needs to have a
secondary name server on this machine.
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To make the control panel 6s DNS server a
Go to Domains xlomain name DNS Setting@n the Web Sitegroup).

2 Click Switch DNS Service Modde original resource records for the zone
will be restored.

If you host Web sites on this server and rely entirely on other machines to perform the

Domain Name Service for your sites (there are two external name servers - a primary

and a secondary), switch of f eachsteseroedbyr ol pane
external name servers.

O To switch off the control panel 6s DNS se
server:

1 Go to Domains xlomain name DNS Setting@n the Web Sitggroup).

2 Click Switch Off the DNS Servioethe Toolsgroup. Turning the DNS
service off for the zone will refresh the screen, so that only a list of
name servers remains.

Note: The listed name server records have no effect on the system. They are only
presented on the screen as clickable links to give you a chance to validate the
configuration of the zone maintained on the external authoritative name servers.

3 Repeat the steps from 1 to 3 to switch off the local domain name
service for each site served by external name servers.

U If you wish to validate the configtion of a zone maintained on authoritative name
servers:

1 Go to Domains xlomain name DNS Setting@n the Web Sitggroup).



Hosting Web Sites 125

2 Add to the list the entries pointing to the appropriate name servers
that are authoritative for the zone: click Add specify a name server,
and click OK Repeat this for each name server you would like to test.

The records will appear in the list.

3 Click the records that you have just created. Parallels Plesk Panel will
retrieve the zone file from a remote name server and check the
resource records to make sure that
resolved.

The results will be interpreted and displayed on the screen.

Changing Web Hosting Type from
Physical to Forwarding

If you hosted a site on the server with virtual (or physical) hosting account, and now
you need only domain forwarding service for that site because it has been moved to
another server, you should reconfigure the hosting account.

Before changing hosting configuration for a site that was previously on a physical
hosting account, make sure that the site owner has a local copy of his or her site
because all files and directories related to a site are removed from the server when
hosting type is changed.

To reconfigure a hosting account:

Go to Domains xlomain name Web 8e group title menu > Change
Hosting Type

2 Select the Forwardingoption, and then select the type of forwarding:
Frame forwardingr Standard forwarding
With standard forwarding, a user is redirected to the site and the actual site's URL
is shown in the user's browser, so the user always knows that he or she is
redirected to another URL. With frame forwarding, a user is redirected to the site

without knowing that the site actually resides at another location, therefore, Frame
forwardingshould be preferred.

3 Specify the destination URL: the current Web site address that you
would like this domain to point to.

4 Click OK

d o ma
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Serving Domain Names for Sites Hosted
on Other Servers (Domain Forwarding)

U If you need to serve a domain name or several domain nanpesnthi@® a Web site
hosted on another server:

1 Go to Domains> Create Domain
2 Specify the domain name.

Leave the wwwcheck box selected if you wish to allow users to access the site by a
common and habitual URL like www.your-domain.com. Having the www alias
preceding the domain name will allow users to get to the site no matter what they
type in their browsers: www.your-domain.com and your-domain.com will both point
to the site.

3 If you have a number of IP addresses to choose from, select the
required address from the Assign IP addressienu.

Notice that e-commerce sites need a dedicated IP address (not shared among
other sites) to implement Secure Sockets Layer data encryption.

4 Leave the Create domain without templafgtion selected in the Use domain
template settingsenu.

5 Select the Mailand DNScheck boxes.
6 Under Hosting Typeselect the Forwardingoption.

7 Specify the destination URL: the current Web site address that you
would like this domain to point to.

8 Select the type of forwarding: Frame forwardingr Standard forwarding

With standard forwarding, a user is redirected to the site and the actual site's URL
is shown in the user's browser, so the user always knows that he or she is
redirected to another URL. With frame forwarding, a user is redirected to the site
without knowing that the site actually resides at another location, therefore, Frame
forwardingshould be preferred.

9 Specify the destination URL: the current Web site address that you
would like this domain to point to.

10 Click OK
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Upgrading Web Site Hosting Accounts

U To modify settings for a Web site:
Go to Domains> domain name.

2 To allocate more disk space, bandwidth and other resources, click
Resource Usage.

3 To add hosting features, such as support for programming languages
and scripts, click Web Hosting Settings

4 To renew (prolong) an expired Web site hosting account, click
Resource Usagespecify another term in the Validity periodox, and click
OK.Then click Unsuspend

In this section:

Introducing Similar Changes to Numerous Web Hosting Accounts.................... 128
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Introducing Similar Changes to Numerous Web Hosting
Accounts

To change hosting options for a number sfihg accounts at once:
Click the Domainsshortcut in the navigation pane.

2 Select the check boxes corresponding to the domain names you wish
to perform group operations on.

3 Click [ Modify
4 In the Statussection, you can suspend or unsuspend the domains. To

suspend or unsuspend the domains, select an option button to Switch
on, Switch off or Do not changéo leave it as is.

5 In the Limitssection, you can see the list of all domain-specific limits.
To change a certain limit, select an appropriate menu on the left side
of the list. Adjust the settings as required:

A Select Unlimitedo remove the corresponding limit.

A Select Valueand type the numeric value to set the corresponding limit to the
specified value.

A Select Increase (+)elect the type of value (specific units or percentage) and
type the numeric value to increase the corresponding limit by the specified value
(in specific units or percents).

A Select Decreasey);, select the type of value (specific units or percentage) and
type the numeric value to decrease the corresponding limit by the specified
value (in specific units or percents).

A Leave the Do not changealue selected, to leave it as is.

6 In the Hostingsection, you can see the list of hosting parameters. To
change a certain feature availability for the domains, select an
appropriate option button to Switch on Switch off or Do not changéo leave
it as is.

7 In the Preferencesection, you can see the list of domain preferences.
To set a certain preferences setting for the domains, select an
appropriate option button to Switch on Switch off or Do not changéo leave
it as is.

8 In the Servicessection, you can define availability of various domain
services. To do this, select an appropriate option button to Switch on
Switch off or Do not changéo leave it as is.

9 Click OK
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Suspending and Unsuspending Web Sites

U To suspend a domain (Web site):
Go to Domains xlomain name
2 Click Suspend

The domain (Web site) will be suspended, its Web, FTP and mail services will no
longer be accessible to the Internet users, and domain owner will not be able to log
in to the control panel.

To unsuspend a domain (Web site):
Go to Domains xlomain name
2 Click Unsuspend

Removing Web Sites

To remove a domaind€Wsite) with its Web content:
Click Domains.

2 Select a check box corresponding to the domain name you want to
remove.

3 Click Removeconfirm removal and click OK

U To remove a subdomain with its Web content:
Go to Domains > Subdomains

2 Select the check box corresponding to the subdomain you wish to
remove.

3 Click Removeconfirm removal and click OK
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Using Email Services

You can use a number of different e-mail services with a single e-mail account. For
example, you can have an e-mail address that will accept mail as any standard
mailbox, forward to a number of recipients, and send an automatic response to the
original message sender.

U If you are going to serve mailboxes under a specific domain with an exiérnal m
server, follow these steps:

1 Go to Domains xlomain name DNS Setting@n the Web Sitggroup).

2 In the Record typeolumn, locate an MX record, and click the
respective link in the Hostcolumn on the left.

3 In the Enter mail exchangéiox, type the external mail server's host
name, for example, mailserver.example.com

Click OK

Click Up Leveto return to the domain management screen.
Click Mail Accounts

Click Mail Accounts Mail Settings

Clear the Activate mail service on domaimeck box and click OK.
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Creating Mailboxes

U To create a mailbox:
Go to Domains> domain name Create Mail Account

2 The domain name is shown to the right of @ sign, so you only need to
specify the desired name for the mailbox.

Thiscanbe,fore x ampl e, wuser o6s first name and | ast
department name, or any other text in Latin symbols. The nhame should be short

enough to remember. It can comprise alphanumeric, dash dot and underscore

symbols.

3 Specify a password that mailbox owner will use for accessing his or
her mailbox.

4 Specify the settings related to the appearance of user's control panel,
if desired: interface language, theme (skin), the limit on number of
characters that can appear on custom buttons placed into the control
panel by the mailbox owner.

5 Leave the Allow multiple sessionsheck box selected to allow the mailbox
owner to have several simultaneous sessions in the control panel.

6 Leave the Prevent users from working with the control panel until interface screens
are completely loadatheck box selected.

This will forbid users from submitting data or performing operations until the control
panel is ready to accept them.

7 Make sure that a check mark is present in the Mailboxcheck box. If
required, limit the amount of disk space that this mailbox and it's
autoresponder attachment files can use. To do this, under Mailbox quota
select the Enter sizeoption and type the desired value in kilobytes.

Click OK

8 To allow the mailbox owner to log in to control panel for managing his
or her mail account, click Permissionsclick the Select alshortcut and
click OK

Now, the mailbox is created, and a separate e-mail administration panel has been set
up in Parallels Plesk Panel. To enter it, the mailbox owner should visit the URL
https://your-domain.com:8443, type his or her e-mail address into the Loginbox, type
the password for the mailbox into the Passwordox, and then click Login
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Setting Up Your-Bail Program for
Retrieving Mafrom Your Mailbox
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To set up Microsoft Outlook Express:

Open Microsoft Outlook Express.

Go to Tools> Accounts

Click the Mailtab to open a list of your mail accounts.
Click the Add >button and select the Ma i itemé

Enter your name as you want it to appear in any messages you send,
and click Next »

Type your e-mail address that you created through Parallels Plesk
Panel (for example, your.name@your-domain.com), and click Next >

Select the protocol of your incoming mail server.

Specify the mail domain name as the incoming and outgoing mail
server (for example: mail.your-domain.com), and click Next >

Type your e-mail address in the Account namé&ox (for example:
your.name@your-domain.com).

0 Type your password. This should be the password that you specified
during creation of the mailbox through Parallels Plesk Panel.

1 Leave the Remember passwolibx checked, if you do not wish to be
prompted to enter password each time your e-mail program connects
to the mail server to check for new mail, and click Next >

2 To complete setting up your e-mail program, click Finish

To set up Mozilla Thunderbird:

Open Mozilla Thunderbird.

GotoToolss>Account Settingseée

Click Add AccountThe Account Wizard will open.

Leave the Email accountption selected, and click Next >

Enter your name as you want it to appear in any messages you send.

Type your e-mail address that you created through Parallels Plesk
Panel.

For example, your.name@your-domain.com. Click Next >
Select the protocol of your incoming mail server.

Specify the mail domain name as the incoming and outgoing mail
server (for example: mail.your-domain.com), and click Next >
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9 In the Incoming User Name box, specify your full e-mail address (for
example, your.name@your-domain.com), and click Next >

10 Enter the name by which you would like to refer to this account (for
example, Work Account) and click Next >

11 Verify that the information you entered is correct, and click Finish
12 Click OKto close the Account Settings wizard.
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Accessing Your Mail From a Web Browser

You can read your mail and compose new messages even if you are far from your
home or office computer. To do this, you first need to allow access to the webmail
interface that is integrated with your control panel. Then you can work with your mail
from any computer with Internet connection and Web browser installed, or a WAP-

enabled cellular phone or a handheld computer (PDA).

3

To allow access to the Webmail interface:
Go to Domains somain name Mailgroup title menu > Mail Settings

From the Webmaimenu, select the webmail program that you want to
use.

Click OK

Note: Activation and deactivation of webmail for your domain involves modifications in
DNS zone, therefore, there is actually a certain delay present when activating and
deactivating webmail due to the speed of DNS registration mechanisms.

To access your rifbox through webmail:

Open a Web browser (or a WAP browser, if you are using a handheld
device), and type the URL: http://webmail.your-domain.com, where
your-domain.com is the name of your domain. Press ENTER. The
webmail login screen will open.

Type the user name and password that you specified during creation
of your mailbox and click Log in

Note: If you are going to use Kronolith Web calendars, do not share your calendars
with other users by selecting the option "all authenticated users" because this will make
your calendars accessible to users under other domains hosted on this server. To
share calendars, use the "individual users" type of sharing and add all authorized users
manually.

Protecting Mailbogd~rom Spam

To protect your mailbox from undesirable correspondence, do not publish your e-mail
address on Internet forums and switch on the server-side spam filter provided by the
SpamAssassin software. Also ask your provider to switch on protection from spam and
phishing based on DomainKeys.
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DomainKeys is based on sender authentication. When an e-mail claims to originate
from a certain domain, DomainKeys provides a mechanism by which the recipient
system can credibly determine that the e-mail did in fact originate from a person or
system authorized to send e-mail for that domain. If the sender verification fails, the
recipient system discards such e-mail messages. Verification of incoming mail can be
switched on only by your provider; however, if server policy allows, you can switch on
signing of e-mail messages that are sent from your domain: Domains domain name
Mailgroup title menu > Mail Settings > Use DomainKeys spam protection system to sign
outgoing anail messagesption.

If you use a Linux-based hosting account, then you can also use the spam protection
based on greylisting. Greylisting is a spam protection system which works as follows:
For every e-mail message that comes to the server, sender's and receiver's e-mail
addresses are recorded in a database. When a message comes for the first time, its
sender and receiver addresses are not listed in the database yet, and the server
temporarily rejects the message with an SMTP error code. If the mail is legitimate and
the sending server is properly configured, it will try sending e-mail again and the
message will be accepted. If the message is sent by a spammer, then mail sending will
not be retried: spammers usually send mail in bulk to thousands of recipients and do
not bother with resending.

The greylisting protection system also takes into account the server-wide and per-user
black and white lists of e-mail senders: e-mail from the white-listed senders is accepted
without passing through the greylisting check, and mail from the black-listed senders is
always rejected.

When the greylisting support components are installed on the server, then greylisting is
automatically switched on for all domains. You can switch off and on greylisting
protection for individual domains through Parallels Plesk Panel (at Domains> domain
name> Mailgroup title menu > Mail Settings Switch on greylisting spam protection for all
mail accounts under this domaistion). When you need to publish your e-mail address,
you may want to create a disposable e-mail address - e-mail alias - for your primary e-
mail address, and publish it instead. All messages sent to the e-mail alias will come

into your mailbox. Once you start getting spam, remove that alias and create another
one. If you have a mailbox at another domain or mail server, you may want to set up a
disposable e-mail forwarder.

In this section:

Setting Up Additional Disposable E-mail Addresses (Mail Aliases).................... 136
Setting Up SpamAssassin Spam Filter..........cccooovviiiiiiiiiiii e 136
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Setting Up Additional Disposabla&il Addresses
(Mail Aliases)

To set up an-mail alias for a mailbox:

Go to Domains ¥lomain name Mail Accounts >mail address > Add New
Mail Alias

2 Type a desired name and click OK

The messages addressed to your additional e-mail address (e-mail alias) will get to
your mailbox. You can see the list of currently used mail aliases by clicking Show Aliases
on the page that lists mail accounts under the domain.

To remove anmail alia from a mailbox:

Go to Domains ¥lomain name Mail Accounts >mail address.

2 Select the check box corresponding to the alias that you wish to
remove, and click Remove

Setting Up SpamAssassin Spam Filter

If you receive undesirable correspondence to an e-mail address that you cannot or do
not want to remove, consider setting up spam filter for your mailbox. To do this,

A Enable SpamAssassin spam filter in Parallels Plesk Panel, if supported by your
provider, and

A Install spam filtering software of your choice to work with e-mail program on your
home or office computer.

In this section:

Switching 0N SPam Filter.......oo e 137
Improving Accuracy of Spam Detection............coooveeeieii 139
Clearing Spam Filter's Database ...............uuvuiiiiiiiiiiiiiiiiiiiiiiiiiiieiieeiieeeeeeeaees 139

Switching off Spam Filter.... ..o 140
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Switching on Spam Filter

U To switch on spam filtering for a mailbox:

1 Go to Domains> domain name Mail Accounts e-mail address Spam
Filtering

2 Configure the following settings:

A Switch on SpamAssassin spam filter®gject this option to switch on spam
protection.

A The score that a message must receive to qualify as Bpisrsetting adjusts spam
filter sensitivity. SpamAssassin performs a number of different tests on contents
and subject line of each message. As a result, each message scores a number
of points. The higher the number, the more likely a message is spam. For
example, amessage containi ng t he text string ABUY VI AGI
PRI CE!/'!'1 0 in Subject I|Iine and message body
filter sensitivity is set so that all messages that score 7 or more points are
classified as spam.

A If you receive lots of spam messages with the current setting, to make filter
more sensitive, try setting a lesser value in the The score that a message must
receive to qualify as spamx; for example, 6.

A If you are missing your e-mails because your spam filter thinks they are junk,
try reducing filter sensitivity by setting a higher value in the The score that a
message must receive to qualify as spar

Note: To further improve spam filter accuracy, you may want to train your spam
filter on e-mail messages you receive (see the instructions on improving
accuracy of spam detection in the following section).

A What to do with spam mdilyou are sure that your spam filter is accurate, you
may want to set the filter to automatically delete all incoming messages
recognized as spam. To do this, select the Deleteoption. If you wish to filter malil
with the software on your local computer, select the Mark as spam and store in
mailboxoption, and then specify how spam filter should mark the messages
recogni zed -@gpam-Blpagn. YKXSpameéSndhatiu¥: Yesod head
are added to the message source by default, and if you want, the spam filter will
also include a specific text string to the beginning of Subject line. To include a
desired combination of symbols or words to the message subject, type it into the
Add the following text to the beginning of subject of each message recognized as spam
box. If you do not want the spam filter to modify message subject, leave this box
blank. If you want to include into the subject line the number of points that
messages score, type _SCORE__ in this box.

A Spam detection alert tektyou want spam filter to include a text into e-mail
messages marked as spam, type the text into this box.

A Trusted languages and localEsmail messages written in the specified languages
and with the defined character sets will pass the spam filter and will not be
marked as spam.

3 Click OKto save the settings.

4 If you do not want to receive e-mail from specific domains or
individual senders, click the Black Listtab, and then add the respective
entries to the spam filterds black 1 i st



138 Using Email Services

A To add entries to the black list, click Add Addressedf you have a list of entries
stored in a file, click Browseto specify it, and then click OK Otherwise, select the
From Lisbption, and type the e-mail addresses into the E-mail addressebox.
Place each address in one row, or separate addresses with a coma, a colon, or
a white space. You can use an asterisk (*) as a substitute for a number of
letters, and question mark (?) as a substitute for a single letter. For example:
address@spammers.net, user?@spammers.net, *@spammers.net. Specifying
*@spammers.net will block the entire mail domain spammers.net. To save the
entries you added, click OK then confirm adding, and click OKagain.

A To remove entries from the black list, under the Black Listab, select the entries
and click RemoveConfirm removal and click OK

5 If you want to be sure that you will not miss e-mail from specific
senders, click the White Listab, and then add e-mail addresses or
entire domains to the spam filterds whi

A To add entries to the white list, click Add Addresss If you have a list of entries
stored in a file, click Browseto specify it, and then click OK Otherwise, select the
From Lisboption, and type the e-mail addresses into the E-mail addressebox.
Place each address in one row, or separate addresses with a coma, a colon, or
a white space. You can use an asterisk (*) as a substitute for a number of
letters, and question mark (?) as a substitute for a single letter. For example:
address@mycompany.com, user?@mycompany.com, *@mycompany.com.
Specifying *@mycompany.com will add to the white list all e-mail addresses that
are under the mycompany.com mail domain. To save the entries you added,
click OK then confirm adding, and click OKagain.

A To remove entries from the white list, under the White Listab, select the entries
and click RemoveConfirm removal and click OK

6 Once finished with setting up the spam filter, click OK
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Improving Accuracy of Spam Detection

You can improve accuracy of spam detection by training the spam filter on the e-mail
messages that you have in your mailbox.

U To improve accuracy of spam detection:

1 Go to Domains xlomain mme> Mail Accounts e-mail address Spam
Filtering > Training

Note: In Parallels Plesk Panel for Linux/Unix platforms, each message is
accompanied by an icon in the left column, which tells if a message is recognized

as spam - @', non-spam - @ or not recognized at all - ", If you have already
trained your spam filter on a message and the results were recorded in the spam

filter 6s da “adshowsrein theaight columm.n

2 Train the spam filter.

In most cases, you can tell if a message is spam by looking at its subject line and
sender 6s name. I f they do not give you any
using your e-mail program or Webmail interface.

A To mark a message as spam, select the corresponding check box and click 6 1 t & s
Spa.m! o

A To mark a message as not spam, select the corresponding check box and click
0l tds .Not Spambd

A To remove any information on a given message from the spam filter database,

select the corresponding check box and click 6 For.get 1t 0

3 Once finished with training, you can remove spam e-mails from your
mailbox using your e-mail program or Webmail interface.

Clearing Spam Filter's Database

If you have accidentally made your spam filter learn a great number of spam e-mails as
non-spam or vice versa, your spam filter will likely produce incorrect results. In this
case, clear the spam filter's database and then repeat training.

0 To clear spam filterbés database:

1 Go to Domains xlomain name Mail Accounts email address Spam
Filter > Trainingab.

2 Click the Clearbutton.
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Switching off Spam Fait

To switch off spam filtering for a mailbox:

Go to Domains lomain name Mail Accounts email address Spam
Filter.

2 Clear the Switch on SpamAssassin spam filteghgck box and click OK

Protecting Mailboxes From Viruses

To defend your system from viruses, do not open suspicious e-mail attachments,
enable anti-virus protection on the server side, if this service is provided by your
hosting company, and be sure to have a firewall and anti-virus software installed on
your personal computer. Also keep your operating system up-to-date and timely install
security hot fixes and patches.

In this section:

Switching on Anti-Virus ProteCtion ............couuuiiiiiiie i 140
Switching off ANti-ViruS Prot@CHION ............uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieiiieeeieeeeeeenineeees 141

Switching on Antiirus Protection

To switch on antiirus protection for a mailbox:

Go to Domains ¥lomain name Mail Accounts e-mail address Virus
Protection.

2 Choose the desired mail scanning mode. You can switch on scanning
for incoming mail, outgoing mail, or both.

Note: If Kaspersky Antivirus is used on the server, then you can use the Scanning
settingsicon to adjust scanning settings. To view the information about scanning
settings, click the Helpshortcut in the navigation pane.

3 Click OK
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Switching off Antrirus Protection

To switch off antiirus protection for a mailbox:

Go to Domains lomain name Mail Accounts e-mail address Virus
Protection

Select the Do not scan for virusegption and click OK

Suspendig and Unsuspending Mailboxes
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To temporarily suspenehaail services for a mailbox:

Go to Domains xlomain name Mail Accounts e-mail address
Click Mailboxin the Toolsgroup.

Clear the Mailboxcheck box.

Click OK

To resume-eail services for a suspded mailbox:

Go to Domains xlomain name Mail Accounts e-mail address
Click Mailboxin the Toolsgroup.

Select the Mailboxcheck box.

Click OK

To temporarily suspenehaail services for all mailboxes in a domain:
Go to Domains *omain name MailAccounts
Click Switch Ofin the Toolsgroup.

To resume-mail services for all mailboxes in a domain:
Go to Domains ¥lomain name Mail Accounts
Click Switch Orin the Toolsgroup.
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Removing Mailboxes

U To remove a mailbox:
Go to Domains xlomain name Mail Accounts.

2 Select a check box corresponding to the mailbox that you want to
remove.

3 Click Remove
4 When prompted, confirm removal and click OK

Switching off the Mailbox Service When
You Have Decided to Turn Your Account
Into a Mail Forwarder

If you are going to use your existing e-mail account as a mail forwarder or mailing list,
you are recommended to switch off the mailbox service: a mailbox keeps all incoming
messages and messages are not removed automatically after being forwarded.
Therefore, if you choose to have the "mailbox + mail forwarder" configuration on your
account, be sure to clean up the mailbox from time to time.

0 To switch off the mailbox service for your account discarding all messages in your
mailbox:

1 Go to Domains lomain name Mail Accounts ®-mail address Mailbox.
2 Clear the Mailboxcheck box.
3 Click OK
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Setting Up Mall Forwarding to a Single E
mail Address

U To set up an-mail address that will accept mail and forward it to anathait e
address:

1 Go to Domains xlomain name Create Redirect

2 Select an e-mail address that you would like to turn into a mail
forwarder, or click Add New Mail Accoutd set up new e-mail address.

3 Click Next >>

The domain name is shown to the right of @ sign, so you only need to type the
name. This can be, for example, your first name and last name separated by a dot,
a department name, or any other text in Latin symbols. The name should be short
enough to remember. It can comprise alphanumeric, dash, dot, and underscore
symbols.

4 Select the Rediectcheck box and type the destination e-mail address
to which you would like to forward e-mail.

5 Click Finish

Suspending and UnsuspendMgil Forwarders

To suspend a mail forwarder:

Go to Domains xlomain name Mail Accounts email address> Redirect
Clear the Redirectcheck box.

Click OK

w N -

To unsuspend a mail forwarder:

Go to Domains xlomain name Mail Accounts email address> Redrect
Select the Redirectcheck box.

Click OK

w N -
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Setting Up Mall Forwarding to Multiple E
mail Addresses

U To set up an-mail address that will accept mail and forward it to multiple ottzar e
addresses:

1 Go to Domains @lomain name Mail Accounts e-mai address> Mail
Group

2 Click Add New Membher

You should add at least one e-mail address before enabling mail forwarding to
several e-mail addresses.

3 Enter the desired external e-mail address into the E-mailinput box or
select one or more of the listed mail accounts using check boxes.

4 Click OK
5 Click Switch On

In this section:

Adding and Removing Recipient AddreSSes ...........veeeeiieiiiiiieiiiiiee e, 145
Switching off Mail Forwarding to Multiple E-mail Addresses..........ccccceeeeeeeeeeeenn, 145
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Adding and Removing Recipient Addresses

i

A WD
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4

To add an externaheail address to the list of mail accounts that receive forwarded e
mail correspondence:

Go to Domains ¥lomain name Mail Accounts e-mail address Mail
Group

Click Add New Member

Enter the desired external e-mail address into the E-mailinput field.
Click OK

To remove an externatmail address from the list of mail accounts that receive
forwarded enail correspondence:

Go to Domains ¥lomain name Mail Accounts e-mail address Mail
Group

Select the check box corresponding to the e-mail address you wish to
remove from the list.

Click Remove Confirm removal and click OK

To add an-eail address registered on the server to the list of mail accounts that
receiveforwarded enail correspondence:

Go to Domains> domain name MailAccounts> mail account Groups

Select the required multiple e-mail forwarder in the Available mail groups
list.

Click Add >>
Click OK

An e-mail address registered on your server can also be added to the subscription list
using the procedure for adding an external e-mail address (see above).

i

3
4

To remove armail address registered on your server from the list of mail accounts
that receive forwardeehaail correspondence:

Go to Domains> domain name MailAccounts> mail account Groups

Select the required multiple e-mail forwarder in the Member of the
following mail groupBst.

Click << Remove
Click OK

An e-mail address registered on your server can also be removed from the subscription
list using the procedure for removing an external e-mail address (see above).
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Switching off Malil Forwarding to Multiphesit
Addresses

To switch off the-mail forwarding to severatrail addresses:

Go to Domains lomain name Mail Accounts e-mail address> Mail
Group

2 Click Switch Off

Removing Mail Forwarders

To remove a mail forwarder:
Go to Domains lomain name Mail Accounts

2 Select a check box corresponding to the mail forwarder that you want
to remove.

3 Click Remove
4 When prompted, confirm removal and click OK
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Setting Up Automatic Reply

If you are going on vacation and will not be able to check your mail for a while, you may
want to leave a vacation notice that will be automatically sent to your correspondents
once they send e-mail to your address. This is done with automatic reply facility, also
referred to as autoresponder. Aside from vacation notices, organizations can use
automatic replies to notify customers that their orders or technical support requests
were received and will soon be processed. Automatic replies can include pre-written
messages in plain text or HTML format, and they can contain attached files as well.

To set up automatic reply for a mailbox:

Go to Domains ¥xlomain name Mail Accounts e-mail address
Autorespnders

2 If you are not going to attach any files to the automatic reply, proceed
to the step 3. To attach a file to the automatic reply:

1. Click the Attachment Filescon in the Toolsgroup.
2. Click Browseto locate the file, and once selected, click Send He.

The file will be added to the attachment files storage, and you will be able to
attach this file to a number of different automatic replies.

3. Once finished, click Up Leveand proceed to the next step.
3 Click the Add New Autorespondeon in the Toolsgroup.
4 Configure the automatic reply:

1. Type a name for this automatic reply into the Autoresponder name
box.

For example, Vacation notice.

2. If you want your incoming mail to be forwarded to another e-
mail address while you are away, specify an e-mail address in
the Upon automatic response, forward the original message to the specified
e-mailbox.

3. If you want this automatic reply to be sent in reply to any
incoming e-mail message, in the Conditionsgroup, leave the
always respondption selected. If you wish to automatically reply
only to e-mail messages that contain specific words in the
message text or subject line, select the appropriate option,
and type the word combination in the input box.

4. By default, the subject line of incoming e-mail will be inserted
into the automated reply. To use a custom subject, type it into
the Replysubject input box.
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5. As your correspondents may not figure out that the message
they received from you was an automatic response, they may
want to respond to your auto-reply. So, you should specify
your e-mail address as the Return addressotherwise, their
messages wi l |l be directed at the auto

6. Specify the automatic reply message format (plain textor HTMI.
and character encoding (UTF8 is recommended). If you use
HTML tags in your auto-reply message, you should select the
HTMLoption.

7. Type your message in the Reply with textield.

8. Attach your files, if needed. To do this, click the Add New
Attachmenbutton, select the check box corresponding to the
file that you previously uploaded to the attachment storage,
and click OK To remove an attached file from the automatic
reply, select the corresponding check box, and click Remove

9. To limit the number of automated responses per day to the
same e-mail address, enter the desired number in the
respective input box under Limits

The default setting is to respond no more than ten times in one day to the same
e-mail address.

10. To reduce mail server load, you may want to limit the
number of unique addresses that the autoresponder will
remember. To do this, enter the desired number into the Store
up tobox.

5 Click OK
6 Click the Switch Oricon in the Toolsgroup.
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Switching off Automatic Reply

U To switch off an automatic reply for a mailbox:

Go to Domains xlomain name Mail Acconts >e-mail address
Autoresponders

2 Click Switch Off

The automatic reply is now switched off. Its configuration is not deleted from the control
panel, so the next time you need to use this automatic reply, repeat the above
procedure, clicking Switch Oron the last step.

To delete an automatic reply configuration that you no longer need:

Go to Domains ¥lomain name Mail Accounts e-mail address
Autoresponders

2 Select a check box corresponding to the configuration name, and click
Remove
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Setting Uibitewide Preferences for
Handling Mail to Nonexistent Users (Mall
Bounce)

When somebody sends an e-mail message to an e-mail address that does not exist
under your domain, the mail server, by default accepts mail, processes it, and when it
finds out that there is no such a recipient under the domain, it returns the mail back to
sender with the fithis address no | onger

A Continue returning all such mail back to senders (Bounceor Bounce with message
option),
A Forward all such mail to the specified e-mail address (Forwardio addres®ption),

A Forward all such mail to another mail server with the specified IP address using the
option Redirect to external mail server with IP addeasslable only for Windows
hosting),

A Reject such mail without accepting it and without notifying senders (Rejectoption).

This setting can decrease mail server load caused by a large amount of spam,
which is often sent to randomly generated user names. However, for spammers,
this can somewhat speed up scanning your mail server for valid e-mail addresses.

To configure the siwide settings for handling mail to nonexistent users:
Go to Domains xlomain name Mailgroup title menu > Mail Settings
Select the required option and specify the information as required.
Click OK

w N -

accep
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Introducing Similar Changes to a Number
of Mail Accounts at Once

To introduce similar changes to a number of mail accounts at once:
Go to Domains xlomain name Mail Accounts

2 Select the check boxes corresponding to the mail accounts whose
settings you want to change.

3 Click I# Modify
4 Adjust the settings as necessary:

A Select Switch orto enable the corresponding option for the selected mail
accounts.

A Select Switch offto disable the corresponding option for the selected mail
accounts.

A Leave Do not changselected if you do not want to change the corresponding
option.

5 Click OK

Maintaining Mailing Lists

If you wish to deliver offers and promotions to your customers, run a newsletter, or
inform visitors of your site of recent updates, you should set up a mailing list on your
site and subscribe your users to it or invite them to subscribe themselves.

Mailing list is a convenient way to reach a number of readers at once: it contains a list

of e-mail addresses, which are combined under a single e-mail address, to which you
post your information or a newsletter.

In this section:

Setting Up @ Mailing LiSt........coovuiiiiiii i e e e e e aeaees 152
Subscribing and UnsubscribDing USErS............uuuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiennnes 153
Posting to Your Mailing LiSt..........uuuiiiiiieiiie e 153

Removing Mailing LiStS .......cooiiiiiiiii e 153
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Setting Up a Mailing List

Toset up a mailing list:

Go to Domains xlomain name Mailing lists
Click Switch Orto start the mailing list service.
Click Add New Mailing List

Specify the desired name for the mailing list.

This can be, for example, a department name, a topic of the mailing list, or any
other text in Latin symbols. The name should be short enough to remember. It can
comprise alphanumeric, dash, dot and underscore symbols.

5 Specify the password that will be used for administering the mailing
list.

A WN P C

6 Specify the mailinglist admi ni smailat or 6s e
7 Leave the Notify administrator of the mailing list creatibeck box selected.

You will receive instructions on using and managing the mailing list at the
admi ni s t-madyowspearifed. eep that message for your records.

8 Click OK

Your mailing list is operable with the default settings. However, you may want to
configure it, for example, so as to enable moderation, filter content of the posts or to
archive messages.

To configure the mailing list:
Go to Domains omain nam> Mailing lists
Clicktheiconflnext to the desi-maladdressi | i n g |
A login screen opens.
3 Type the list administrLetomési paéswor d
0 Alternately, you can acsethe mailing list configuration the following way (on Linux
hosting):

1 In your Web browser, enter the following URL: http://lists.your
domain.cofmailman/admin/listnamd&where your-domain.com is your
domain name, and listnameis the name of the mailing list (that is, the
|l eft part of t-hal addrass beforeghe @isgr).6 s e

A login screen opens.
2 Type the list administrLetomési paéswor d

To post a newsletter issue or other information to the mailing list, send it by e-mail to
t he mai | imailgaddtesssAtl gulsscribed users will receive it.
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Subscribing and Unsubscribing Users

To subscribe users to a mailing list:
Go to Domains xlomain name Mailig lists >mailing list name Add New

Member
2 Speci fy -maladdréess. e
3 Click OK
U To unsubscribe users from a mailing list:
1 Go to Domains xlomain name Mailing lists mailing list name
2 Select a check box t omdilhdereds.ef t of
3 Click Remove
4 Confirm removal and click OK

Posting to Your Mailing List

To post a newsletter issue or other information to the mailing list, send it by e-mail to
t he mai | imailgaddtesssAtl sulsscribed users will receive it.

Removing Mailirigsts

To remove a mailing list from a site:
Go to Domains domain name Mailing lists.

2 Select a check box corresponding to the mailing list address that you
want to remove.

3 Click Remove
4 When prompted, confirm removal and click OK

h e
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Viewing Statistics

i

To view the information about disk space and bandwidth used by your sites:

On your Home page, click the appropriate statsshortcut.

i

To find out how many people visited a site, from what countries, and ehaif plag
site they viewed:

Go to Domains > domain name > Web Statistics

View the statistics for the web pages or files downloaded from or
uploaded to specific areas of your site:

To view the bandwidth usage by months, click Bandwidth Usage History

To view the bandwidth usage by FTP, Web and mail services in this domain, click
Traffic Usage Report

To view the statistics for web pages transferred from your site over hypertext
transfer protocol (HTTP), click Web Stats

To view the statistics for web pages transferred from your site over secure
hypertext transfer protocol (HTTPS), click Web Stats SSL

To view statistics for files transferred over file transfer protocol (FTP), click FTP
Statistics

To view statistics for files transferred over file transfer protocol (FTP) with
anonymous access without a password, click Anonymous FTP Statistics

Note: If you use the Webalizer statistical package on your account, you can
customize the graphical reports shown by Webalizer. For instructions, refer to the
Adjusting Preferences for Web Statistics Presentation by Webalizer section.

Alternately, you can view the Web statistics for a site by visiting the following URL:
https://your-domain.com/plesk-stat/webstat. When prompted for username and
password, specify the credentials for your FTP account.

To view a consolidated report on all your web sites and your hosting account, go to
Domains > View Statistics

Common operations on reports:

A To get more details, select the Full Reporbption from the Reportdrop-down menu.
A To adjust the amount of information presented in a report, click Customizeand then

modify an existing report template (to do this, click a report template name) or
create a new report template (to do this, click Add New LayoutNext, specify how
much information you want in each section of the report: select Noneif you do not
want any information, select Summaryf you want a concise overview, or select Fullif
you need a detailed report. Select the Use as default reparheck box and click OK
To delete a custom report layout, select the check box corresponding to the report
layout name and click Remove
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A To print the report, click Print A report will open in a separate browser window.
Select the File> Printoption from the browser's menu to print the report.

A To send the report by e-mail, type the recipient's e-mail address into the input box
located to the right of the Report group and click Send by Enail If you are the
recipient, then you do not need to specify an e-mail address: the system assumes
by default that you are the report recipient and specifies your e-mail address
registered with your control panel account.

A To have the reports automatically generated and delivered by e-mail on a daily,
weekly, or monthly basis, click Report Delivergnd follow the instructions supplied in
the section Automating Report Generation and Delivery by E-mail (on page 158).

In this chapter:

Adjusting Preferences for Web Statistics Presentation by Webalizer................. 155
Automating Report Generation and Delivery by E-mail................ocoooviiiiienne.n. 158
Viewing Log Files and Configuring Recycling of Log Files.................ooeeeeeein. 160

Adjusting Preferences for Web Statistics
Presentation by Webalizer

By default, statistical utility counts and reports the requests for web pages and other

files made fromyoursited by your own web pagéemwserSo, when a
requests from your site a single web page that contains references to other files, such

as scripts, cascading style sheets, media files, and the like, the statistical utility reports

these references to files as if they were visits to your web page. Thus, with the default

settings your usage statistics is inaccurate.

You may want to:

A Hide these internal references, and references from other sites.

A Group references from a number of sites, so as to show them as if they originated
from a single location.

A Hide direct requests. Direct requests are sent to your web server when users
access your site by typing the URL in their browsers.

In this section:

Hiding and Unhiding Internal References from Your and Other Sites ................ 156
Grouping and Ungrouping References from Other Sites ...........ccccccveeeviieeeeieenns 156
Hiding and Unhiding DireCt REQUESTES ..........ccovvviiiiiiiiiiiiiiiiiiiiieeeeeeee 157
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Hiding and Unhiding Internal References fooimarid
Other Sites

A WON PP C

To hide the internal references or references from other sites:

Go to Domains xlomain name Web Statistics > Preferences
Click Hide Entries

In the Entry typedrop-down box, leave the Referrewvalue selected.

In the Referreffield, type the domain name from which you do not want
the referrers shown in web statistics reports.

You can use the "' wildcard character to specify a part of domain name.
Click OK

To unhide references:
Go to Domains lomain name Web Statistics > Prefereisc

Select the check boxes corresponding to the entries you wish to
unhide and click Remove

Confirm the operation and click OK

Grouping and Ungrouping References from Other Sites

To group references from a specific site:

Go to Domains xlomain name Web Statistics > Preferences > Grouped
referrerstab > Group Referrers

Type the group name that you wish to be shown for all referrers on
the specific site.

In the Referreinput box, specify the site (domain name) from which all
referrers should be grouped.

You can use the *" wildcard character to specify a part of domain name.
Click OK

To ungroup references from a specific site:

Go to Domains xlomain name Web Statistics > Preferences > Grouped
referrerstab. All referrer group names will be presented in a list.

Select the check box corresponding to the required group name and
click Remove

Confirm the operation and click OK
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Hiding and Unhiding Direct Requests

To hide direct requests:

Go to Domains xlomain name Web Statistics > Preferences
Click Hide Entries

In the Entry typedrop-down box, select the Direct requestalue.
Click OK

A W N PP C

To unhide direct requests:

=

Go to Domains ¥lomain name Web Statistics > Preferencas$l hidden
entries will be presented in a list.

2 Select the check box corresponding to the Direct requeséntry and click
Remove

3 Confirm the operation and click OK
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Automating Report Generation and
Delivery by fnall

To receive consolidated reports on your account status on a regular basis:
Go to Domains xlomain name Report }ayouts

Under the Namecolumn, click the report type you need.

Click Report Delivery

Click New Delivery Schedule

To receive the report to your e-mail address registered with the
system, select the the clientvalue from the Deliver tadrop-down menu.
To receive the report to another e-mail address, select the the email
address | specifgption and type the e-mail address.

6 Select the delivery interval from the Delivery frequencgrop-down menu.

gaa b~ W DN PP

You can have the report delivered each day, each week, or each month.
7 Click OK

U To change the delivery schedule for an account status report:

Go to Domains xlomain name Report >Layouts >eport name> Report
Delivery

2 Under the Frequencyolumn, click a hyperlink corresponding to the
delivery schedule you would like to change.

3 Adjust the settings as required and click OK

U To stop receiving the account status reports:

Go to Domains xlomain name Report Layouts >eport name> Report
Delivery

2 Select a check box corresponding to the delivery schedule and click
Remove Confirm removal and click OK

U To receive detailed reports on a specific domain/web site on a regular basis:

Go to Domains xlomain name Report >Layouts >eport name> Report
Delivery

2 Click Add Delivery Schedule

3 To receive the report to your e-mail address registered with the
system, select the clientvalue from the Deliver tadrop-down menu. To
receive the report to another e-mail address, select the email address |
specifyoption and type the e-mail address.

4 Select the delivery interval from the Delivery frequencgrop-down menu.
You can have the report delivered each day, each week, or each
month.

5 Click OK
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To change the delivery schedule for a detailed domain/web site report:

Go to Domains xlomain name Report Layouts >eport name> Report
Delivery

Under the Frequencycolumn, click a hyperlink corresponding to the
delivery schedule you would like to change.

Adjust the settings as required and click OK

To stop receiving the account status reports:
Go to Domains lomain name Report Layouts >eport name Report
Delivery

Select a check box corresponding to the delivery schedule and click
Remove Confirm removal and click OK
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Viewing Log Files and Configuring
Recycling of Log Files

All connections to the Web server and requests for files that were not found on the
server are registered in log files. These log files are analyzed by the statistical utilities
running on the server, which then present graphical reports on demand. You may want
to download these log files to your computer for processing by third-party statistical
utilities, or view their contents for web server debugging purposes.

U To prevent these log files from growing too large, you should enable automatic
cleanup and recycling of log files:

1 Go to Domains> domain name Log Manager Log Rotation

2 Click Switch Onn the Toolsgroup. If you see only Switch Ofthere, this
means that log recycling is already switched on.

3 Specify when to recycle log files and how many instances of each log
file to store on the server. Also specify whether they should be
compressed and sent to an e-mail address after processing.

4 Click OK

To view the contents of a log file or download it to your computer:
Go to Domains> domain name Log ManagerA list of log files opens.
2 Do any of the following:

A To specify the number of lines from the end of the log file that you would like to
view, type a number into the input box under the Preferencegroup.

A To view the contents of a log file, click its file name.

A To download a file to your computer, click an icon ki, corresponding to the file
you need.

A To remove a processed log file from the server, select a corresponding check
box and click RemoveConfirm removal and click OK
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Backing Up And Restoring Your Data

With the current version of backup and restore utilities installed with your control panel,
you can:

Back up your account with domaifike backup archive will include all control panel
configurations and data related to your account and your domains (Web sites).

Back up individual domains (Web sit€hg backup archive will include all data related to
domain administrator's account, domain (web site) and mail services, including the
contents of mailboxes, Horde Turba address book contact lists, antispam and antivirus
settings.

Schedule backup$cheduling backup can be done both for your account and your
domains.

Restore your data from backup archives

In this chapter:

Configuring Control Panel for Using FTP RepoSitory.......ccccooeeviviiiiiiienieeeeceeenns 162
Backing Up Your Account with Your DOMaINS ...........ccoovvviiiiiiiiiiiiiiiiiiiiiiiiieeeee 163
Backing Up Individual Domains (Web SIteS).........ccovviiiiiiiiiiiiiiiiiiiiiiiiiiieee 164
Backing Up Databases (Windows HOStING) ......ccoooeeiiiiiiiiiiiiieeeccceeieee e, 164
Scheduling BaCKUPS ... ..oi i e e eeaaes 165
Restoring Data From Backup ArChives..........ccccccoviiiii 166
ReStOriNg DatabaSES........cii i 167
Maintaining Your Backup Files REPOSItOrY .......cccoeeeiiiiiiiiiiiiiieeeeeeeeicee e 168

Maintaining Database Backup Files Repository (Windows Hosting) .................. 170
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Configuring Control Panel for Using FTP
Repository

U If you are going to use an FTP server for storing backup files, you should set up the
control panel appropriately:

1 Navigate to the repository you need:

A For a repository on your account level, go to Home> Backup Manager Personal
FTP Repository Settings.

A For a repository on a domain level, go to Domains> domain name Backup
Managepr Personal FTP Repository Settings.

2 Specify the following settings:
A FTP server's IP address or host name.
A Directory on the server, where you want to store backup files.
A User name and password for access to the FTP account.

3 Click OK
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Backing Up Your Account with Your
Domains

To back up your account with domains:

On your Home page, click BackupManager
Click Back Up

Specify the following:

A Backup file name prefix and description. You cannot specify an arbitrary file
name, however, you can set the control panel to add a prefix to backup file
names. Note that the control panel automatically adds the date and time of
backup file creation (in Universal Time) to backup file names.

A Splitting of the backup file. To create a multivolume backup, select the
respective check box and specify volume size in megabytes.

A Location where to store the backup file. Select the repository where you would
like to store the backup file.

A What data to back up. You can back up only the settings related to your account
and Web sites, or the settings with all Web site content.

A E-mail notification on backup completion. If you want to be notified of the
backup completion, type your e-mail address.

Click Back UpThe backup process will start and the progress will be
shown under the Current Back Up Tasksb. You can use the Refresh

button to update the information on the screen. When backing up is
finished, the backup file will be saved to the repository you selected.
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Backing Up Individual Domains (Web
Sites)

w N =

To back up a domain (Web site):

Go to Domains xlomain name Backup Manager
Click Back Up

Specify the following:

A Backup file name prefix and description. You cannot specify an arbitrary file
name, however, you can set the control panel to add a prefix to backup file
names. Note that the control panel automatically adds the date and time of
backup file creation (in Universal Time) to backup file names.

A Splitting of the backup file. To create a multivolume backup, select the
respective check box and specify volume size in megabytes.

A Location where to store the backup file. Select the repository where you would
like to store the backup file.

A What data to back up. You can back up only Web hosting settings, or the Web
hosting settings and all site content.

A E-mail notification on backup completion. If you want to send an e-mail notice
on the backup completion, type the required e-mail address.

A Suspend the Web site until backing up is finished. If you do not want anybody to
make any changes to the site content or settings during backing up, select the
corresponding check box.

Click Back Up NowThe backup process will start and the progress will
be shown under the Current Back Up Tasksb. You can use the Refresh
button to update the information on the screen.

When backing up is finished, the backup file will be saved to the repository you
selected, and will be accessible either from the FTP server, or from the location
Domains> domain namg Backup Manager

Backing Up Databases (Windows Hosting)

To back up a database:
Go to Domains> domain name Databases

Select a check box corresponding to the database you want to back
up and click Back Up

Specify the name of the backup file and click OK

If you want to download the resulting backup file, click the file name
on the next page after the backup process was finished. Specify the
location where you want to save the file and click Save
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5 Click OK

To back up all databases on your domain:

Go to Domains> domain name Backup Manager Database Backup
Repository make sure that All domain repositorieis selected in the
Databasdield, and click Back Up

2 Specify the name of the backup file and click OK

3 If you want to download the resulting backup file, click the file name
on the next page after the backup process was finished. Specify the
location where you want to save the file and click Save

4 Click OK

Scheduling Backups

To schedule backing up of data:

Go to the backup files repository corresponding to the type of data
you want to back up:

A To back up your account settings and Web site content, go to Home> Backup
Manager

A To back up a Web site, go to Domains> domain name BackupManager

2 Click Scheduled Backup Settings

3 Select the Activate this backup tasiheck box and specify the following:
A When and how often to run the backup.
A Backup file name.

A Splitting of the backup file. To create a multivolume backup, select the
respective check box and specify volume size in megabytes. Note that volume
size cannot exceed 4095 megabytes.

A Location where to store the backup file. Select the repository where you would
like to store the backup file.

A Maximum number of backup files stored in the repository. Type a number if you
want to recycle backup files: When this limit is reached, the oldest backup files
are removed.

A E-mail notification on backing up errors. If you want to send an e-mail notice
when something goes wrong during backing up, type the e-mail address you
need.

A What data to back up. You can back up only the settings, or settings and Web
site content.

4 Click OK



166 Backing Up Ad Restoring Your Data

Restoring Data From Backup Archives

To restore data from a backup file:
Go to the backup files repository where the backup file is located:

A To restore your account settings and Web site content, go to Home> Backup
Manager

A To restore a Web site, go to Domains> domain name BackupManager
2 Click the backup file name.
3 Specify the following settings:

A Types of data to bbestored.

A Suspend domain (Web site) until restoration task is com@etedt this if you want
to avoid possible conflicts that may occur when users modify site content or
settings while they are being restored.

A Send an nail notice when restoration kds completedType your e-mail address if
you want the control panel to notify you when restoring is completed.

A Conflicts resolution policgpecify what to do if any conflicts occur during
restoration.

4 Click Restore

In case if any errors or conflicts occur during restoration of data, the wizard will
prompt you to select an appropriate resolution. Follow the instructions provided on
the screen to complete the wizard.

Note: The Overwrite data restoring mode means that all objects will be restored
from the backup files regardless of their current presence in the system. The
overwrite mode works as follows:

A If an object or settings from the backup file are not present in the Parallels Plesk
Panel, then they are created or set in the Parallels Plesk Panel.

A If an object or settings from the backup file are present in the Parallels Plesk
Panel, then the object or settings from the backup file replace the corresponding
object or settings that are present in the Parallels Plesk Panel.

A If an object or settings are present in the Parallels Plesk Panel, but are missing
from the backup file, then the object or settings currently present in the Parallels
Plesk Panel are not changed.
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Restoring Databases

U If the database already exists and you only need to restomaéistso

Go to Domains> domain name Databases$ database name Database
Backup Repositoryselect the required backup file from the list and click
Restore

If you do not have the backup file on your server, you can upload the backup file to
the server repository from your local machine. Refer to Uploading Database Backup
Files To Server section for more information.

2 Confirm the restoration by selecting the corresponding check box and
click OK

If you are restoring MS SQL database, there is a possibility that some database
users will be orphaned. In order to provide the ability to access and use the
database for these users, you need to repair them. Refer to Recovering Orphaned
Database Users section for more information.

U If the database does not existlgou need to recreate it from scratch:
Go to Domains> domain name Databasesnd click Add New Database

2 Specify the database name, type and server for the database you are
restoring.

Note. You can specify a new database name, but you must choose the correct
database type: for example, if you are trying to restore a MySQL database, choose
MySQL database type.

3 Select the Restore database from backupdteck box.

4 Specify the location of the database backup file. You can upload a
backup file from your local machine or specify a file located on the
server.

5 Provide the default username and password for the restored
database.

6 Click OK

If you are restoring MS SQL database, there is a possibility that some database
users will be orphaned. In order to provide the ability to access and use the
database for these users, you need to repair them. Refer to Recovering Orphaned
Database Users section for more information.

In this section:

Recovering Orphaned Database USErS............coiiieiiiieieiiiiiie e 168
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Recovering Orphaned Database Users

If you are restoring an MS SQL database, there is a possibility that some database
users will be orphaned. In order to provide the ability to access and use the database
for these users, you need to repair them.

U To check if a database has orphaned users:

Go to Domains> domain name Databases database name

2 If you see a warning saying that there are several orphaned users that
should be repaired in order to function properly, you have orphaned
users who need to be repaired.

To repair orphaned users:

Go to Domains> domain name Databases database namand click the
Repairbutton corresponding to the orphaned user you want to repair.

2 Provide a password for this user and click Repair

If a user is supposed to be a system user without a password, run repair with empty
password field.

w

Repeat steps 1-2 as necessary to repair all orphaned users.

Maintaining Your Backup Files Repository

This section provides instructions on:

A Uploading backup files stored on another computer.
A Downloading backup files to another computer.
A Removing redundant backup files from the backup repository.

In this section:

Uploading Backup FIleS t0 SEIVEN ......ccoooiiiiiei e 169
Downloading Backup Files from Server........cccccccooiiiiiiie 169
Removing Backup Files from Server .........ccccooiiie 169
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Uploading Backup Files to Server

To upload a backup file to the backup repository within the control panel:
Go to Domains xlomain name Backup Manager

Click Upload Files to Server Repository

Click Browseand select the required backup file.

Click OK

The backup file will be uploaded to the backup repository.

A W DN - C

Downloading Backup Files from Server

To download b&ap file from the backup repository:
Go to Domains xlomain name Backup Manager

2 Click the icon & corresponding to the backup file you wish to
download.

3 Select the location where you want to save the backup file and click
Save

The backup file will be downloaded from the backup repository.

Removing Backup Files from Server

To remove backup file from the backup repository:
Go to Domains xlomain name Backup Manager

2 Select a check box corresponding to the backup file you want to
remove.

3 Click Remove
4 Confirm removal and click OK
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Maintaining Database Backup Files
Repository (Windows Hosting)

Your database backup files are stored in your own database backup repository,
accessible by going to Damains> domain name Backup Manager Database Backup

RepositoryEach database has its own backup files repository. To see backup files for a
specific database, select the required database from the Databasenenu. By default, the

database backup repository shows backup files for all databases on a domain.

In the database backup repository you can:

A Upload database backup files stored on another computer
A Download database backup files to another computer
A Remove redundant database backup files from database backup repository

In this section:

Uploading Database Backup Files TO Server.........cccovviieiiiii i 170
Downloading Database Backup Files From Server.........ccccoooeeeiiiiiiiiiieiiieeeeceennn, 171
Removing Database Backup Files From Server.........ccccoceeeiieeeiiiieiiiiieie e, 171

Uploading Database Backup Files To Server

To upload a backup file to backup repository:

Go to Domains> domain name Backup Manager Database Backup
Repositoryand click Upload Backufgile

2 Select the database in which repository you want to upload the
backup file to in the Database nanmenu.

3 Click Browse..and select the required backup file.
4 Leave the Restore database backup immediately upon uploait@ak box

selected if you want the database contents to be restored immediately

after the backup file is uploaded.
5 Click OK

The database backup file will be uploaded to the backup repository of the specified
database.



Backing Up And Restoring Your Data 171

Downloading Database Backup Files From Server

To download a bacgdile from backup repository:
Go to Domains> domain name Backup> Database Backup Repository.

Select the database which backup files you want to browse in the
Databasenenu. Leave All domain databaseselected if you want to browse
backup files of all databases on a domain.

Click an icon l corresponding to the database backup file you want
to download

Select the location where you want to save the backup file and click
Save

The backup file will be downloaded from the backup repository.

Removing Database Backup Files From Server

i
1

2

To download a backup file from backup repository:
Go to Domains> domain name Backup Manager Database Backup
Repository.

Select the database which backup files you want to browse in the
Databasenenu. Leave All domain databaseselected if you want to browse
backup files of all databases on a domain.

Select a check box corresponding to the database backup file you
wish to remove. Click 2 Removeconfirm removal and click OK
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Scheduling Tasks

If you need to run scripts on your site at specific time, use the task scheduler on your
provider's server to make the system automatically run the scripts for you.

In this chapter:

Scheduling a Task (LINUX HOSEING) ......vvvviiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieieeeeieeeeieeeeeeeeees 173
Scheduling a Task (WiNdOWS HOSHING) ......vvvvvriuiieiiiiiiiiiiiiiiiiiiiiiiiiiieninieeeeeenenenens 174
Suspending and Resuming Execution of Tasks..........ccccceeeiiiieiiiiiiiiiiiin e, 175

CANCEIING @ TASK ...ttt snnnnnnes 175



Scheduling Tasks 173

Scheduling a Task (Linux Hosting)

U To schedule a task:
Go to Domains> domain name Scheduled Tasks

2 Select the system user account on whose behalf the task will be
executed.

3 Click Schedule New Task
4 Specify when to run your command.
A Minute- enter the value from 0 to 59
A Hour- enter the value from 0 to 23
A Day of the Monthenter the value from 1 to 31
A Month- enter the value from 1 to 12, or select the month from a drop-down box
A Day of the Weekenter the value from 0 to 6 (0 for Sunday), or select the day of
the week from a drop-down box

You can schedule the time using the UNIX crontab entry format. In this format, you
can

A enter several values separated by commas. Two numbers separated by a
hyphen mean an inclusive range. For example, to run a task on the 4th, 5th, 6th,
and 20th of a month, type 4-6,20.

A insert an asterisk to specify all values allowed for this field. For example, to run
a task daily, type * in the Day of the Montiext box.

To schedule the task to run every Nth period, enter the combination */N, where N is
the legal value for this field (minute, hour, day, month). For example, */15 in the
Minutefield schedules the task to start every 15 minutes.

You can type the contracted names of months and days of the week, which are the
first three letters: Aug, Jul, Mon, Sat, etc. However, the contracted names cannot
be separated with commas or used together with numbers.

5 Specify which command to run. Type it into the Commandnput box.

For example, if you want to run the backup creation task at the specified time and
have the backup file sent to your e-mail, you need to specify the following command
in the Commandnput box:

lusr/local/psa/admin/sbin/backupmng
6 Click OK
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Scheduling a Task (Windows Hosting)

A WON PP C

To schedule a task for a domain:

Go to Domains> domain name Scheduled Tasks
Click Schedule New Task

Input a name for your task in the Descriptiorfield.

In Scheduler notificatigrspecify whether the scheduler should notify you
when it runs this task. The following options are available:

A Do not send do not notify you.
A Send to the defaulinail- send the notification to your default e-mail address.

A Send to the-mail | specify send the notification to the e-mail specified in the
corresponding field. After selecting this option, you need to input the required e-
mail in the field on the right.

Specify which command to run. Type it into the Path to e&cutable file
input box. If you need to run the command with certain options, type
them in the Argumentdield.

A For example, if you want to run the statistics calculation task to count disc space
and see more detailed information for the example.com and example.net
domains, you need to specify the following path in the Path to executable fileput
box:

C:\ Program Files \ Parallels \ Plesk \ admin\ bin \ statistics.exe
and the following options in the Argumentdield:

-- disk -usage -- process -domains=example.com, exam ple.net i
verbose

A If you want to run your own php script using the task scheduler, you need to
specify the following path in the Path to executable fileput box:

C:\ Program Files
(x86) \ Parallels \ Plesk \ Additional \ PleskPHP5 \ php.exe

and specify the script location in the Argumentdield:
C:\Inetpub \ vhosts \ mydomain.tld \ httpdocs \ myscript.php

Select the appropriate priority in the Task priorityfield. Task priority can
be set to Low, Normalor High

Specify when to run your command by selecting the appropriate check
boxes in the Hours Days of MonthMonthsor Days of Weekelds.

Click OKto schedule the task or click Run Nowo schedule the task and
immediately run it.
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Suspending and Resuming Execution of
Tasks

To temporarily suspend execution of scheduldd ta
Go to Domains> domain name Scheduled Tasks
Select the system user account on whose behalf the task is executed.

Locate the task that you want to suspend and click the command
name.

4 Clear the Switched orcheck box and click OK

w N =

To resume executiai scheduled task:
Go to Domains> domain name Scheduled Tasks
Select the system user account on whose behalf the task is executed.

w N R

Locate the task whose execution you want to resume and click the
command name.

4 Select the Switched orcheck box and click OK.

Canceling a Task

To cancel a task:

On your Home page, select the required domain name from the list.
Click Scheduled Tasks

Select the system user account on whose behalf the task is executed.
Select a check box to the left of the task that you want to cancel.
Click Remove

Confirm removal and click OK

o o A WDN PP o



CHAPTER 11

Monitoring Connections to Control Pa
and FTP Services

In this chapter:
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Monitoring Connections to Control Panel

U To find out who of your customers is logged in to the control panel at the moment:

1 Go to Home> Active Sessons. All sessions including yours will be
presented and the following details will be displayed:

A Type A type of control panel user who established the session:

@ for client.

Y2 for domain or Web site owner.

“3 for mailbox owner.

Login The login name the user is logged in as.

IP addressThe IP address from which the control panel is accessed.

Logon timeThe date and time when the user logged in to the control panel.

> > > >

Idle time The time that user was not doing anything in the control panel while
being logged in.

2 To refresh the list of user sessions, click Refresh

3 To end a user session, select the respective check box and click
Removethen confirm removal and click OK
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Monitoring Connections to FTP Service

Your Parallels Plesk Panel can show active FTP sessions only when any of the
following FTP server programs is installed on the hosting server:

Microsoft FTP 7.0 (Windows hosting)

Gene6 FTP Server (Windows hosting)

Serv-U FTP Server (Windows hosting)

ProFTPd (Linux/UNIX hosting)

A

> > >

[ERN

To find out who is connected to your server via FTP, in what dir¢ctyriesrrently
are and what files they are uploading to or downloading from the server:

Go to Home> Active Sessions

Click the FTP Sessiontab. All sessions including yours will be
presented and the following details will be displayed:

A

> >y > >y > >y > D> By D

Type The type of user who established the session:
2 for users not registered with the control panel.
2 for anonymous FTP users.

Y2 for domain or web site administrators.

'3 for subdomain administrators.

a2 for web users (owners of personal web pages without individual domain
names).

Status The current status of FTP connection.

FTP user loginrhe login name used for access to FTP account.
Domain nameérhe domain the FTP user is currently connected to.
Current locationThe directory the FTP user is currently at.

File nameThe file name being operated on.

Speed Transfer speed in kilobytes.

Progress, %r he file transfer operation progress in percentage.

IP addressThe IP address from which the FTP account is accessed.
Logon timeThe time lapsed since the moment user logged in.

Idle time The time that user was not doing anything while being connected to the
server through FTP.

A To refresh the list of FTP sessions, click Refresh
A To end a session, select the respective check box and click Remove
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Accessing The Server Using Remote
Desktop (Windows Hosting)

The remote desktop (RDP) access feature allows you to remotely log in to the Parallels
Plesk Panel server and interact with it using standard Microsoft Windows desktop
interface.

U To &cess the server via Remote Desktop interface:

1 Go to Domains> domain name Remote Desktop

2 Set up screen resolution for the session in the Screen resolution for
terminal sessiomenu.

Note: Higher resolutions are more taxing for your connection, decreasing the
interaction speed and spending more bandwidth.

3 Select the connection method according to your browser:

A Microsoft RDP ActiveXecommended to use with Internet Explorer browser,
since it may not work with other browsers. When you use this method for the
first time, your browser will automatically install the required ActiveX component,
if Internet Explorer security settings permit this. If your browser shows security
alerts, try to temporarily lower security measures in the browser options.

A properoJaaRDPR recommended to use with Netscape, Mozilla, or Firefox
browsers, since it may not work with Internet Explorer. Only 8.0 and higher
versions of Opera are supported. This component requires Java Runtime
Environment (JRE) to be installed on your system. If you do not have JRE, you
can download it from http://java.sun.com/j2se/1.5.0/download.jsp (version 1.4
and higher) and install it before using the remote desktop feature.

Note: You don't need to install JDK (Java Development Kit) in order for the
RDP feature to work.

If you use Internet Explorer or Mozilla, you should open the Terminal Services
Configuration console in Microsoft Windows (Start> Administrative Tasksand set
the Licensingoption to Per useion the Server Settingscreen.

4 Click OK A new window will open with an area where your interaction
with the server's desktop will take place.

5 Log in to the system. By default, Parallels Plesk Panel uses the
domain's FTP/Microsoft FrontPage login. You can supply any valid
login and password.

6 After logging in to the system you can start working with it as with a
regular Windows desktop.


http://java.sun.com/j2se/1.5.0/download.jsp

Accessing The Server Using Remote Desktop (Windows Hostidgp

U To finish your Remote Desktop session:

A Close the browser window with the remote desktop session. This way, the session
you had will be detached from your desktop, but it will keep running on the server,
so when you log in there next time, you will see the remote desktop in the state you

left it,

or

A Select Start> Log offif you want to quit the session permanently (all running
sessions consume the server's resources).



CHAPTER 12

Using Help Desk for Resolving Your
Customers' Issues and Requesting
Assistance from Provider

If your hosting company provides a Help Desk solution integrated with the control
panel, then you can use it to
A report your problems to your providerds tect

A receive problem reports or requests for assistance from your own customers i Web
site owners.

In this chapter:

Viewing Trouble Tickets in Your Help DesK..........coooeeeiiieeeiieeeeeeeen 181
Submitting a Problem Report to Your Service Provider ............ccccccvvceeieeeeeeiinnn, 181
Commenting and Closing Trouble TiCKetS ..o, 182
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Viewing Trouble Tickets in Your Help
Desk

U To check for new tickets from your users, or to view the status of tickets you
submitted:

1 Click the Help Deslshortcut in the navigation pane. All tickets
submitted by you and your customers will be listed and the following
supplementary information will be displayed:

A 1d: identification number assigned by the system upon submission,
A Ticket Subjecta summary entered by the ticket reporter,

A Ticket Statusnew, reopened, closed,
A

Reporter Type type of control panel user account or an e-mail address the
ticket came from - a client, domain administrator, e-mail user with access to
control panel, or user submitted a ticket by e-mail,

A Reporter Name name of person who submitted the ticket, domain names for
tickets submitted by domain owners, or e-mail addresses for tickets submitted
by e-mail,

A Modifiedthe date the ticket was modified - a comment appended, or status
changed,

A Categorythe category to which the ticket is related.
2 To see what is inside a ticket, click a ticket id or ticket subject.

Submitting a Problem Report to Your
Service Provider

To submit a new problem report to your service provider:
Go to Help Desk- Add New Ticket

2 Type the ticket subject, select the category the issue is related to, and
type in the problem description.

3 Click OK

The ticket is now submitted to the system and sent to your provider. You will be
notified by e-mail when the issue is resolved.
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Commenting and Closing Trouble Tickets

U To close a ticket when theug was resolved or to post your comment:
Click the Help Deslshortcut in the navigation pane.

2 Locate the ticket you need and click its subject or identification
number.

3 To close, reopen or post a comment to the ticket, select the operation
you would like to perform from the Ticket Eventirop-down box, and type
a new comment into the New Commentput field if required.

4 Click OKto submit.
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